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| INTRODUCTION

Welcome to Dataton WATCHOUT™, a fully digital, multi-screen display tech-
nology. It combines the qualities of traditional multi-image with digital
imagery, video and the graphics power of contemporary computer technology.
Use it with projectors for large, seamless images, or hook it up to monitors,
video walll cubes or plasma screens for other creative screen arrangements.

About This Manual This manual is divided into the following parts:

* An introduction section, giving you the big picture. Start here if you're a
new user or just having your first look at WATCHOUT.

* A reference section, describing all windows, menus, commands and other
details. Refer to this section to learn more about specific functions

* A number of appendices with additional information related to particular
areas of the product, such as live video inputs and external control proto-
cols.

HINT: If you're reading the electronic version of this manual, the table of
contents, index and all cross references can be clicked to jump directly to
the referenced page.

WATCHOUT Version 5 This manual refers to WATCHOUT version 5. The latest version of the software
and its documentation can always be obtained from:

http:/ /www.dataton.com/watchout/support/downloads
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SYSTEM OVERVIEW

This section provides a brief introduction to the various components in a very
basic WATCHOUT system, and how they fit together.
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Production Computer This is the focal point for your WATCHOUT production work. This is where you

collect all the source material, or media, to create your presentation. Using the
WATCHOUT production software (see page 13), you simply drag media into
your presentation, positioning it in the Stage window and along the Timeline.
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Display Computers

Network

Display Devices

The production computer talks to the display computers through the network,
transferring media files for you as required, as well as controlling the playback
of the show. It can also be used for audio playback while running the show.

You need one display computer for each display device, or group of display
devices, used in your presentation (projector, monitor, efc). Display computers
handle all the hard work associated with rendering still images and video.
They also apply edge blends and can play sound files.

The fact that the system can use multiple display computers means it is scalable
to virtually any size; as more displays are added, you can also add more
computing power to drive these displays. A display computer may drive up to
six displays, depending on hardware and performance requirements.

The network ties the parts together, allowing the production computer to
manage all display computers. The network is created by connecting the
computers to a common hub or switch (not shown in the overview illustration).

As you add new media to your presentation, or revise existing media, these
changes are automatically propagated, via the network, to the appropriate
display computers. The network also transfers your display configurations,
timeline programming and other aspects of your presentation to the display
computer. With all this material residing on the display computers, very little
information needs to be sent over the network during playback, avoiding
network congestion.

WATCHOUT can be used with virtually any display device that can be

connected to a computer, such as projectors, LCD and plasma displays. See
“Display Issues” on page 239 for more details.

Chapter 1 Introduction 9



Minimal System Configuration
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Although you can use the WATCHOUT production software on its own in
order to get acquainted, you won’t be able to appreciate the full power of
WATCHOUT until you connect some display computers. The illustration to the
left shows a minimal system, consisting of the following components:

* A computer running WATCHOUT production software.

* A computer running WATCHOUT display software

e A display device (for example, a monitor or a projector).

e A network, connecting the two computers together via a hub or switch.

In addition, each computer in a system running WATCHOUT must have a
WATCHOUT license key connected (see “License Keys” on page 16).

NOTE: The production software can be used on its own without a license
key. License keys are required for using the display software.

WATCHOUT is very flexible in terms of how you arrange the displays. The
illustrations below show some more unusual display arrangements. In addition,
WATCHOUT also supports projection on curved surfaces (see “Geometry

Correction” on page 160).
S,
& £

a

Vertically oriented, edge  Diamond-shaped Arch built using
blended projectors display cluster multiple LCD displays
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Images, Sound and Video

Live Feeds

External Control

A WATCHOUT presentation uses multiple media, such as still images, video
clips, sound files, etc. WATCHOUT accepts a wide variety of still image and
video file formats. Transparent areas (alpha channel) are supported in both still
images and video files. For more details on the various kinds of media
supported by WATCHOUT, see “Media” on page 33.

In addition to pre-produced content, WATCHOUT can also incorporate live
feeds of various kinds:

* Video camera, e.g., for integrating a live image of a speaker into the
presentation.

e Other external feeds, such as a DVD player or a satellite link.
e Computer graphics, e.g., a PowerPoint presentations.

e RSS feeds or other external data sources managed through the
WATCHOUT Dynamic Image Server (see page 217).

Some live feeds require additional hardware, such as capture cards, in order
to bring the signal into WATCHOUT (see “Live Video” on page 47). In other
cases, the external feed can be brought into the system through the network.

WATCHOUT can be combined with other systems and technologies to build
entire presentation environments. Use a touch panel, an iPhone, iPad, or
similar device, as an interactive front-end, controlling any number of
WATCHOUT clusters. Connect other devices and systems to WATCHOUT
using a computer network, serial port, MIDI, DMX-512 or a timecode feed (see
separate sections and appendices for details on external interface options).

Chapter 1 Introduction 11



SOFTWARE OVERVIEW
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This section gives a brief introduction to the WATCHOUT production software.

The Stage window allows you to organize the displays (screen areas) to reflect
their expected placement. It also provides a preview of the end result, and
allows you to manipulate the placement and movement of images.

Media files are dragged from your hard disk into a timeline window, where
they appear as cues. Each cue features a thumbnail icon of the media. You
determine timing and duration by adjusting the position and length of these
cues. The horizontal layers in the timeline window represent the order of over-
lapping images, back-to-front.

As media is added, thumbnails representing the media files also appear in the
Media window. This acts as a central repository for all media used in your
presentation. It provides information about each media file, and allows the file
to be easily accessed for editing or other purposes.

The cues in the timeline window can be enhanced by applying tween tracks.
Tween tracks control the dynamic behavior of media on stage, such as posi-
tion, size or transparency.

As you make changes to the presentation, those changes can be transferred to
all the display computers by a single keystroke. This automatically transfers
any media you have added, or modified, to the relevant display computers
and shows the result on screen. As the media files and cues are cached locally
on each display computer, the show is ready to run at any time by simply
pressing the spacebar.

Chapter 1 Introduction
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WATCHOUT Training Videos

Where to Go From Here

14

To learn more about WATCHOUT, you may want to watch the training videos
available here:

http://dataton.com/watchout/support/training

To use WATCHOUT for running actual, full-scale presentations, you need to
hook up display computers and projectors (or other display devices) as shown
on page 8. Chapter 2 provides details on setting up and configuring a
complete system.

In addition to the computers and display devices, you also need to acquire
WATCHOUT license keys (see “License Keys” on page 16).

Chapter 1 Introduction


http://dataton.com/watchout/support/training

2 INSTALLATION

This chapter tells you how to install the required software components as well
as how to hook up the hardware.

SOFTWARE Obtain the “WATCHOUT Installer”, either from the WATCHOUT license key or
by downloading it from

i‘i‘:‘ http:/ /www.dataton.com/watchout/support/downloads
W;T.SEQEET Run the installer and follow the on-screen instructions. This installs both the
production and display software components, adding them to your Start menu.
NOTE: If you intend to use the computer primarily for WATCHOUT, first
read the section titled “Dedicated Computer” on page 225.
Installing QuickTime In addition to WATCHOUT, you also need to install Apple QuickTime, avail-
s able on the WATCHOUT license key or from:
http:/ /www.apple.com/quicktime/download/
Quickkime
Installer

Chapter 2 Installation 15
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NETWORK

Stand-alone System

LIC

16

ENSE KEYS

.‘ B
.| WATCHOUT @

The production computer and all display computers must be interconnected
using a TCP/IP compatible Ethernet network, which comes standard on most
computers. Wireless networks are generally not recommended.

Connect all computers to a hub or switch.

Production = = =

Display

Computers

Ethernet switch

For stand-alone operation of a WATCHOUT system, this is usually all you need
to do in terms of hardware hook-up.

Each computer in the system requires a WATCHOUT license key, including the
production computer. Plug the key into any free USB (Universal Serial Bus) port
on the computer.

NOTE: You can run the production software off-line without a license key
connected. A key is needed when you go on-line to communicate with the
display computers.
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DISPLAY DEVICES

PROJECTION SCREEN

SOUND

® ©

Sound output jack symbols.

WATCHOUT can be used with most display technologies, including DLP and
LCD projectors, LCD monitors, video wall cubes and plasma screens. Generally
speaking, you can use any display device that’s compatible with the display
card in the display computer.

For projection purposes, DLP projectors with a high contrast ratio (2000:1 or
better) is recommended. See “Display Issues” on page 239 for further details
on various kinds of displays, and how to connect them to WATCHOUT.

As in all multi-screen projection applications, it is important to choose the
screen material with caution. Make sure you buy your screen material from a
screen manufacturer familiar with the requirements of multi-image projection,
or similar applications.

For front projection, avoid using high-gain, or “silver” screens. Such screens
often cause uneven brightness or banding when using multiple projectors and/
or when viewing from non-optimal angles. See “Banding” on page 245.

A related problem when using rear projection screens is the “hot-spot” caused
by the projection lens showing through the projection surface. See “Rear
Projection” on page 245.

Sound can be provided through any of the display computers, or through the
production computer. Simply connect the sound output from the computer
(usually a 3.5 mm mini-jack) to the amplifier or powered speakers.

If you need to run the computer’s line level audio signal a long distance, you
should use an audio line level transformer. This converts the unbalanced signal
coming from the computer to a balanced signal, thereby reducing the risk of
hum and noise when connected to a professional audio amplifier.

Chapter 2 Installation 17



Using Multiple Sound Channels

LIVE VIDEO INPUT

Feeding Multiple Display Computers

18

You can have multiple display computers playing at the same time, thereby
providing multiple audio channels. The synchronization between computers is
generally good enough for multi-language support or special effects sound
tracks, but not for true, phase accurate, multi-channel sound reproduction.

Another option is to install a multi-channel sound card in a display computer.
Such sounds cards can handle up to eight phase accurate sound channels. See
“Multi-Channel Audio” on page 45 for more details.

WATCHOUT can integrate live video feeds using video input devices, such as
capture cards. This may be a camera feed, a satellite link or the image
displayed by another computer (for example, a Microsoft PowerPoint® presen-
tation). For examples on some suitable video input solutions, see “Live Video
Input” on page 224.

The video signal must be fed to each computer where it's supposed to appear.
For instance, if your system uses five display computers, and you want to show
a live video image straddling two of those five display areas, both those
display computers must be fitted with the same kind of capture card, and the
video signal must be fed to the same input on both cards.

A video DA (distribution amplifier) may be required to distribute the signal to
multiple inputs. Such devices are available from companies such as Extron and
Kramer Electronics:

http:/ /www.kramer.co.il/

http:/ /www.extron.com/
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Software Driver Installation

WATCHOUT Configuration

MIDI AND DMX-512

Most capture cards require specialized software drivers. Although such a
driver is usually delivered with the card on a CD-ROM,, it's often a good idea
to check the manufacturer’s web site for the latest driver version. For a list of
suitable capture cards, see “Live Video Input” on page 224.

Configure each WATCHOUT display computer that will show live video as
described under “Add Live Video” on page 145. Optionally, you can also
choose to show live video in the Stage window of the production computer (see
“Video In” on page 124).

WATCHOUT can communicate with other devices using the MIDI and DMX-
512 industry standard protocols, as well as devices connected through a serial
or network data link. MIDI communication requires a Windows compatible
MIDI interface, which is often connected through a USB port. Follow the instruc-
tions included with your MIDI inferface to install any required software or
drivers.

See “Inputs and Outputs” on page 197 for more details.
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VNC SERVER SOFTWARE

20

If you want to use the Computer Screen media item in WATCHOUT to integrate
a live computer display into your presentation (for example, to display Excel or
Powerpoint as part of a speaker-support presentation), you must install VNC
server software on the remote computer. This must be a separate computer — it
can not be one of the computers running WATCHOUT software.

NOTE: This software is not required for basic WATCHOUT functions. You
only need to install this software if you want to use the “Computer Screen”
feature (see “Add Computer Screen” on page 143).

VNC (Virtual Network Computing) server software is available for a wide
variety of operating systems. The instructions below describe its installation
under Windows. VNC is free software, available in several forms:

http://www.realvnc.com/

http://ultravnc.sourceforge.net/

Download the VNC server software from one of the above locations, and
follow its installation instructions. When using Windows 7, you're advised to
start the VNC server software as a user mode application.

For best performance, use a reasonably fast computer to run the VNC server
software and the application you wish to incorporate info your presentation
(for example, Powerpoint).

Make sure that the VNC server computer is connected to the WATCHOUT
network, and has a fixed, known IP number in its TCP/IP settings (see

page 24). This IP number and other TCP/IP parameters must match the
network to which it is connected. Also verify that its firewall is disabled, or that
the VNC port 5900 is open in the firewall (see “Firewall Settings” on page 25).
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The first time you run the VNC server software, you will be prompted to enter
a password. The VNC server software then appears as an icon in the lower
right corner of the screen while running. Pointing at this icon displays the IP
number of the VNC server. Double-click the icon to change the settings.

. — T 3
VNC Server software setfings. W0 VNC Server Properties (User-Mode) ﬁ
| Sharing | Desktop I Capture Method I Legacy
Authentication | Connections I Inputs
Enter the desired VNC server - —
pCISSWOFd here' () Mo Authentication
@ YNC Pazsword Authentication Configure
MT Logon duthentication Configure
Encryption: Elways O Generate Keys

[] Prompt local user to accept connections

Only prompt when there iz a uger logged on

[ OK J [ Cancel Apply
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COMPUTER SETTINGS Each computer needs to be configured for TCP/IP networking. Click the Start
button and choose Control Panel. Open the “Network and Sharing Center”.
Make sure there’s a “Local Area Connection” shown in the list.

P —

s

L+ <« All Control .. » Metwork and Sharing Center - | 3 | | Search Con... 2 |

Control Panel Home

Manage wireless networks et up connections

Click “Change adapter settings”. Change adapter settings Ay |h 0 See full map

e

aanasiaduancedihanisg FUITSULAP.. Metwork  Internet

2 — = ~

@uvl E-' <« Metwork a... » Metwork Connections » - | ¢f| | Search Net.. 2 |
. . I - e 71
Right-click your local network Organize l = Ol @
Sonnedl_on ”C’nd choose L_“. Bluetooth Metwork Connection L. Local Area Connection
Properties”. S Mot connected " Network
XK g Bluetooth Device (Personal Area .. @ Realtek PCle GBE Family Controller

L_“. Wireless Metwork Connection
S o Mot connected
}f ;Elﬂ Atheros AR9285 Wireless MNetwork...

Click “Change adapter settings”, then right-click your Local Area Connection
and choose “Properties”. You may need to type your password to continue
configuration at this point.
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Ensure that “Internet Protocol Version 4 (TCP/IPv4)” is available and selected.

U Local Area Connection Properties ﬁ

Metworking

Connect using:

LF Broadcom NetXreme Gigabit Ethemet

This connection uses the following items:

7% Client for Microsoft Metworks

=1 (105 Packet Scheduler

O g File and Prirter Sharing for Microsoft Networks

[ - Imtemet Protocol Version & (TCP/IPvE)

g ntemet Protocol Version 4 (TCP/IPv) |

i Link-Layer Topology Discovery Mapper /0 Driver
& Link-Layer Topalogy Discovery Responder

Ingtall... Uninstall

Description

Transmission Cortrol Protocol/Intemet Protocol. The default
wide area network protocal that provides communication
across diverse interconnected networks.

OK || Cancsl
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Choose “Internet Protocol Version 4 (TCP/IPv4)”, click “Properties...” and
entfer the numbers as shown below.

I

"
Internet Protocol Version 4 (TCP/IPw4) Properties @l-‘.:_hj

General

‘You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically

NOTE: The exomp|e shown is i@ Use the following IP address:

appropriate if you're building a IP address: 192,168 . 0 . 1
stand-alone system. If your

WATCHOUT subnet is connected Subnet mask: 28023525 0
to a larger network, you should Default gateway:

consult your network

ddminstrctor. Obtain DMS server address automatically

i@ Use the following DNS server addresses:

Preferred DMS server:

Alternate DNS server:

[ OK ” Cancel l
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Firewall Settings The Windows firewall may interfere with normal operation of WATCHOUT.
You can avoid this either by disabling the firewall, or by configuring the fire-
wall to allow WATCHOUT to function. To disable the firewall, open the
“Windows Firewall” control panel, as shown below.

F B

| Bt
\‘:’}\‘;} |ﬂ » Caontrol Panel » All Control Panel tems » Windows Firewall - |¢,| Search Con... ,Ol
I@I -

Control Panel H . . .
B Help protect your computer with Windows Firewall

Allow a program or feature

! h Windows Firewall can help prevent hackers or malicious software from gaining access
through Windows Firewall

to your computer through the Internet or a network.

m

¥ Change notification settings How does a firewall help protect my computer?

B Turn Windows Firewall on or What are network locations? —
off

|5| Restore defaults Update your Firewall settings

B Advanced settings Windows F|rewa|||§ net using the [ @Use recommended settings

recommended settings to protect

Troubleshoot my network your computer.
See also What are the recommended settings?

If the firewall is on, click “Turn Windows Firewall on or off.” This opens the
“Windows Firewall Seftings” window (see next page), allowing you to turn off
the firewall.
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[ S
@Uv|ﬁ <« Windows Fir... » Customize Settings - | 3 | Search Con... 0 [
IMPORTANT: A WATCHOUT sys- it
tem should not be accessible from Customize settings for each type of network
the Internet, or other external net- You can modify the firewall settings for each type of network location that you use.
work. If you need to access the In- What are network locations? 3
ternet From your SYSf?m/ use d Home or work (private) network location settings
separate firewall device fo protect @ © Turn on Windows Firewall
your Fomplete system from - Block all incoming connections, including those in the list of allowed
security attacks. programs
Motify me when Windows Firewall blocks a new program
The firewall feature should be turned ah—@ Turn off Windows Firewall (not recommended)
off. Otherwise it may interfere with E B
the ability to connect to and down- [ ok || cancel
load media files to the display
computers.

NOTE: As an alternative to disabling the firewall entirely, you may
configure the firewall to allow WATCHOUT and any other related functions
to pass through. Please consult your computer’s documentation for details
on how to configure the Windows firewalll.
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DISPLAY COMPUTER SETTINGS To achieve best performance and reliability in your WATCHOUT system, you
need to adjust several settings on all your display computers. Most of the
settings below are found by clicking the Start button and choosing Control
Panel.

Network Open the “Network and Sharing Center” control panel and configure TCP/IP
as described on preceding pages. Specify a unique IP number for each display
computer by changing the last group of IP address digits.

As an example: in a system consisting of one production computer and three
display computers, you would end up with IP addresses assigned like this:

192.168.0.1 192.168.0.10 192.168.0.12
| 192.168.0.11 |
Production P Display
computer = me computers

If your WATCHOUT subnet is not stand-alone but connected to a larger
network, you should consult your network administrator for the correct IP
number, subnet mask, and other parameters.

IMPORTANT: Each display computer must be manually assigned a unique
IP address. Unlike the production computer, the display computers may not
use automatic (dynamic) IP number assignment.
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Display Properties

28

* Right-click your computer’s desktop and choose “Screen Resolution.”

* Set “Resolution” to match the desired resolution for the display. If you have
multiple displays connected, select each display and set its resolution and
other parameters.

IMPORTANT: When connecting multiple displays to one display computer,
all those displays must be set to the same resolution and connect to a single
graphics card.

[ =SSR )
QQ |ﬂ_ « Displ... » Screen ... i | ‘?| | Search

s

Change the appearance of your display

Detect

Identn‘y

m

Display: 1.LPIS6WH2-TLBA ~ |

Resolution: [136& « 168 (recommended) v]

QOrientation: [Landscape v]

1

Advanced settings
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Click “Advanced settings.”

Click the Monitor tab and set “Colors” to “True Color” and “Screen refresh

rate” as set in the “Display Framerate” according to your WATCHOUT

presentation (see page 121), and click OK.

-
Generic PnP Manitor and Intel(R) HD Graphics Properties

===

Intel{R) Graphics and Media Control Panel
Adapter Monitor | Troubleshoaot Color Management

Manitor Type

k'l- Generic PnP Monitor

Monitor Settings

Screen refresh rate:

60 Hertz

Hide modes that this monitor cannot display

and/or damaged hardvare.

Colors:
[True Color (32bit) |

Clearing thiz check box allows vou to select dizplay modes that this
manitor cannot display carrectly. Thiz may lead to an unuzable dizplay

0K || Cancel

Hpply
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Windows 7 UAC Settings

30

If you don't intend to use video, or if you have mixed PAL and NTSC video,
choose “60 fps” in the WATCHOUT Preferences dialog box, and set the
display’s refresh frequency to 60 Hz.

NOTE: Some video projectors and LCD displays work better at 60 fps than
other refresh rates even when displaying PAL video. If you experience jerky
motion and/or video playback, you may want to try setting both the
WATCHOUT Preferences and your display computers to 60 fps/Hertz.

Some system configurations don’t allow you to change the refresh rate. In this
case, the Refresh rate option will not be shown under the Adapter tab. This
may vary depending on the display card, display card drivers and the display
connected to the system.

IMPORTANT: While WATCHOUT will attempt to set the display resolution

automatically, setting the resolution manually is usually preferable. The rea-
son is that many display adapters don’t allow WATCHOUT to set the most
optimal display refresh frequency. By setting the display resolution and re-
fresh frequency manually before starting WATCHOUT, you avoid the risk

of getting a non-optimal display frequency.

When using display computers in a dedicated, unattended manner, you may
want to disable the User Access Control feature of Windows 7. If not, Windows
may occasionally display a confirmation dialog for certain operations,
requiring an administrator user to enter a password. See “Windows 7 UAC
Settings” on page 227 for more details.
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Sound Settings When using a display computer for sound playback, you must enable the

correct sound output and turn up its volume. Open the Sound control panel and

make sure the correct output is activated. If not, select the desired playback
device and click “Set Default”.

N
%/ Sound ﬁ
Playback |Recording | Sounds

Select a playback device below to modify its settings:

Speakers
Realtek High Definition Audio
Working

Indicates the currently active

(default) sound output port. Realtek Digital Output
Realtek High Definition Audio
Working

[ 0K ][ Cancel ] Apply
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Turn up the volume.

Once you have selected the desired output in the list shown on the previous
page, click Properties and turn up the volume under the Levels tab.

a Speakers Properties ﬁw

| General | Levels |Er1har1cemer|ts I Advanoed|

Realtek HD Audio output

NOTE: The look of this window
may vary depending on the

features of your audio interface.

32

O 100 Balance

Aux

-
u | 0 Balance |E|
CD Audio
g 0 [€) [satence ]

Line In
0 "0 [0 [eatenee]

Front Pink In

u | 0 Balance

[ oK ] [ Cancel Apply
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3 MEDIA

Various kinds of media in the
WATCHOUT Media window.

WATCHOUT is a compositing tool; it does not include any media creation or
editing functions. All media to be used in your presentation must be supplied
and edited using other means.

This chapter provides an overview of the media and file formats supported by
WATCHOUT, as well as examples of popular applications used to create or
edit such media files.

IMPORTANT: Keep a show’s media files in a folder that is located in the
same folder as the WATCHOUT show file, or in a sub-folder. This allows
the software to use relative file access paths, making it easier to move the
show to another disk or computer.

& Media (=& =

Mame \ Thumbnail | Type

Eldhimmel. tga : *‘ Image

ArmCyde.mav
52, AIFF
SloMoHD. m2v i 1920 x 1080

B Panoramas Folder 7 items
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STILL IMAGES

Supported Formats

34

Still images can be used as backgrounds or superimposed on other images.
You can control the degree of transparency, scaling, rotation and other effects
for all images (stills as well as moving images).

WATCHOUT reads most popular image formats, including BMP, GIF, JPEG,
Photoshop, PICT, PNG, Targa and TIFF.

Preferably, use an image format native to the application used to create/edit
the images. For example, if you use Photoshop to edit images, save the images
as Photoshop files. Although most image editing applications support saving or
exporting to other file formats, doing so may cause a loss of information. This
can make it difficult to edit the image later.

IMPORTANT: In order to use Photoshop images with WATCHOUT, files
must be saved with “Maximize PSD File Compatibility” enabled. This Pho-
toshop option is found under Preferences, File Handling, File Compatibility.

For photographic images (for example, scanned or shot using a digital
camera), JPEG at a high quality setting often provides the best compromise
between image quality and file size. Keep in mind that JPEG is a lossy
compression format. This means that minor, normally unnoticeable, details in
the original image may be lost in the compression process.

For computer-generated images with large, smooth areas (for example,
screenshots), PNG is a suitable cross-platform format.
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Transparency

Background image.

Some image formats include transparency information in addition to the image
itself. This transparency information is sometimes referred to as an “alpha
channel”, although some image editing applications use this term for other
functions. Transparency can be used to create non-square images, holes inside
images or semi-transparent areas, such as drop shadows. Photoshop, PNG,
TIFF and Targa file are examples of file formats that support transparency.

Image with a transparent back-  Result when composited in
ground and a semi-transparent ~ WATCHOUT.
shadow.

CAUTION: Even if an application supports writing to a particular file format,
it may not support transparency in that format. Perform tests with images to
determine the suitability of particular formats and applications.

WATCHOUT supports most methods used for encoding transparency into
images. Which method to use is usually determined automatically. If not, you
can specify this manually by opening the Specifications dialog box for the
image and choosing the desired encoding (see “Transparency” on page 142).
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Image Specifications

Transparency

Optimize For...

36

Double-click the name of an image in the Media window to change its specifi-
cations. Click the Browse button to link the media item to another file. This
updates all cues to show the newly selected image instead.

Image

— &5 |

Image File: mgServer/DynImgSrvLoge.png Browse. ..

Auto Detect v

Transparency:

Optimize For: (@ Better Performance
More Effects and Capabilities

Applies to Images up to

2048 by 2048 poxels.

Eook | Cancel

s

In most cases, WATCHOUT can determine the kind of alpha channel (trans-
parency) being used in the image, if any. If the automatic detection fails,

choose the correct type of alpha channel here.

WATCHOUT normally optimizes all images for best possible playback perfor-
mance. However, this may occasionally limit your options when attempting to
apply advanced features to an image, such as external control of its position
or size (see page 178). To allow the use of such advanced features, choose

“More Effects and Capabilities” instead.

IMPORTANT: Do not choose “More Effects and Capabilities” unless you
need to, as doing so increases the load on your computer. This option is not
available for images larger than 2048 pixels in either direction.
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MOVING IMAGES

High Definition Video

WATCHOUT can play back movies and videos saved in a Windows Media
(DirectShow) or QuickTime-compatible format, such as MOV, WMV, AVI, DV
and MPEG-1/2/4 (including H.264/AVC).

WATCHOUT supports high definition video using either MPEG-2, H.264 or
the Windows Media 9 format.
Video can be encoded by, for example, the Grass Valley ProCoder:

http://www.grassvalley.com/products/procoder 3

Another excellent and very flexible encoder is TMPEGEnc Video Mastering
Works:

http://tmpgenc.pegasys-inc.com/en/index.html

Telestream Episode is a popular choice, available for both MacOS X and
Windows, providing support for a wide variety of formats:

http: / /www.telestream.net/episode/overview.htm

NOTE: Windows Media as well as H.264 HD content requires a compara-
tively fast computer. MPEG-2 content will play on less powerful computers.

When shooting and encoding high definition content, a progressive (that is,
non-inferlaced) format is preferable (for example, “30p”).
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Computer-generated Animations

38

When using computer-generated moving images, you must specify the frame
rate and resolution of the resulting movie during rendering. Generally, when
combining computer generated and pre-recorded video material, the frame
rate is dictated by the live material. Alternatively, if your playback computer is
fast enough, match the rendered frame rate to the WATCHOUT display frame
rate (see “Display Framerate” on page 121); for example, 60 fps progressive.

It's often advantageous to use smaller, computer generated, moving images
layered on top of larger still images. By rendering only the parts of an image
that actually move, not only do you lower the burden on the playback machine,
but you also reduce rendering times. Keep in mind that you can make non-
square movies, or even holes inside movies, by using transparency options in
supporting applications and codecs.

As computer generated movies are by nature resolution independent, it is also
possible o make movies that are much larger than a single display area. Very
large movies may need to be pre-split in order to be used in WATCHOUT (see
“Pre-splitting Large Movies” on page 42), depending on the performance of
the display computers.
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Assembling Individual Frames

(* & A e

Arm.mov

Some applications, most notably 3D animation software, often save the
resulting frames as individual image files. This may also be the case when
scanning images frame by frame from film. Such a sequence of images must
be converted into a movie file, with the appropriate frame rate, before it can
be incorporated into WATCHOUT. This can be done using, for example,
Adobe After Effects or Apple QuickTime.

The individual images must be saved as files all ending in a frame number. This
number precedes the file name extension: for example, File001 .tgq,
File002.tga, File003.tgq, efc.

Assembling using Adobe After Effects. To assemble a movie from still
images using Adobe After Effects, choose “Import, Footage File” on the File
menu, select the first file in the sequence, and select the “<Format> Sequence”
checkbox. The desired frame rate can be specified in Preferences prior to
importing the images, or can be altered at any time by choosing “Interpret
Footage, Main” on the File menu.

Assembling using QuickTime Pro. Choose “Open Image Sequence”
on the File menu, select the first image to import and specify the desired frame
rate.

NOTE: Many video encoding applications can also encode directly from an
image sequence.
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Using Transparency

Computer generated movie with
transparent background and semi-
transparent drop shadow playing
over a background image.

Video Compression

40

Some applications support inclusion of transparency information in the gene-
rated movie file. Such transparency can either come from the source material
(for example, a computer generated animation), or be added afterwards (for
example a mask applied to a video clip).

Being able to create arbitrarily shaped movies, or movies with holes in them,
means you can combine moving and still images in many creative ways.

In order to include transparency information in the movie file, you must choose
the QuickTime Animation codec set to use “Millions+" of colors. The “+” at the
end stands for the transparency information. This is sometimes called
“Millions+Alpha”. You must also use an application that's capable of repro-
d'l:JFCing and/or generating transparency information, such as Adobe After
Effects.

HINT: In many cases, a clean green or blue background can be used
instead of true transparency. Simply apply WATCHOUT's Key tween track
to the video (see “Key (Green/Blue)” on page 185).

Due fo the large amount of raw data in a video stream, storing and playing
back uncompressed video is usually not feasible. Video compression is based
on the concept of codecs. A codec (which stands for compressor/decom-
pressor) is the part of the editing and display technology responsible for
storing and playing back compressed digitized video.

There’s a wide variety of codecs available, each optimized for a particular
kind of source material and playback requirements. WATCHOUT supports
both Apple QuickTime and Microsoft DirectShow codec technologies for play-
back. Here’s a rundown of some of the more commonly used codecs:
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Recommended Compression
Formats

MPEG-2. High quality. Used on DVD video discs. Optimized for camera
video at normal frame sizes. Also supports high definition formats with some
encoders (see “High Definition Video” on page 37). The WATCHOUT MPEG-
2 decoder performs de-interlacing automatically when required.

Quicktime Animation. Very low compression. Optimized for computer-
generated material. Supports transparency when set to “Millions+” of colors.

DV. High quality. Medium compression. Optimized for video editing. Gener-
ated directly by most digital video camcorders. Native frame size is fixed,
based on video format's frame size. For best performance, use the AVI file
format for DV content to be used with WATCHOUT.

Windows Media 9. High quality. Flexible in terms of frame size (useful for
making tall or narrow movies), frame rate and interlacing/progressive
options. Demanding on processor speed when using high resolutions.

H.264/AVC. High quadlity. Flexible in terms of frame size (varies with
encoder). Demanding on processor speed when using high resolutions.

Choosing the right codec and codec settings for your source material and play-
back hardware may require some experimentation.

Although WATCHOUT supports most video file formats, some formats tend to
give better results. As a general guideline, use MPEG-2, Windows Media 9 or
H.264 unless an alpha channel is required, in which case QuickTime Anima-
tion is the recommended codec. WM9 as well as H.264 requires more
processor power, but provides greater flexibility then MPEG-2 in ferms of
supported frame sizes.
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Pre-splitting Large Movies

42

Modern computers are generally capable of playing at least one high defini-
tion video file. Fast computers may be able to play several high definition
videos at the same time. As long as what you need to play fits within the realm
of your computer’s capabilities, you should generally choose among the
MPEG-2, H.264 or Windows Media high definition formats.

However, for extremely large movies, spanning numerous displays, even
modern computers may not be fast enough to handle the required resolution as
one large movie. This applies in particular to computer generated movies,
which can be made at any resolution and frame rate your animation software
is capable of producing. Such very large movies can be played by splitting
them into individual pieces, where each piece includes only the portion of the
frame that will play on each display.

While this splitter function is built into WATCHOUT for still images, it is not
handled automatically for moving images. The primary reason for this differ-
ence is that the original, large movie would most likely have to be compressed
in order to be stored and distributed to the display computers. To split the
movie, the display computers would have to decompress each frame, split it
and then re-compress the result again for final playback. This would mean that
each movie frame will be compressed twice. The end result would be a loss of
image quality.

In addition to this quality aspect, there are also storage and bandwidth consid-
erations related to distributing and storing the original (large) movie in order
to split it, as well as the processing time involved in compressing it twice. The
latter would be significant for such a large movie, particularly to achieve the
best quality.
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A 1200 x 480 movie to be pre-split

across two overlapping 800 by
600 display areas.

Crop left
by 480

pixels. \

4“—>
Crop right |
by 480 !

pixels. |

This can all be avoided by splitting the image using the originating application,
prior to compression. Most applications allow you to crop the output fo any
desired rectangle. In some cases, you can even set up batches to generate all
the individual movie files in one go.

As an example, assume that you have two 800 by 600 pixel displays with a
30% overlap, and want to display a movie of 1200 by 480 pixels, the split
would appear as in the illustration to the left.

NOTE: These figures are only chosen as an example. Most modern
computers would be able to play such a movie as is, without pre-splitting it.

Include the overlap in the split, since the portion of the image in the overlap will
have to play on both displays. Likewise, if the displays aren’t overlapping you
will have to factor in any gap between the edges of the display areas by speci-
fying a corresponding gap when making the split.

Most applications specify cropping relative to the initial image size. This means
that the bottom and right edges need to be calculated based on the height and
width of the original (large) image.

IMPORTANT: When splitting a large movie into smaller pieces like this,
avoid using a compressed movie as the source. Doing so would introduce
an additional de-compression/re-compression step, resulting in lower qual-
ity. Thus, whenever possible, start out with the original material, such as in-
dividual, computer-generated, image files.

Save the resulting files into a separate folder. Give each file the name of the
WATCHOUT display on which it will appear. Select “Pre-split for Multiple
Displays” and link the Video Proxy to the folder (see “Add Proxy” on page
139).
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This is how you would split a movie using Adobe After Effects:

Output Module Settings

— Based on "Lossless”

Format: | Windows Media p.’.]
Embed; MNone 2
Post-Render Action: : Nene [-e-]
—M Video Output
Format Options... Starting #: i f Use Comp Frame Number
r
Title: Channels; | RGE I—ﬁ
gkl Depth | Milions of Colors
Video: 175 Kbps 2 Pﬁ
Calor: | Premultiplied (Matted) )
—4 h
| Stretch
Width Height
Rendering at: 1200 = 480
Stretch to! % 458 Custom .
Stretch ¥ x

Stretch Quality: | High

f Lock Aspect Ratio to 5:2

—E Crop
Crop fhe resulﬁng mov"e as D Use Region of Interest Final Size: 720 x 480
required on each side. Top: [ 0 Lefts 0

Bottorn: | 0 | Right: K=

— ] Audio Output

| Format Options... |

44.100 kHz EERETD T4 Stereo B

( Cancel )G—M—;
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AUDIO

Audio waveform displayed
inside cue on timeline.

Audio File Formats

Multi-Channel Audio

Audio is used in WATCHOUT in a way that's very similar to moving images.
Simply bring the sound file into WATCHOUT and place its icon on the display
in the Stage window where you want the sound file to play.

A e~ || etk e 1] o

NOTE: Do not place the sound file’s icon so that it straddles multiple
displays, unless you specifically want the same sound file to play from
multiple display computers.

WATCHOUT can generally play any sound file compatible with Windows
Media Player. However, the recommended sound file format is WAV. There's
usually no reason to use a compressed sound file format, such as MP3, and the
additional decompression step adds unnecessary load. The size of uncom-
pressed sound files is usually not an issue with the kind of computers used to
play back WATCHOUT presentations.

WATCHOUT can play back multi-channel audio using a suitable sound card
(see page 18). Multi-channel sound files are saved as WAV files using the
“Wave Format Extensible” file format. Some applications capable of saving
multi-channel WAV files include Steinberg Nuendo, Digidesign ProTools and
Adobe Audition.

Free tools are also available for creating multi-channel WAV files from a
number of single-channel WAV files. For example the “CDP Multi-Channel
ToolKit”, found here:

http://www.cs.bath.ac.uk/~rwd/mctools.himl
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Using Embedded Audio

46

Some video files contain an audio track in addition to the video. In this case,
the sound will play from the same display computer(s) as the video does. If you
don’t want this, cut the sound track out of the movie and place it in a file of its
own, thereby ending up with two media files: one containing the video and
one the audio. This allows you to place them separately in WATCHOUT,
making the sound play from any computer.

You can use QuickTime Pro or any QuickTime compatible video editing soft-
ware to split the audio and video tracks of a QuickTime movie into two sepa-
rate movies. In QuickTime Player, open the composite movie and choose
“Show Movie Properties” on the Window menu. Select the sound track and
click “Extract”. This extracts the sound track into its own movie, which you can
then save as an AIFF or WAV file using the Export command on the File menu.

NOTE: If your video file is not QuickTime compatible, you may not be able
to extract the audio from it. Try opening the file using a video editing appli-
cation, which may allow you to extract audio into a separate track, which
can then be exported.

In WATCHOUT, add both the video and the sound as separate cues. You can
now position them independently in the Stage window, allowing the sound
track to play through any display computer.
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LIVE VIDEO

COMPUTER SCREEN

Live video can be integrated into your presentation. This is particularly useful
in speaker support applications, since it allows you to bring an image of the

speaker onto the screen. It can also be used to play video from DVD or other
external video playback devices, or to use video originating from satellite links
or video conference feeds.

Video is brought into WATCHOUT by connecting the video source directly to

each display computer that will show the live video. This minimizes the delay

in the video signal — important for speaker support applications — while maxi-
mizing the quality by avoiding compressing the video signal. See “Live Video
Input” on page 224 for more details.

From a production viewpoint, you can use the live video image like any other
still image or video played from disk. Simply add the live video object to the
Media window and drag it onto the Stage or Timeline from there. See “Add
Live Video” on page 145 for more details.

Just like you can display a live video feed in your presentation, you can also
incorporate a live image of what appears on a computer's screen. This can be
used to show Excel graphics, Powerpoint slides, a Web browser, or similar
software applications, as part of your presentation.

The image displayed on the source computer’s screen is sent continuously via
the network to the WATCHOUT display computers, where WATCHOUT
composites it with other media. For example, you can put a plain Powerpoint
presentation on top of a large, high-resolution background, thereby enhancing
it with all the high-quality presentation capabilities of WATCHOUT.

The computer to supply the image must have VNC server software installed
and configured. See “VNC Server Software” on page 20 for more details.
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Using an RGB Capture Card

J

An RGB capture card.

NETWORK VIDEO

48

From a production point of view, you use the live computer image just like any
other image. Simply add a Computer Screen object to the Media window and
drag it onto the Stage or Timeline from there. See “Add Computer Screen” on
page 143 for more details.

Although the VNC-based solution discussed above provides excellent image
quality at virtually no additional cost, it does require a fast computer for
running the VNC server software. Even so, it may not provide full frame rate,
and may hamper the performance of the computer somewhat, since it has to
handle both the VNC server and the application being displayed (for example,
Powerpoint).

As an alternative, you could use an RGB or DVI capture card to bring the
computer into WATCHOUT. This solution is essentially identical to the “Live
Video” input, described above. However, it requires a different capture card
that can be connected to the source computer instead of a video camera.

An example of an RGB capture card is the Datapath VisionRGB:
http://www.datapath.co.uk/products/video-capture-cards

Some computers have an HDMI output, or can be used with a DVI-to-HDMI
adaptor cable, in which case you may be able to use an HDMI capture card
for computer display purposes (see “Live Video Input” on page 224).

This media type is similar to Live Video, except that video is received via the
network rather than using a capture card. It can be used with network-enabled
video cameras and other devices, applications and services capable of
sending video over the network. WATCHOUT supports standard streaming
protocols such as RTP and RTSP and video encoding formats such as H.264 or
MPEG-2.
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Stream

The advantage of this media type is that it requires no additional hardware
installed in the computer and that it adds new kinds of video sources. A
possible disadvantage is the noticeable delay incurred by the network stream
processing, making it unsuitable for on-camera speaker display (IMAG), or
other applications calling for low latency.

Assuming that you have such a network streaming source available, it can now
be incorporated into your presentation by choosing “Add Network Video” on
the Media menu. Specify a name for the source, such as the name of a
network-attached camera.

Network Video [ |
Marme: E’E

Stream: () Multicast (@) Unicast

URI: rtsp:ff192.168.0. 178 /axis-media/media. 3gp

Preview: @ Live () Thumbnail

Dimensions
Width: 1280 Height: 720

Choose whether the data is sent as a multicast or unicast stream. In general,
unicast is preferred. Use multicast only if the video stream will be shown by
multiple display computers simultaneously. This setting doesn’t apply to RTP
streams.
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URI

Preview

Dimensions

DYNAMIC IMAGES
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Enter the Uniform Resource Identifier of the stream’s source. The details here
vary with the camera or application sending the stream, so you need to consult
the device’s documentation. As an example, an AXIS network camera used the
following URI (where the group of digits is the IP address assigned to the
camera):

risp://192.168.0.178/axis-media/media.amp

Select “Live” to see the network video in the Stage window. Generally, use this
setting only for initial festing purposes, or when using a multicast stream (see
above). For final playback, you're advised to use the “Thumbnail” preview
mode.

Enter the width and height of the video stream’s image, as dictated by the
originating device. In the example above, this is the native resolution of the
video camera.

The WATCHOUT Dynamic Image Server allows you to incorporate dynamic
data into your presentation, such as:

e Still images that can be updated live by simply dropping a new image into
a folder.

* Graphs obtained from databases or other sources.

* Up-to-the-minute news, available from online providers such as CNN.
e Live stock quotes.

To use dynamic content in your presentation:

* Make sure the WATCHOUT Dynamic Image Server is running on a
computer accessible from your display computers via the network.
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* Provide content for the image server in the form of still images or Flash
(SWF) files.

® Choose “Add Dynamic Image” on the Media menu to add the corre-
sponding media item fo your presentation (see page 148).

* Drag the media item onto the Stage or Timeline to make it appear on
screen.

Please refer to “Dynamic Images” on page 217 for more details on how to use
this feature.
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TEXT

52

This media type makes it easy to add headings and other texts to your
WATCHOUT show without having to use an external program, such as Adobe
Photoshop. To add a text to your presentation, choose “Add Text” on the
Media menu, enter your text in the checkerboard area and click OK.

Avial )72 vx1 - B@m IO =

= =] m= =] = == =] | = i
=0 &= EEU BE0 F|EOE
Text | Styles
Width: 500 px. | Style: [l Auto update Optimize For: @) Better Performance
Margin: 0 S [ — ] R () More Effects and Capabilities

e

To display the resulting text, drag it onto a timeline and position it on stage.
The text is shown on a transparent background and is used like a still image.
As the fext is rendered on the production computer, you don’t need to have the
fonts installed on your display computers. To change the text, double-click it in
the Media window or Alt-double-click the cue.
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Width  Specifies the width of the resulting text image, in pixels. The height will be
determined automatically by the amount and format of the text.

Font menu  Choose any font installed on your production computer and apply it to the
selected text. Note that you must select some text before you can apply a new
font. The same goes for most other settings, as they apply on a per-character
basis.

Text Color  The color swatch next to the Font menu specifies the color of the text. Again,
first select some text then click the button to choose a color.

Font Size and Scale Factor  This menu, in conjunction with the scale factor, determines the size of the text
as displayed in your presentation. For small to medium sized text, keep the
scale factor set to 1 and adjust the font size. For very large text, use the scale
factor to scale the rendered text while keeping the edited text at a manageable
size. The scale factor also governs other dimensions, such as the size of any
drop shadow, but does not apply to the Width setting.

72 wxl -

Bold and ltalics  These checkboxes apply the corresponding styles to the selected text.

Text Alignment  The alignment radio buttons align paragraphs to the left, center, right or
adjusted on both sides. Although adjusted text isn’t shown as such in the dialog
box, the rendered text will be adjusted.

@

Text Indentation  The Indent and Hanging Indent seftings indent the selected text by the specified
ging 9 Y P
r=y & = = amount. Note that these settings cpp|y to entire parqgrqphs.

=0 =

Leading and Paragraph Spacing  These fields control the spacing of lines and paragraphs in the selected text.

To 2=, = Usenegafive numbers to tighten the spacing.

-

(4]
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Bullets and Numbering
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Margin

Style

Reset Text
Set Style

Update and Auto Update

Optimize For...
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These checkboxes display a bullet or a paragraph count in front of each
selected paragraph. Use the Hanging Indent setting to control the distance
between this embellishment and the text itself.

Adds additional spacing on both sides of the text, as a percentage of the font
size. This may be required to account for certain italicized fonts.

Chooses a common text style, as defined under the Style tab (see page 55).

Resets the text, removing any local overrides, so it matches the sty|e selected on
the Style menu.

Updqtes the sty|e selected on the Sty|e menu to match the current|y selected
text. Doing so affects all texts using this style.

Click “Update” to see the result of your changes in the Stage window
(assuming the fext being edited is currently displayed). If you select the “Auto
Updqte” checkbox, the stage will qutomqticc”y Updcte whenever you make
changes. This may be time-consuming when rendering large fexts - especially
when also applying effects.

This sefting serves the same purpose as for still images, and has the same
restrictions (see “Optimize For...” on page 36).
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Style

You may define text settings that can subsequently be applied across several
Text media items, thus maintaining a consistent style throughout your presenta-
tion. To define a style, click the Styles tab in any Text media item.

e - ¥ |5B7E=e S0 Bomo|'s: B B Hz: =D
Styles: Preview:
[ ad | [ pekte | [ coy | [ Paste |
Light Angle: []orop shadow Distance:| 10 ~ px. | [JEmboss  Width:| 5 = o
[#] Use glabal angle Opadty: - Blur:| 5 * px. | Strength: -
[ OK ][ Cancel ]

A non-editable preview fext is displayed in the checkerboard area of the
window. If you have typed anything into the Text media item, that text will be
used for the preview. Otherwise, a default text sample is shown.

Change any of the settings (Font, Size, Color, etc) using the controls along the
top of the window. The preview area shows the result. Style settings apply to
the entire text, so you don't need fo select anything before changing settings.
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Add/Delete Style

Text Effects

A text style with Emboss and Drop
Shadow effects applied.

Light Angle

Applying a Style

Transferring Styles Between Shows
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Click Add to create a new, named style based on the current settings, then
enter a style name. To delete a style, first select it in the list, then click Delete.

The controls along the bottom of the window allow you to add a drop shadow
and emboss effect to the rendered text. Your settings here are reflected in the
preview area of the Styles tab, but do not appear in the main editing area of
the Text tab.

NOTE: Applying a drop shadow effect renders the image slightly wider than
the specified Width setting in order to accommodate the shadow without
causing the text to re-flow.

Controls the perceived angle of light expressed by the emboss and drop
shadow effects. Setting the light angle to be from the top left causes the drop
shadow to appear below and fo the right of the text. Select “Use global angle”
to use a common angle across all styles with this option selected, or uncheck
this checkbox to set the angle independently for the current style.

Once a style has been defined in this way, you can apply it using the Style
menu on the Text tab. Note that local overrides applied to the text take prece-
dence over style seftings. Click the “Reset Text” button to remove all local over-
rides, setting all the text according fo its style.

Use the Copy button to copy selected styles to the clipboard. You can then
paste those styles into another show to establish the same set of styles.
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DMX-512 RECORDING

Specify a file for storing the recorded
DMX5 12 data. Save this file in/under
the folder containing the current show

file.

Choose the Artnet Universe number
used by the lighting console. Only
data sent on this universe will be
recorded.

WATCHOUT can control individual lighting channels directly (see “DMX-512
Output” on page 205). However, when using numerous lighting channels, or
moving lights, a dedicated lighting console is generally required. By recording
the data from the console into WATCHOUT, you can then simplify such systems
by removing the console and use WATCHOUT to play back the lighting control
as it was recorded. Assuming that you have a lighting console connected to
your network using the Artnet protocol, you can record its programming by
choosing “Add DMX512 Recording” on the Media menu.

Sawvein: || DMX - @ o

Date modified Type

ke Mo iterns match your search.
Recent Places

Desktop 4 \
g L File name: ConsoleSeql
e
Save as type: dmx files {*.dm)
Computer \

Record DMX512 Data from Universe: 2

Y
-

NOTE: If your lighting console doesn’t support Arinet directly, this requires
a DMX512-to-Artnet adapter. See page 201 for more details.
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. . * Drag this new item from the Media window onto a timeline. Note that the
b ‘% el symbol on the cue is displayed in yellow, indicating that it is ready to be
— recorded. Place this cue where you want the recording to start, and extend
it to cover the duration of the recording.

—— Ready to Play.

Recording. * Run the timeline along with the lighting console. You may simply start

Not recorded. WATCHOUT and cue the console manually. Alternatively, use timecode to
synchronize them.

* As the timeline reaches the cue, recording commences, as indicated by the
lamp symbol on the cue turning red. Allow the timeline to run for the entire
duration of the cue.

* Once recording is complete, the lamp symbol on the cue becomes gray.
e Disconnect the lighting console from the network, or switch it off.

Play the WATCHOUT timeline again. The recorded DMX512 data will now be
played back by the cue. An Artnet-to-DMX512 adapter is required unless your
fixtures/dimmers accept Artnet directly.

You can use the Fade tween track of the cue to modulate the intensity of the
recorded channels, if desired.

NOTE: Do not use the Fade tween track if any recorded channels use 16 bit
precision — often used by moving lights and similar devices.

If you make a mistake during the recording, or simply want to do another take,
you can reset the recording to its initial state by double-clicking it in the Media
window and selecting the “Re-record DMX512 File” checkbox. This dialog box

DM File:  /Ct/ShowsTest/DMX ConsoleSeq 1.dmx Browse...

["|Re-record DMX512 Fle

[Pl Override Artet uiverse: [ 2 also allows you to play the recording back using a different Artnet universe
ok [ conce | than the one recorded.
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4 PRODUCTION

STAGE

Adding and Removing Displays

Arranging Displays

This chapter goes through the steps required to produce a presentation using
WATCHOUT. It assumes that you have already produced the source media
assets, as described in the previous chapter.

The Stage window allows you to arrange the display areas and provides a
preview of your presentation. Portions of images that appear inside a display
will be shown by that physical display. By arranging displays side by side or
vertically, you can make images span multiple displays.

To add a display to the Stage window, choose “Add Display” on the Stage
menu. This menu item provides a choice of standard display sizes. Once a
display has been added, set its IP address and other settings through its Speci-
fications dialog box (see “Display Specifications” on page 158).

To remove a display, select the display by clicking it with the mouse so it shows
a bold outline, then choose Clear on the Edit menu.

NOTE: If “Online” is selected on the Stage menu, you can not add or
manipulate any displays.

Displays may overlap each other. When they do, images that span multiple

displays will be automatically blended at the edges. Alternatively, displays can
be positioned edge-to-edge, or with a small gap between them, for a videowall
look. By positioning the displays in the Stage window according to the actual
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Displays deliberately set apart to
account for the frame on LCD or
plasma screens.

arrangement and separation of the monitors or image areas, images that span
multiple display areas will line up properly.

B stage <<< OFF LINE>>> [= |[ @ |

B Stage <<< OFF LINE>>> [ || = |[oim]

Display 1 Display 2

Overlapping displays using
projectors.
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To arrange the displays, simply drag them to their desired positions using the
mouse. Alfernatively, you can position them numerically by selecting a display
and choosing Specifications on the Edit menu. Type in the desired position, in
pixels, relative to the upper left corner of the Stage (see “Display
Specifications” on page 158).

NOTES: The Stage window must be selected in order to manipulate the
displays. To select the Stage window, click its title bar. You can not select
the Stage window by clicking inside the window, as this is used to select and
move images when the window is not active. If the “Online” item on the
Stage menu is activated, you can not select, change or delete displays.
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Complex Display Arrangements

MEDIA

Adding Media

If you have complex display arrangements, such as multiple display areas or
different sets of display showing the same part of the stage, use Stage Tiers to
keep them apart. See “Tier” on page 133.

The term “media” refers to moving and still images as well as sound. These
media types are treated in very similar ways, with only minor differences
where appropriate. See Chapter 3 “Media” for more details.

To add media to your presentation, choose “Add Media File...” on the Media
menu, or simply drag the media file to the desired position in the Timeline or
Stage window. Media can be dragged from the folder where it is stored, or
you can drag media items from the WATCHOUT Media window.

=]=] = |
'\_:_;"\;‘,J' | . % Images

[ WATCHOUT + Show o (5 ]

File Edit Stage Preview Media Timeline Tween Window Help

Media file dragged

into timeline...

...appears as a cue in the time-

M stage << [ [= 5=

line as well as being displayed
in the Stage window.
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Editing a Media File

Refreshing Media Information

Purging Unused Media

Changing the File Association of a
Media List ltem

62

IMPORTANT: Whenever possible, store media files in a sub-folder of the
folder containing your WATCHOUT show file. This allows WATCHOUT to
use relative file paths, making it easier to move the show elsewhere.

To open a media file in its designated editing application, double-click its
thumbnail in the Media window, or Alt-double-click an associated cue in the
Timeline. To track down the media item associated with a cue, double-click the
cue and click “Locate Media”.

After making changes to media files, choose “Refresh” on the Media menu to
load those changes into WATCHOUT. Choose “Update” on the Stage menu to
update the display computers with these changes as well.

After working with a show for a while, you may have added many media items
that are not included in the final version. These media references persist in the
Media window, regardless of whether any cues actually use them. To remove
such unused media from the Media window, choose “Select Unused” on the
Media menu and then “Clear” on the Edit menu (see page 150).

NOTE: This operation will only remove unused entries from the Media
window. It will not remove any files from your hard disk.

Sometimes, when editing a media file, you may want to keep both the old and
the new version of the file around, in case you change your mind. In this case,
you end up with two or more similar media files with different names. To

change the link between an item in the Media window and a file, double-click
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the file name in the Media window and choose another file. This will affect all
cues that use this media list item.

NOTE: You can only relink it to another file of the same kind. You can not
change from an image file to a sound file, for example.

Using Media Proxies Occasionally, you may want to use media in your presentation but can not
import it simply by dragging. This would happen in the following cases:

* The media file isn’t recognized by the production computer, but you know
it can be handled by the display computers. Perhaps the media requires a
specialized codec in the playback computer which is not available in the
production computer.

¢ The media file is a large movie that has been pre-split into multiple files (see
“Pre-splitting Large Movies” on page 42).

* You want fo incorporate stereoscopic video into your presentation, using
separate left-eye/right-eye video files.

* The media may not yet be available, or may for other reasons need to be
provided or replaced manually on the display computer at a later time.

Use a media proxy to accommodate any of these cases. Once a media proxy
has been added to the media list, it can be used on the timeline just like other
media items. See “Add Proxy” on page 139 for more details.
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TIMELINE

P Layer 10

¥ Layer 9

Zoom button, cue area and tween
pane.

Adding Media Cues
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The Main Timeline window shows the temporal relation of cues and effects, as
well as the layering of overlapping media. Cues control the display and
presentation of media, and use tween tracks to control various aspects of the
media.

The amount of time displayed in the timeline window can be controlled using
the button in the lower left corner. Zoom in to increase the precision by which
you can position cues and set their duration, or zoom out to get a better over-
view. The center part of the button allows you to change the scale gradually.
Changing the time scale has no effect on the behavior of the timeline or its
cues. See “Main Timeline Window” on page 101 for more details

Tween tracks are used to animate properties of media cues, such as position
and opacity, over time. The tween tracks of the currently selected cue appear
at the bottom of the timeline window, called the tween pane. See “Tween
Tracks” on page 179 for more details.

HINT: When tween tracks are visible, you can toggle between the cue and
tween panes using the Tab key.

To add a media cue to the timeline, drag the media onto the timeline and drop
it at the desired layer and time position, as shown on page 61. Cues can be
dragged along the timeline to change their timing relationship. Select multiple
cues by Shift-clicking the cues, or by clicking and dragging diagonally, starting
from a point where there are no cues.

IMPORTANT: Do not overlap cues on the same layer. Doing so may cause
images to display incorrectly. When you want images to overlap in time,

always put their cues on separate layers. Overlapping cues are indicated
by a red warning line above the cues.
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Positioning Media on Stage When media is added to the timeline, it also appears in the upper left corner

of the top/left display in the Stage window. To make the image appear else-

where, drag the image’s preview in the Stage window, or double-click the cue
to set the position numerically.

HINT: For precise positioning of selected images, hold down the Control key

and press the Arrow keys to nudge the image one pixel at a time. Add the
Shift key to move ten pixels at a time.

When using a Position tween track to make images move, the current position

of the image is shown numerically in the tween track’s header area. Click the
triangle to reveal the numeric position.

B stege <<<0F. [ = | =@ [ 22| | BE Main Timeline

0:03.300 0:00

W Layer 10
Drag image in Stage window.

Stage position of the image.

s
lJ.‘ni'.f«.’»lij.- X
I

If the image isn’t visible in the Stage window, it may be obscured by a larger
image in front. You can hide the large image by clicking the yellow sun icon in
its layer title area (see “Disabling Layer Preview” on page 103).

IMPORTANT: Make sure that the timeline window is selected before
attempting to drag the image in the Stage window.
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Layering Media The horizontal layers in the timeline window allow you to control the stacking
order of images in the Stage window. To move an image towards the front,
drag its cue up to a layer with a higher number. To move the cue without
changing its time position, press the Shift key while dragging. Use the
commands on the Timeline menu to add or remove layers.

- Main Timeline =

Click the triangle to expand the
layer to see the entire cue.

Drag to move the partition between
the cue pane and the tween pane.

Drag to resize the tween track.

Changing the Media Association You can change the media association of a cue by dragging new media onto
of a Cue the cue. This changes the media association of that cue only, while retaining all
other relevant properties.

HINT: This can be used to duplicate a complex move or other effect using
different media. First make a copy of the cue to re-use, then replace its
media association as described above.
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Changing a Cue’s Duration

Aligning Cues in Time

Cue Specifications

When adding moving images or sound, the duration of the cue is set to the
duration of the file. When adding still images to the timeline, the duration is set
to a default value. Change the duration by selecting the cue and dragging the
vertical bar located at either end of the cue.

NOTE: If the cue has any tween tracks, their tween points will, by default,
remain stationary in relation to the timeline. To make the tween tracks
contract or expand with the cue, press the Alt key while dragging the bar.

A video or sound file can be cut short by shortening the cue. Increasing the
cue’s duration beyond the actual length of the media will make a video stop at
its last frame. See also “Looping” on page 175 for more options.

NOTE: Dragging the start of a moving image cue changes the starting time
along the timeline only. It does not affect the in-time of the movie. To change
the in-time, double click the cue and change its “In-Time” value.

Use the Snap command on the Edit menu to align objects in time. Cues snap to
adjacent cues. Tween points snap to other tween points in the same cue. Cues
and tween points also snap to the current time position.

HINT: To line up a number of objects in time, first position the current time
indicator then de-select “Click Jumps to Time” on the Timeline menu (see
page 151). You can now use the current time indicator as a ruler for
aligning cues and tween points.

In addition to direct manipulation of cues in the Timeline window, you can also
set most parameters numerically using the Cue Specifications dialog box.
Select the cue and choose Specifications on the Edit menu, or simply double-
click the cue. See “Cue Specifications” on page 170 for more details.
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Using Control Cues

Adding a Control cue to the
current layer of the timeline.
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In addition to media cues, you can also add control cues to the timeline by
choosing “Add Control Cue” on the Timeline menu. When reached during
playback, a Control cue set to Pause causes the timeline to halt. This is useful

when cueing a presentation manually.

9

B WATCHOUT + WO5 = | B |
File Edit Stage Preview Media | Timeline | Tween Window Help
S ¥ Click Jumps to Time Ctrl-T
. Main Timeline
0:11.800 0:1G 0:14 Add Play Control Cue Ctrl-P
m Add Pause Control Cue Ctrl-Shift-P
Append Layer
m Insert Layer Ctrl-1
Delete Layer Ctrl-Delete
---------------- Layer Settings...
Timeline Settings... Ctrl-J

s

NOTE: If you want a Control cue to coincide with the start of another cue,
then put the Control cue on a separate layer. If you don’t do this, the Control
cue may be hidden behind the other cue. You may want to dedicate a layer

for control cues only.

Control cues provide many other functions for managing the flow of your
presentation. This is often useful for speaker support or other situations where
live elements or other forms of interaction are involved. For more details, see
“Looping and Jumping” on page 81 and “Control Cue” on page 193.

Production
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TWEEN TRACKS Tween tracks control the behavior of media dynamically throughout the cue.
For instance, you can use an Opacity tween track to make an image fade in
and out, or a Volume tween track to reduce the volume of a sound or movie

file.
Adding and Removing a Tween To add a tween track, first select the cue then chose the desired type of tween
Track track on the Tween menu. Likewise, remove a tween track by de-selecting it on

the Tween menu.

B WATCHOUT = WO5 = | B s

File Edit S5tage Preview Media Timeline | Tween | Window Help
__ el

L&)

. Main Timeline

0:08,200 0:10 0:15 0:20 0:25 0:30 a4

Drag this partition to enlarge the
tween pane.

Tween pane.

The tween tracks of the selected cue appear in the tween pane at the bottom of
the Timeline window. Drag the partition to see more tween tracks. Likewise,
you can adjust the height of a tween track to see more details.
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Adding Points

Removing, Cutting and Pasting
Tween Points

Stretching Tween Tracks

Corners and Smooth Tween Points
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Adding a tween track to a cue generally has no effect in itself unless you use it
to change the value governed by the tween track. This is done by adding and
adjusting tween points along the tween track. These tween points provide
values acting as key-frames along the cue’s tween track.

To add a tween point, click anywhere on the curve in the tween track where
there isn’t already o tween point. To edit the value of a tween point, drag it
using the mouse. For better precision, first enlarge the tween track by dragging
the partition between the tween tracks. Select multiple tween points to move
them together. Press the Shift key while dragging to constrain the movement of
the tween points.

NOTE: Normally, tween points can’t be dragged past their neighbors. To
relax this constraint, press the Alt key while dragging.

Select multiple tween points by Shift-clicking, or by dragging from a position
outside all tween points. The selected tween points can then be edited using
commands on the Edit menu. This makes it easy o move complex tween tracks
from one cue to another, by simply copying and pasting the tween points.

When changing the length of a cue by dragging its end, you have the option
of either leaving its tween points at their current time positions or making them
expand and contract with the cue, as if the cue was a rubber band. Press the
Alt key during the drag to get the rubber band effect.

For simple values, there are two kinds of tween points: corners and smooth
points.

NOTE: Position tween tracks use a different method to create smooth
motion, as described on page 75.
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Add a corner point by clicking the

curve.

Add a smooth tween point by
Control-clicking.

Editing Tween Points Numerically

External Control of Tween Tracks

A corner is represented by a diamond-shaped tween point. A sequence of
corner points causes the value to change gradually, and linearly, between the
points. Often, this is the desired behavior, particularly when controlling opacity
or volume.

A smooth point is represented by a round tween point, and is added by
Control-clicking. It acts as a pin attached to the curve by a rubber band. When
you move the smooth point away from the curve, the rubber band stretches,
causing the curve to bend.

! Main Timeline = @

P | opmp % P

To edit a tween point numerically, double-click to open its dialog box. See the
description of each type of tween track under “Tween Tracks” on page 179 for
more defails.

Tween tracks can also be controlled by external inputs. Those are indicated by

a round formula button under the title of the tween track. See “Controlling
Tween Tracks” on page 202 for more details.
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OPACITY

VOLUME

SCALE

e
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Scaling handle.
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Use an opacity tween track to fade objects in and out, or to make objects semi-
transparent. An opacity tween track can be applied to all images. See
“Opacity” on page 180 for more details.

To cross-fade from one image to another, you only need to fade the opacity of
the image at the front. You don’t need to do anything to the image behind it,
as this will be obscured by the front image unless the front image contains
transparent or semi-transparent areas. In this case, you may also need to fade
out the image below to perform a smooth cross-fade.

Use a volume tween track to control the volume of sounds and movies
containing embedded audio. You can play several sounds simultaneously, and
cross fade between them by fading up one while fading out the other. See
“Volume” on page 180 for more details.

NOTE: When no volume tween track is being applied, the volume is set to
the value specified in the Preferences dialog box (see “Default Audio
Volume” on page 121).

Use a scale tween track to change the size of images. This is particularly useful
for playing video material at full screen size, but can also be used as an effect
for both still and moving images. In addition to dragging the tween point, you
can also adjust the scale by dragging the scaling handle. This appears in the
lower right corner of the image after adding a Scale tween track. Press Shift
while dragging to maintain the aspect ratio of the image.

HINT: By using negative scale values, you can flip or mirror the image.

See “Scale” on page 181 for more details.

Chapter 4 Production



ROTATION z

.Stage << 0. [ o |[ E || &

‘ )
Anchor Rotate by dragging
point. the rotation handle...
ROTATION X AND Y

Use a rotation tween track to control the angle of images, or to make an image
rotate over time. Rotate the image by dragging the rotation handle or the rota-
tion tween point. You can rotate by degrees as well as by number of revolu-
tions (or a combination of the two). See “Rotation Z” on page 184.

(= ]G s

- Main Timeline

...or by dragging a
rotation tween point.

NOTE: The rotation handle may be hidden underneath the anchor point. If
so, either move the anchor point as described below, or drag the tween
point to adjust the angle.

These tween tracks are similar to Rotation Z, but allow you to rotate images
around the X (horizontal) or Y (vertical) axes, providing a perspective view of
the image.

NOTE: The amount of perspective being applied is controlled by the
Perspective slider in the 3D tab of the Preferences dialog box.

Chapter 4 Production 73



ANCHOR POINT

74

Images scale and rotate around the anchor point. The anchor point is indicated
by a white crosshair in the Stage window (see illustration above). To change

the anchor point, double-click the cue and change the values under “Anchor

Position within Image”. See “Cue Specifications” on page 170 and “Anchor

Position” on page 172 for more details.
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POSITION

Editing Position Points

Use the position tween track to position an image on stage, or to make an
image move along a path. Select one or several images on stage, then drag
them in the Stage window. Alternatively, press an arrow key while holding
down the Control key to move the selected images one pixel at a time. Press the
Shift key as well to move in 10 pixel increments.

HINT: The initial stage position can also be changed numerically inside the
cue’s dialog box. If you change this for a cue that has a motion path, the
entire motion path moves. Use the Move command on the Edit menu to
move multiple images together after selecting their cues (see page 127).

To make an image arrive at a specific stage location at a particular time, first
add a tween point at the desired time, then position the image in the Stage
window as described above.

NOTE: To change the stage position of an already existing tween point,
make sure the timeline is positioned at that point before moving the image.
If not, a new tween point will be added instead. To ensure that the timeline
is positioned at a tween point, first de-select all tween points, then click the
tween point with “Click Jumps to Time” selected on the Timeline menu.

Alternatively, drag one of the handles attached to the motion path in the Stage
window, or double-click the handle or tween point to type in the desired stage
position of the image.
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Moving Along a Path

To make the image move along a path, first add a tween point by clicking at
the desired time position along the tween track, then drag the image to the
desired position in the Stage window. A line indicates the image’s motion path
in the Stage window.

B stage <<< OFF LINE>>> o |[= )= BS Main Timeline [ ® |23

Controlling the Speed of Motion

Moving Along a Curved Path
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¥ Layer 9

Double-click a position tween point to change its incoming or outgoing speed.
A value of 1 indicates nominal speed, with smaller values being slower an
greater values being faster. The speed is indicated by the white dots along the
motion path, with dots spaced farther apart indicating faster motion.

By default, a Position tween point acts as a corner along the motion path. To
move smoothly through a point, double-click the point and select Smooth. You
can control the incoming and outgoing segment independently. Selecting the
Smooth option reveals a yellow direction handle, controlling the path of motion
into or out form that point. Close the dialog box and drag the direction handle
to create a curve. In the illustration below, smooth points have been set to move
the image along an S-shaped curve.

Chapter 4 Production



-Stage <<< OFF

Speed handle.

LINE>>> | o |3

Direction handle.

3D Motion Paths

Dragging the direction handle farther away from the point increases the curva-
ture. Add tween points for better control over the path’s shape.

HINT: To make an image rotate while moving, so that it always points along
the motion path, double-click the cue and select “Auto-orient along Motion
Path” (see page 178).

Images can also be moved along the Z axis, or using a 3-dimensional motion
path. To change the Z position of a position tween point, drag the point verti-
cally in the tween track. Double-click the tween point to set the value numeri-
cally. If the image moves away from you (positive Z), it appears smaller
according to distance as well as the amount of perspective set by the Perspec-
tive slider in the 3D tab of the Preferences dialog box.
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3D/STEREOSCOPY

Still Images and Small Video

Large Stereoscopic Video

Stereoscopic Projection

78

WATCHOUT allows you to produce and present stereoscopic presentations, to
be viewed using appropriate display technology and glasses. These are some-
times referred to as 3D presentations, giving a perceived three-dimensional
viewing experience. Such presentations can incorporate still images as well as
video. They take advantage of the 3D capabilities of WATCHOUT, in many
cases creating the stereoscopic effect with no additional production effort,
since it can be calculated from the 3D position of media elements.

When using still images and small video elements, it is generally sufficient to
place them at the proper depth (Z position). Hence, to make an obiject appear
closer to the viewer, move it o a negative Z position rather than merely scaling
it up to make it look larger. The amount of stereoscopy derived from the Z posi-
tion is controlled by the “Eye Distance” setting (see “Eye Distance” on page
125).

Large or full-screen videos will not reproduce with a stereoscopic effect by
merely changing the Z position. Instead, the entire video needs to be produced
as stereoscopic footage, with separate left/right eye video files originating
from two cameras or a specialized stereoscopic camera. Use a Video Proxy to
incorporate such a video info your presentation (see “Stereoscopic” on page
140). High-resolution stereoscopic stock footage is available from companies
such as Artbeats:

http:/ /www.artbeats.com/s3d

You need specialized display or projection technology to show a stereoscopic
presentation, combined with stereoscopic glasses worn by all viewers. See
“Stereoscopic Presentations” on page 86 for more details.
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5 PRESENTATION

CONNECTING TO THE DISPLAY
COMPUTERS
A Stage [= [ E ]

Display 1 D@E
1

I I
Progress bar Unable to
shown during connect fo this
transfer of files. ~ computer.

Quitting the Display Software

This chapter tells you how to take your WATCHOUT presentation from your
production computer onto the display computers, and run the presentation. It
discusses the various ways in which your presentation can be used and
controlled.

After installing and configuring the production and display computers,
producing the presentation, and starting the display software on each display
computer, you can select “Online” on the Stage menu. This causes the produc-
tion computer fo connect to the display computers and transfer all required
information to them, ready for playback. A progress bar indicates the transfer
of files to each display computer.

Failure to connect to a display computer is indicated by an error icon in the
Stage window. If you get a error icon, quit the WATCHOUT display software
on the offending display computer and double-check the network configura-
tion to ensure that it has been set up properly (see “Network” on page 16 and
“Computer Settings” on page 22). Also confirm that the IP address of the
display computer matches the settings in the Display Specifications dialog box
(see “Display Specifications” on page 158).

Any further problems encountered after connecting to the display computers
will be reported in the Message window in WATCHOUT and/or on the display
computer’s screen.

To quit the display software, press Ctrl-X or Alt-F4 on the display computer.
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Downloading Media Whenever you go online, WATCHOUT will check to make sure that all
required media files have been transferred to the display computers.

8 D:\ WATCHOUTYS -|alx|| WATCHOUT will only transfer the files actually required on the individual
He Edt Vew Favorie | A0 computer. Ifxou modify a media file, WATCHOUT will detect this and transfer

the updated file.

Folders X || Marmne - | . R . .

WATCHOLT o[ Scae While media files are being transferred to a display computer, a progress bar

& re C)Media will be shown in that display in the Stage window, as well as on the display

= ]LicenseKeyInst' [ CachedFies computer itself. You may continue working in WATCHOUT while files are

O wPee2 I spec being transferred, but you will not be able to further update or access the

D) resource display until the previous update has completed.

) Shows HINT: You can stop an update in progress by deselecting “Online” on the
¥ ) CT DEMO 3 Stage menu. The transfer will stop once the current file has been transferred.
=1 1) {EER(E - . . . .

_'lJ i N Note that all media files transferred to the display computer will remain there
until removed manually. The media related to a show is stored in a folder with

the name of the show. This is located in a “Shows” folder in the same folder as
The “Shows” folder contains a folder e WATCHOUT display software application.

related to each show that has been  After using a display computer to run a show, you may want fo clean up the

transferred to the display computer.  Shows folder by putting its contents into the trash and emptying the trash
before using that computer to run another show. This stops old shows from
occupying hard disk space unnecessarily.

NOTE: If you for any reason remove the “Cache” folder, then remember to
remove the “CachedFiles” file as well. This file is used to keep track of what's
in the “Cache” folder. If you experience problems displaying certain
images, you may try removing the “Cache” folder and the “CachedFiles”
file. WATCHOUT will re-create this file the next time you open the show.
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Updating the Stage

RUNNING THE PRESENTATION

Manual Control

Looping and Jumping

If you make changes to your show while online, transfer them to the display
computers using the “Update” command on the Stage menu. This includes
adding new media or cues.

Once all media has been transferred to the display computers, the
WATCHOUT logo on the display computers will disappear. You are now
ready fo run your presentation. To run it, click the play button in the lower left
corner of the Timeline window, or press the spacebar.

You can jump to any point along the timeline by clicking in the time ruler at the
top of the Timeline window (see also “Timeline Settings” on page 152).

For speaker support, or other manually controlled presentations, add Control
cues to the timeline. When run, WATCHOUT performs the instructions
embedded in the cue — for example, pauses or jumps to another position along
the timeline (see “Looping and Jumping” on page 81).

You can also use Control cues to instantly go to any location in your presenta-
tion. Give the cue the same name as one of the function keys on your
computer’s keyboard (for example, name if “F1”), then press that function key
to jump straight to it. See “Add Play / Pause Control Cue” on page 151.

Use a Control cue to loop any segment of the timeline (see “Add Play / Pause
Control Cue” on page 151 and “Control Cue” on page 193). By combining
this with the QuickFind feature (page 129) and the Standby command

(page 134), you can gracefully exit loops or jump to other sections of the
presentation.
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External Control Options

DMX512
miai

82

You can use a touch panel, such as an iPhone/iPad, or other external control
system to remotely control your WATCHOUT presentation, as well as the
presentation environment. Since WATCHOUT uses the ubiquitous TCP/IP
protocol, it can communicate with virtually any computer system or device.

HINT: Download the free WATCHOUT Remote app for iPhone:
http://itunes.apple.com/us/app/id426344171

Furthermore, using the MIDI and DMX-512 input capabilities, WATCHOUT
can be controlled using any device that can speak those industry-standard
communications languages.

For museums, visitor centers, and similar places where personalized or multi-
lingual audio is desired, you can use WATCHOUT together with Dataton
PICKUP. PICKUP plays the audio of the presentation, and acts as a remote
control for starting the presentation.

http:/ /www.dataton.com/pickup/

To integrate PICKUP with your WATCHOUT display clusters, use the Dataton
NETWORK TRANSPONDER, which connects to your Ethernet network. In
addition to acting as an IR transponder for PICKUP it also controls your
WATCHOUT presentations. It provides advanced features such as synchro-
nized audio playback. It can also match the language selection between
PICKUP and WATCHOUT by means of controlling the conditional layers in
WATCHOUT (see “Condition” on page 104).
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EXTERNAL CONTROL

Activates external control through
the network port on the produc-
tion computer.

For more complex applications, you may want to integrate WATCHOUT with
other control systems. This can be accomplished by means of external control
of your WATCHOUT system through the network.

To control the production computer, connect the external controller to the
network and activate the TCP/IP control port in the Preferences dialog box.

Preferences Iﬁ

#

[ o Online Automatically After Opening Show

.

Production Computer Control: TCRfIF  [|UDP
[ Timecode Contral of Main Timeline (LTC EBU/SMFTE)

Timecode Format: | Auto Detect
Time Offset: (0.0 +or -
[ MIDI Show Control, Device ID: | 0
MSC Cue Lists: | Ignore Command (do nothing)
DM 512 Universe, In: 0 Out: 1

Default Dynamic Image Server Address: 192.168.0.49

[ OK ] [ Cancel

)

See page 251 for more details on how to control WATCHOUT from a touch
panel or another computer via the network.
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Display Cluster Control

TIMECODE CONTROL

Controlling the Production Computer

% Sound ==

Playback | Recording | sounds

Select a recording device below to modify its settings:

a Unba\anced

Microphone

A

Aux

Line In
F' altek High Definition Audio
orking

Rea\tek D\gltallnput

Properties
]
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Instead of controlling the WATCHOUT production software, as discussed
above, you may choose to control a cluster of display computers directly. This
removes the need for a production computer during playback. Please see
“Display Cluster Protocol” on page 257 for details.

WATCHOUT can accept a standard timecode signal for controlling the main
timeline. This timecode synchronization feature uses the LTC format according
to the EBU or SMPTE standards. You can control either the production
computer or the display cluster.

To control the production computer, select the “Timecode Control of Main
Timeline” checkbox under Preferences, Control (as seen on the previous page).
Specify the timecode format and any offset to be applied. Connect the time-
code signal to Line In connector of the production computer. Starting the time-
code feed should now start the main timeline at the position specified by the
timecode.

IMPORTANT: Make sure that the correct sound input port is selected in the
Sound Control Panel shown to the left, and that the input volume is turned
up, indicated by the green bar next to the active recording device.

You can use the separate Timecode Tester application (see next page) on the
production computer to troubleshoot any timecode issues.

HINT: Add a “Timecode Position” item to the Status window to view the
current timecode being received. See “Status Window” on page 112.
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Controlling the Display Cluster

" Dataton WATCHOUT

Signal Strength:

Format:

Auto Detect
SMPTE-NDF

Film (24)
SMPTEDF

@) EBU (25)
SMPTE-30

Speed Deviation:  +0. 1%

Errors and Warnings:
Bi-phase Mark: 345

Duplicate Frame: 0
Discontinuity: 0 Clear
Invalid Frame: 0
Bad BCD Digit: 4]

The WATCHOUT Timecode
Reader application, used to
troubleshoot timecode problems.

Connect the timecode signal to Line In of the primary display computer and
activate timecode synchronization using the timecodeMode command, as
described on page 268.

NOTE: This method can not be used in conjunction with the WATCHOUT
production software. When the production software goes online, it tempo-
rarily disables any timecode input to the cluster.

Use the separate WATCHOUT Timecode Tester application on the primary
computer in the cluster to verify proper timecode reception, quality and signal
level. Connect the timecode signal to the Line In connector. Choose the appro-
priate input using the Sound Control Panel, as shown on the previous page.

HINT: Use the Windows Sound Control Panel to adjust the input level, if
required. Note that this setting is system-wide.

Quit the Timecode Tester after using it. Do not leave it running when starting
WATCHOUT display software, which contains its own timecode reader.
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STEREOSCOPIC PRESENTATIONS

86

WATCHOUT includes full support for stereoscopic (“3D”) presentations. In
terms of production, you can create the stereoscopic effect through proper
positioning of images along the Z axis, or by incorporating stereoscopic video
into your presentation. See “3D/Stereoscopy” on page 78 for more details.

You must use separate outputs from WATCHOUT for the left and right eye
channels. Set the left/right channel assignment in the settings dialog box of
each display accordingly. See “Stereoscopic Assignment” on page 166 for
more defails.

Since the left/right displays must occupy the same position in the Stage
window, you must place all left-channel displays on one stage tier and all right-
channel displays on another tier. This provides proper edge blending among
displays on the same tier. See “Using Stage Tiers for Complex Display
Arrangements” on page 98 for more details.

To present a stereoscopic production, you need projectors fitted with the
appropriate filters or other suitable stereoscopic technology. Your viewers must
wear glasses matching the stereoscopic filter technology used in the projectors.
In most cases, passive glasses are recommended. See “Stereoscopic Projec-
tion” on page 249 for more details.
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6 USING COMPOSITIONS

A Basic Example

A composition allows you to group a set of cues together on their own sub-
timeline. This can then be used from other timelines similar to how you can play
a video. A composition makes it easy to re-use or re-arrange show sections or
short snippets. It also makes it easier to apply the same effect to a group of
media elements — for instance, to move and scale a set of images together.

A composition behaves like other media elements, such as still images and
video clips. It lives in the Media window, from where you can drag it onto any
timeline to use it. You can use a composition any number of times — you can
even play multiple instances of a composition at the same time.

Similar to a video clip, a composition has a duration and may contain motion.
However, as a composition is created within WATCHOUT, there's no
rendering time or other delays involved in changing it. A composition can be
looped and/or free running, making it easy to create motion of indefinite dura-
tion within WATCHOUT.

For example, assume you want to add a frame to a video clip, and then make
the video clip move across the screen while scaling it up at the same time.
Although you could do this by applying the motion and the scaling to the video
and the frame image individually, it’s often hard to make the two move
together in a cohesive way. Instead, you can add both elements to a composi-
tion without applying any motion and scaling to the individual elements. Then
use the resulting composition from the main timeline, applying the motion and
scaling to the composition as a whole.
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Moving and scaling a video
together with a surrounding still
image frame.

CREATING A COMPOSITION

88

-

B stage <<< OFF LINE>>»

Start by choosing “Add Composition” on the Media menu. Give the composi-
tion a name, and type a suitable size into the “Reference Frame” field. In this
case, it is a good idea to make the reference frame just slightly larger than the
still image frame around the video. This reference frame will be used later
when manipulating the composition as a whole from the main timeline. See
“Add Composition” on page 143 for more details.
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Open the composition’s timeline window by double-clicking the newly added
composition item in the Media window.

@| FramedVideo =R |EoR| X

The timeline window of a new
composition.

Notice that the content of the Stage window changes when the composition
window appears. Instead of showing the display rectangles, it now shows the
reference frame of the composition. While editing a composition, its preview
appears in the Stage window, temporarily replacing the preview of the
displays. To restore the Stage window to its usual state, select the main timeline
window.

To change the size of the reference frame, or any other composition setting,
choose “Timeline Settings” on the Timeline menu while the composition’s
window is active.
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ADDING CUES You add cues to a composition in the same way as you do to other timelines.
In this example, we will add a video with a still image frame on top. Drag those
images onto the composition’s timeline. Their preview will appear in the Stage
window.

Composition preview mode. — L composition: FramedVideo <<< O FF LL.[ = | & |[ 2 |

Stage window content temporarily ——
replaced to show a preview of the
composition.

This rectangle represents the
composition’s reference frame.

Media added to the composition’s
timeline.

_! VideoFrame. png
-

m

LaunchClip.mpg

When you've added the media to the composition, close its timeline window.
This restores the Stage window to its normal preview mode.
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USING THE COMPOSITION To use your newly created composition as a whole, simply drag it from the
Media window onto the main timeline.

I WATCHOUT + Compl = | 5 |

File Edit Stage Preview Media Timeline Tween Window Help

Drag a composition from the Media
window onto the Main Timeline. ——— : ‘ = [TumcaiTee 0

Image 2657 x 14595

Folder
The yellow selection rectangle
around the composition corre-
sponds to its reference frame.

. Image

A composition cue appears on the — & e el Fomede ‘ Framediides
Main Timeline.

Starfield.jpg Starfield.jpg Starfield. jpg

Add tween tracks to move and scale —
the entire composition.

HINT: To open a composition’s timeline window from the Main Timeline,
press Alt then double-click the composition cue.
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NESTING COMPOSITIONS A composition may be used inside other compositions. This can be applied in
a hierarchical fashion to build complex animations one step at a time. This
example shows how to build a four cylinder car as a composition, starting by
creating a single cylinder from still image parts.

B WATCHOUT + Compl = | B S

File Edit Stage Preview Media Timeline Tween Window Help

Compos.. | = |l 5] || 83

Still image components.
\| Thumbnail § Type

House.png l Image
Preview of the PistonLoop i

e P 1.png = Image
composition. : - -

Rod.png l Image

______ Rotor.png ? Image

Composition timeline to make one ——
full revolution of the engine.

SE Ei\-ﬁ.g_ark.]

Piston.png Piston.png

Fod.png Fod.png Fod.png

NOTE: Select “Lock Duration” in
the “Timeline Settings” dialog box
of the composition, and set its
duration to one second (see “Lock
Duration” on page 154).

(.U'\ Rotor.png Rotor.png

House.png Hou:
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Add four instances of the “Piston

Loop” composition. Scale down all —

but the frontmost instance by incre-
ments of 10% each, and offset their
positions as shown.

Stage window preview of the
resulting “Four Cylinders”
composition.

Once the single “Piston Loop” composition works as desired, go ahead and

create the next, outer composition, naming it “Four Cylinders”. Add four
copies of the “Piston Loop” to this composition by dragging them from the

Media Window into the “Four Cylinders” timeline window.

l!? Four Cylinders

0:17.400 0:00

> Layer 4

% pistonLo

P Layer 2

bh-" PistonLoop

h@iﬁ__'i' PistonLoop

P Layer 1

IE.)‘;:_-‘JZ' PistonLoop

Since the “Piston Loop” contains a single engine revolution only, you need to
set each of the “Piston Loop” cues on the “Four Cylinders” timeline to loop. This
behavior is selected in the Composition Cue specifications dialog box, shown
by double-clicking the cues.

Drag out the tail end of all four cues to about one minute to give enough
running time to play with at the next level.

Chapter 6

Using Compositions

93




Once the complete engine works as desired, create the next outer level. This
level puts the complete cylinder engine into a car. While we could have done
this last step on the main timeline, doing it as yet another composition makes it
easier to do things with the car as a whole, such as driving it off stage.

Creae @ "Car w Engine”————1-8 carw Engine =5 (is
composition.
T | N -
” . ” | FeLr Cvlinders
Add a cue for the “Four Cylinders” — u
sub-composition. L

Fade up an image of a car. ———— BlueCar . tif

Use Position and Scale tween tracks — :
to put the engine into the car.

- ¥R m

Finally, drag the “Car w Engine” composition from the Media window onto the
main timeline. Add a Position tween track to make the car (including its engine)
drive off the stage affer a while.

NOTE: The complete engine animation, as shown above, is included with
WATCHOUT.
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7 WINDOWS

Media window, listing
all media used in your

presentation.

Stage window,
showing the display
areas and a preview of
the presentation.

Main Timeline window,
showing the layers, cues
and tween tracks.

Other windows are
described later in this
chapter.

B WATCHOUT + Show = | B S
File Edit S5tage Preview Media Timeline Tween Window Help
.
Sage e OFFLINESSs o= 1= 122 [ [ Pl Media (== ==

13
4

. Output

Input | |[[=1 [ &S|

(== e

. Task

(== &=

[. Messages | = |[= |[ 23]

l Status

=== |

MName
P Fanoramas
52.AIFF

SloMaoHD.m2v
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Manipulating Windows

All WATCHOUT windows reside inside a desktop window, with a menu bar

running along its fop. You can resize the desktop window by dragging any of
its outer borders or corners. Minimize or maximize it using the buttons in the
upper right corner. Clicking the close box is equivalent to choosing Quit on the
File menu.

Move a WATCHOUT window by dragging its title bar. Resize a window by
dragging any of its corners or outer borders. Minimize and maximize a
window using the buttons in the upper right corner.

Minimize, maximize or close the

WATCHOUT desktop.

B WATCHOUT + Show E=EREERX

|Fi|e Edit 5tage Preview Media Timeline Tween IWindcrleeIp

Use the Window menu to open
most windows.

Minimize, maximize or close the——]

window.

Drag border or corner to resize.

Minimized windows.
Click to restore.

RS Stage <<< OFF LINE>>> [[o [ 3 |

Opening Windows
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WMain.. =2 || = |[ 23]

e 4

Most windows are opened through the Window menu. Hence, if you acciden-
tally close a window, look here to re-open it. See “Window Menu” on
page 155.
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STAGE WINDOW

On/Off line indicator, corre-

.ﬁagghm OFF LIN E:-:-:-| (o ===

sponding to the “Online”
Stage menu item.

Displays added to the Stage
window.

Selected display.

The Stage window is used to add and arrange the display areas used in the
presentation. It also provides a preview of your presentation as you move
along the timeline, and lets you to position media on stage.

— Control-Alt-drag to
scroll the window using
the hand cursor.

Adding Displays

Sefting the Stage Scale

Adding Media

To add a display to the Stage window, choose Add Display on the Stage menu.
See “Adding and Removing Displays” on page 59 as well as “Displays” on
page 157 for more details.

Set the viewing scale for displays and images using the Scale command on the
Stage menu. Alternatively, you can inferactively set the scale by clicking in the
Stage window while holding down the Control key. This displays a magnifying
glass that allows you to zoom in at the clicked location. Drag with the magni-
fying glass to zoom to a specific area. Control-Shift-Click to zoom out.

Add media to your presentation by dragging it fo the desired location in the

Stage window. A corresponding cue will be added to the timeline window at
the currently selected layer and time position. To remove the media from the

stage window, remove the corresponding cue from the timeline.
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Positioning Media on Stage

Using Stage Tiers for Complex
Display Arrangements

Desired display layout:
Side displays (yellow)

You can position media on stage by dragging its preview in the Stage window.
To do so, first select the timeline window, then drag the image in the Stage
window. Press the Shift key to constrain the move. See “Positioning Media on
Stage” on page 65. Double-click a Cue or an individual Position tween point
to edit the position numerically (see “Initial Stage Position” on page 172 and
“Position” on page 182).

IMPORTANT: To change a position tween point, first click the tween point
to go to its exact time position, then move the image. If you don't go to the
tween point first, a new tween point may be added instead.

The straightforward method of adding displays to the stage, as described on
the previous page, works fine in most cases. However, more complex display
arrangements call for a different approach.

Assume, for example, that you want to make a display layout consisting of a
main area with three overlapping (edge blended) projectors, plus one
detached projector on either side, and finally a high-resolution plasma display
showing the center part of the screen. This plasma display could be placed
outside the theater, as a preview display. The detached projection screens on
either side of the center area will generally be used as part of the main show,
but will occasionally show different images to augment the center screen.

Center area (red, green, blue)

Larger, separate plasma (purple):
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Tier “Plasma” with the single
plasma display.

Merely adding all six displays to the stage will not work as desired for the
following reasons:

¢ The large plasma display overlapping the three projectors in the center will
cause WATCHOUT to attempt to edge blend all these four displays (over-
lapping displays automatically get an edge-blend gradient).

* Panning large images sideways on the large center area, or on the side
screens, will make those images intrude on the adjacent display areas.
That's OK while using all five projectors as a single, large canvas, but
undesirable when using the side displays independently.

You can overcome these problems by placing each set of displays on their own
stage tier. Stage tiers act as independent, named levels on the stage. Edge
blending occurs only among displays on the same tier. Furthermore, timeline
layers can be associated with specific tiers only, preventing their images from
spilling onto displays on other tiers.

Tier “Sides”

Tier “Main” with the three over-
lapped projectors.

To create additional tiers, choose “Tier: Add” on the Stage menu (see

page 133). To add displays to a specific tier, first select that tier on the Tier
sub-menu of the Stage menu. To associate a timeline layer with a stage tier, see
“Stage Tiers” on page 105.
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3D Views

Orbiting image viewed from the
front.

Displays appear as lines when

When working with images positioned in 3D space, or rotated around their X
or Y axes, it is sometimes hard to see where things are if you only view them
from the front. For instance, if you want to make one image orbit another
image along a horizontal plane, the motion path will look like a straight line
when viewed from the front. Choose “View Top” on the Stage menu to view the
stage from the top.

B stage <<< OFF LINE>»>

viewed from the top.

Orbiting image and motion path-

viewed from the top.

Previewing Without Perspective
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Likewise, for vertical motion, the stage can be viewed from the left. By alter-
nating between these three views, you can create elaborate three-dimensional
motion paths.

The Stage window generally shows images in 3D space using the perspective
set in Preferences. Deselect Perspective on the Preview menu to view and edit
images using an ortographic (non-perspective) view.
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MAIN TIMELINE WINDOW The timeline window holds the cues that make up your presentation. Cues are
arranged along layers, representing the back-to-front stacking order of images
on stage. Increasing layer numbers move the image closer to the front.

[ - Main Timeline |E||E”E|
Current time position and indicator.— Jump button.
Currently selected layer. L Time ruler.
Lock layer.
Collapsed layer. |i|
Layer attributes. Layer.
Disabled layer preview. -
—t— Tween pane.
Play button. 8 WEALPSN = ’ Time scale button.
Using the Scroll Wheel By default, the scroll wheel on the mouse scrolls windows vertically. The scroll
wheel can be combined with the following modifier keys in the timeline
window:
e Shift: Scrolls the timeline horizontally.
 Control: Moves the current time position in 0.1 second increments.
 Control+Shift: Moves the current time position in 1 second increments.
Time Position Indicator The current time position is indicated by a vertical line through the Timeline

window. Its color indicates the “Click Jumps to Time” mode (see page 151).
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Setting the Current Time Position

Adjusting the Time Scale

The Jump Button

Starting and Stopping

Adding Cues

Selecting the Current Layer

Changing Layer Height
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Click the time ruler to jump to a time position. To set the time numerically,
choose “Timeline Settings” on the Timeline menu. To go to the beginning of a
cue, or to a tween point, click it with “Click Jumps to Time” selected on the
Timeline menu (see “Click Jumps to Time” on page 151).

Click the magnifying glass areas of the time scale button to zoom in and out by
a fixed amount. Pressing the ‘+' and ‘=’ keys on the numeric keypad has the
same effect. Drag the center of the button to change the scale gradually.

Click the jump button, located to the right of the time ruler, to jump to the
current time position if scrolled out of view, or to jump back to the previous start
time. Pressing the asterisk key on the numeric keypad has the same effect.

Click the play button to start and stop playback. If the stage is online, this also
controls playback on screen. Pressing the spacebar is equivalent to clicking the

play button. Pressing O on the numeric keypad starts playback, Esc stops play-
back.

To add a cue, drag media from your hard disk or the Media window to a time-
line or the Stage window. See Chapter 10 for more details on cues.

Click a layer’s name to make it the currently selected layer. When pasting an
individual cue, it will be pasted at the current time and layer. Likewise, when
adding media by dragging into the Stage window, a new cue will appear at
the currently selected time and layer.

Click the collapse triangle to minimize and restore the layer height. Shift-click
to collapse/expand all layers.

Chapter 7 Windows



Adding and Removing Layers

Disabling Layer Preview

Locking a Layer

Layer Name and Attributes

Layers can be added, removed and renamed using the corresponding
commands on the Timeline menu (page 103).

To disable the layer preview in the Stage window, click the layer preview
symbol to turn it off. Shift-click to disable/enable all layers. Disabling a layer
allows you to manipulate images in the Stage window that otherwise would
have been covered by other images. Disabling a layer’s preview has no effect
on its playback on screen.

To lock a layer, click the padlock symbol. Cues on locked layers can’t be
selected or changed. Nor can you add new cues to a locked layer.

To change the name or other attributes of a layer, first select the layer then
choose “Layer Settings” on the Timeline menu.

- !
Layer Lﬁ
General | Stage Tiers

Layer name.

Images and other media on this

Mame: I8

Locked: EfLock all Cues on this Layer
Preview: mHide Layer in Stage Window

Locks the layer.

Disables layer preview.

layer are displayed when in
Standby mode only.

For conditional layers, enter a
layer condition number here.
Set to zero for a normal

‘ (unconditional) layer.

Perform: @) Mormal \_ In Standby

Conditon: 0 (0 for none)

I oK I I Cancel
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Lock all Cues on this Layer
Hide Layer in Stage Window

Perform Normal/In Standby

Condition

This checkbox is equivalent to the padlock symbol in the layer’s header pane.
Selecting it prevents cues on this layer from being changed or deleted.

This checkbox is equivalent to the sunshine symbol in the layer’s header pane.
See “Disabling Layer Preview” on page 103.

By selecting “In Standby”, images and other media on this layer will perform
only when in Standby mode. This allows you to keep, for example, a back-

ground image ready to be displayed at any time, thereby avoiding going to a
black screen when activating the standby mode (see “Standby” on page 134).

Normally, the Stage window doesn’t preview media controlled from such
standby layers. You can override this using the “Preview Standby Layers”
command on the Stage menu (see “Preview Standby Layers” on page 137).

IMPORTANT: In order to be available to the Standby command at any time,
media on standby layers consume processor and memory resources even
while not in standby. Avoid using multiple standby layers at the same time
or playing video or other heavy-duty content on standby layers. Generally,
use only a single, large background image at a time.

Media associated with cues on a conditional layer will perform only when that
condition is enabled in the Preferences dialog box (see “Enabled Layer Condi-
tions” on page 123). This can be used to keep, for example, multiple language
versions of a show in the same file, allowing the desired language version to
be activated by enabling its associated condition.
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Stage Tiers

Normally, the Stage window previews media on enabled conditional layers
only. You can override this using the Preview menu (see “No / All / Enabled
Conditional Layers” on page 137).

NOTE: The name of a conditional or standby layer is shown in italics in the
Timeline window.

Click the “Stage Tiers” tab to constrain cues on this layer to a specific stage tier
or set of tiers (see “Using Stage Tiers for Complex Display Arrangements” on
page 98 for an overview of stage tiers).

Normally, cues appear on displays
on all stage tiers.

NOTE: You must add tiers to the
Stage window before you can
assign layers to specific tiers (see
page 133).

Layer ﬁ
Appear OnS) Al @ Selecied Tiers Oy Click here to (gsfr{ct cues on this
- layer to specific tiers only...
ain
...then select the desired set of
tiers in this list.
Ok l [ Cancel
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AUXILIARY TIMELINE WINDOW The window associated with an auxiliary timeline is very similar to the main
timeline window. The main differences are:

* An auxiliary timeline can be stopped. This is indicated by a red Stop button
in its lower left corner. When stopped, it doesn’t contribute fo the stage.

* The auxiliary timeline’s window is opened by double-clicking its name in the
Task window. Name the auxiliary timeline by choosing “Timeline Settings”
on the Timeline menu while the auxiliary timeline’s window is active.

To create an auxiliary timeline, choose “Add Auxiliary Timeline” from the
window menu of the Task window (see “Task Window” on page 111). For
more details, see “Auxiliary Timeline” on page 210.

COMPOSITION WINDOW The window associated with a composition resembles the main timeline
window in the way it is operated. However, its purpose is quite different. Unlike
£* Comp =RE=R = the main timeline and auxiliary timelines, its output doesn’t appear directly on

0:05 stage. Instead, you use the composition from another timeline similar to
playing a video clip. See Chapter 6 “Using Compositions” for details.

Create a composition by choosing “Add Composition” on the Media menu. A
new composition item appears in the Media window. To open the timeline
window of a composition, double-click its name in the Media window. Use the
“Timeline Seftings” command on the Timeline menu to change the name or
other properties of a composition (such as its reference frame).

NOTE: When opening a composition, its preview will temporarily replace
the normal content of the Stage window. This doesn’t affect the image
shown by any display computers. Close the composition to restore the Stage
window.
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MEDIA WINDOW The Media window lists all media items that have been added to the presen-
tation. It provides a thumbnail preview of each item, along with a description
of its name, type, file location, size and other information, as appropriate for
each kind of media.

" | dih S Media E=5 o ===
Dr ag fo change column wiath. Mame | Thumbnail | Type | Dimensions i Duration | File Loc
Thun?b’?ai/ and descripﬁon of each Eldhimmel. toa : “_ Image 3040 x 601 Media Pz
media item. -

¥ Panoramas Folder 2 items
Double<click thumbnail to open . )
media file in its associated droppe.taa ; mlmagrz 3040 x 600 Mediafva
app/ication. Myl.tga voa. Image 3040 x 600 Media/Pa

Double-click name to edit the ————-52.AIFF Sound 1:04.233 Media/bl

media specification. e i Video 1920 x 1080 14.066 Mediajne

Group media items into folders.

» Small Objects Folder 6 items
Double-lick to open
Composition’s timeline.

Car w Engine '¥ Composition 1024 x 758 10,0

Adding Media Add new media by dragging files from your hard disk into the Media window,
or by choosing “Add Media File...” on the Media menu. Files dragged directly
into the Timeline or Stage windows are automatically added to the Media
window as well. Each media file used in your presentation will only appear
once in the Media window, regardless of how many times it is being used.

Removing Media Remove individual media items by selecting them and choosing “Clear” on the
Edit menu. Remove all unused media items from the Media window by first
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File Location

Changing the File Association
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choosing “Select Unused” on the Media menu. It is not possible to remove
media that's currently in use in the presentation. Removing media list items in
this way does not affect the files stored on your computer’s hard disk.

HINT: Use the Find command in the Timeline window to track down media
references by the name of the media item.

Indicates the location of each media file. If the file is located in or under the
folder in which the presentation itself is saved, the path to the file will be rela-
tive to this folder. Otherwise, it will be an absolute path, beginning with a */’-
character.

IMPORTANT: If possible, store media files in a sub-folder of the folder con-
taining the presentation file, since this allows the use of relative path names.
Doing so allows you to move the entire presentation to another folder, disk
or computer infact. Using absolute path names may cause problems if the
specified location is not available after moving the presentation.

HINT: If you change you mind concerning file locations, you may move the
files to a more appropriate location (for example, to a folder under the
folder containing the show file), and then use the Find/Replace command
to update the locations in the Media window accordingly. See “Find/
Replace” on page 128.

You can change the file associated with a particular media list item by double-
clicking its name and choosing another file. This will affect all cues associated
with this media list item. You can only replace a media file with another of the
same type.
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Editing the Media File

Refreshing Media Information

Grouping Media ltems into Folders

Adding a Media Proxy

To open a media file in its associated application, double-click its thumbnail.
This provides convenient access to a media file in order to view or edit it.

NOTE: Your computer must have been set up properly in order to associate
each file type with the appropriate application.

HINT: You can also open the media file associated with a cue by Alt-double-
clicking the cue on its timeline.

After editing media files, update the Media list in WATCHOUT accordingly by
choosing “Refresh” on the Media menu. See “Refresh” on page 149 for more
details.

Media items can be arranged into groups. Chose “New Folder” on the Media
menu fo create a folder then drag the desired media items onto the folder.
Double-click the folder’s name to change it. Click the triangle to show or hide
the content of the folder.

NOTE: Folders in the media window have no relation to folders on your
computer’s hard disk. They are merely a way to organize items in the Media
window. Creating or removing folders from the Media window will not
create or remove any folders on your hard disk.

In some cases, media files can not simply be dragged into the Media list (see
page 63 for some examples). Instead, you can add a proxy item to the Media
window using the “Add Proxy” command on the Media menu. See “Add
Proxy” on page 139 for more details.
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INPUT WINDOW

The Input Window lists external inputs available for use in expressions. Expres-
sions are used to control tween track parameters and to trigger tasks.

; Input

Click to add more inputs.

Name and description of each
input.

Mame \ Description | Value
Ci6 MIDI 16 Contr 16 || 1.000

D

Current input value.

Drag to simulate a change in
valve.

OUTPUT WINDOW

Click to add more outputs.

Name and description of each
output.

MiddleC MIDI 1 Mote &0 0.000

ModWheel MIDI 1 Contr 1

For details on the various kinds of inputs see page 197. For more on Expres-
sions, see page 212.

The Output Window lists outputs allowing you to control external devices using
cues. To create a cue for an output, drag the output onto a timeline. See
“Outputs” on page 204 for more details.

Name 1 Description | Value

Houselights DMX 62 1.000

Spotl DM 1 0.439

Current output value.

Drag to change the value
manually.
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Switch UDP 192.168.0.64 On
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TASK WINDOW The Task window lists all the auxiliary timelines of your presentation, along
with their status and triggering expression.

B Task (===

ry— ' Ciatus — Click to add more tasks.
D oo+ MY 32 — Task’s triggering expression.
P Crenshaw B o:zs — Timeline's time position.
J Jones uu
B Aru:lrr:'r-.'g gu

Double<lick to open the timeline.

Paused timeline.

Playing timeline.

Drag tasks vertically in list to
re-arrange their frontto-back
— ordering on stage.

Stopped timeline.

The status of each task is shown in the Status column. An auxiliary timeline can
be in either of three states, as indicated by the two buttons (see illustration
above). While stopped, its cues have no effect on the stage.

An auxiliary timeline can be started by either of the following events:
*  Manudlly, for instance by clicking the Play symbol in the Task list.
* By external inputs, using its triggering expression (see page 212).
* By another timeline, using a Control cue set to target the auxiliary timeline.

For more details see “Auxiliary Timeline” on page 210 and “Control Cue” on
page 193.

Changing the Stacking Order An auxiliary timeline always performs in front of the main timeline on stage.
When multiple auxiliary timelines are active at the same time, their front-to-
back stacking order is typically controlled by their order in the Task window.
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STATUS WINDOW

Click to add status items.

Double<click an item to change its
settings, such as color.

Drag divider to re-size the item.
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To move an auxiliary timeline closer to the front, drag it towards the top of the
Task window.

NOTE: This behavior can be overridden in the Timeline Seftings dialog box
of an auxiliary timeline. Here you can choose that it always starts out as
frontmost, regardless of its position in the Task window (see “Auxiliary
Timeline Settings” on page 152).

The status window provides a user-configurable set of status items that can be
sized as desired.

To configure a status item, double-click it in the Status window then change its
settings (such as color and other properties). To remove a status item, select it
with the mouse then choose “Clear” on the Edit menu.
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MESSAGE WINDOW The Message window lists the messages sent to you by WATCHOUT. Such

messages may originate from the production software or from the display

computers. Some messages are merely informative while others indicate errors
requiring your attention.

An error message from a media list A Messages = Mo E5c)

item telling you that it can’t find its —| From Image "Media/Images|Ball. ps
Error: Media file not found: Media;

associated media file.

An information message reporting —] ® : '_é 11 }tﬁnl_lﬂ':ﬂ
the result of the Refresh command.

NOTE: The Message window appears automatically when a message is
posted. To avoid this, move the window to the side instead of closing it.

Removing Messages To remove messages, select them (either by Shift-clicking or by choosing
“Select All” on the Edit menu) then choose “Clear” on the Edit menu.
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8 COMMANDS

FILE MENU

New

Navigate to the desired folder
using this control and by double-
clicking folders in the list.

Type the name of the show here,
then click Save.

The File menu provides commands related to the entire presentation, such as
Opening old presentations or creating new ones.

Creates a new presentation, specifying the name and location of the

WATCHOUT presentation.
.
B 5ave WATCHOUT Show As =5
_@é_y_‘&hows » Model 4 Launch - | &? | | Search 2 |

Favorite Links Mame
Bl Desktop

1M Computer
More s

Folders ~

File name: '\

‘ Organize v EEE Views = ‘ Mew Folder

Date modif... Type Size
This felder is empty.

-

Save as type: [WATCHOUT Show files (*.watch)

)

= Hide Folders

[ Save ] [ Cancel ]

A

HINT: To re-use objects such as display arrangements and cues, simply

copy them from the old presentation then paste them in the new one.
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Open

Navigate to the containing folder.

Select the desired show then click
Open.

Opens an existing WATCHOUT presentation.

Open Recent

Save

Save a Copy As

116

N
B Open a WATCHOUT Show (]
@\J I - Shows » Seminar Show » - | d'r?| Search jel |
‘ Organize v Views + [ New Folder
Narme : Date modified Type Size &
J F6_Building a show 1/15/2008 5:24 PM File Folder
| F7_Power features 1/15/2008 5:25 PM File Folder
J F&_Closing message 1/15/2008 5:25 PM File Folder
ﬁWATCHOUT{:gemo.watch 8/5/2008 7:37 PM High impa... 1,542 KB L4
File name: WATCHOUT_Demo watch - IWATCHO UT Shaw files (*wz v]
[ Open ] [ Cancel ]
L =

Provides a list of recently opened presentations. Choosing an item from the
sub-menu opens the selected presentation.

Saves the presentation that is currently open.

Saves a copy of the presentation that is currently open. This is useful for saving
backup copies without changing the name of the current presentation.

NOTE: Opening and using such a copy without changing it back to its orig-
inal name will cause a new set of media to be downloaded to all display
computers under the new show name.
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Consolidate To

Consolidate Media Files

Include:  (3) Media Currently Used () All Media Items

= Copy media files, Uses more disk space, but leaves
the ariginal presentation intact,

Move media files if passible (if nat, copy instead).
The consolidated presentation will then be opened.

Moves or copies the entire presentation, including its media files, to a folder.
You can use this command to consolidate all the relevant files in preparation
prior to burning the presentation onto a DVD.

This command is also useful if you've been using media files stored on servers
or removable disks, or if you want to weed out unused media files intermixed
with files actually used in the presentation.

In addition to collecting your media files, this command also updates the
access paths accordingly in the Media window, and stores this updated copy
of the presentation file in the consolidated folder. When using Copy, the old
presentation is not affected.

When you give this command, first choose an empty folder for your consoli-
dated presentation. You're then presented with the dialog box shown below,
allowing you to choose whether to copy or move the media files.

Include. Choose “Media Currently Used” to remove unused media items
from the Media window, excluding those from the consolidation (the files will
stay where they are). Choose “All Media ltems” to include all media items and
files listed in the Media window, regardless of whether they are used or not.

Copy. Creates a new copy of your presentation, leaving the current media
files and the presentation file as they are. This is the safest option, but may

require more time and disk space, since it entails making new copies of the
media files.

IMPORTANT: Unless you choose “All Media ltems”, only media actively
used in the presentation is copied. Unused media items (including compo-
sitions) are removed from the Media window in the consolidated version of
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Export Movie
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the show. Unused media files are left in their old locations, and are not cop-
ied or moved.

Move. Instead of copying them, this moves all actively used media files that
reside on the same volume as the target folder. This is much faster and requires
no additional disk space for files already located on the target volume. Media
files residing on other disks, partitions or servers will be copied, however. The
consolidated presentation is then opened automatically.

IMPORTANT: Since the Move option moves media files away from the
locations specified in the original presentation, you will no longer be able
to use the old presentation file as media it refers to has been moved. A new
copy of the presentation file is created in the consolidated folder with the
updated media file references.

Exports the main timeline of your show as a QuickTime movie. The movie file
can then be sent off for client approval, posted to a web site, or similar.

NOTE: Before choosing this command, set up the Stage window to define
the scale and area to be exported. Only the displays currently visible in the
Stage window will be exported. This can be used to export a smaller portion
of a very large stage. Areas outside the displays that are currently visible in
the Stage window will be cropped or blanked out in the resulting file. Also,
if your show uses conditional layers, set the desired set of layer conditions
in the Preferences box before exporting.

When you choose the “Export Movie” command, a Save dialog will be shown,
allowing you to name the resulting movie file. This dialog box also allows you
to limit which part of the timeline to export, and to control the compression

Chapter 8  Commands



Navigate to the desired folder.

being used. The formats available may vary depending on the version of
Quicktime you have installed.

Name of the new movie.

Portion of timeline to save.

How to compress the movie.

Exporting an Auxiliary timeline

Export Audio

Quit

‘u-
=] 4 1 ¥
MNetwork
File name: / - Save
Save as type: [Ouidclirne Movie {"mav) - | [ Cancel ‘
T ! ]
Start Time: 0.0 End Time: 3:23.518 mpression Settings. ..

Y

To export an auxiliary timeline, first open and select its window, then choose
“Export Movie” on the File menu.

Exports a stereo mix-down of the audio from the main timeline of your show,
as a Wave-file. This is particularly useful for exporting audio to PICKUP. The
resulting WAVE file can then be imported into iTunes, which converts it into
MP3 format for PICKUP.

NOTE: If your show contains multiple languages controlled by conditional
layers, make sure you enable the desired set of conditional layers before
exporting the sound track.

Quits WATCHOUT after optionally saving any changes.
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Preferences

Sets the frame rate to be used

Allows you to specify miscellaneous settings of the presentation.

Preferences

3]

Display Address Prefix:

Display Framerate:

by your display computers.

Defaultimage duration for new

@ &0 fps ()75 fps
(7) Custom fps: | 60

image cues and volume level
for audio and video cues.

Display Address Prefix

120

Stand-By Enter Rate: 1.0 seconds
Stand-By Exit Rate; 1.0 seconds
Default Image Duration: 10.0 seconds
Default Audio Volume: 50 %
When Adding Mew Cues: Center Anchor Position
[ OK ] l Cancel

)

Enter the common
part of your display
computer’s IP
addresses.

Determines the fade
rates for the Standby
command.

Default anchor posi-
tion for new image
cues.

The IP addresses assigned to the displays usually only differ in the last few
digits (see illustration on page 24). By entering the common initial part in this
field, you then only have to enter the last few digits into the specifications
dialog box of each individual display (see “Address” on page 158).

IMPORTANT: You must enter the period that separates the last two groups
of digits here. The complete IP address is made by simply concatenating the

contents of the “Display Address Prefix” field with the contents of the dis-
play’s Address field.
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Display Framerate

Standby Rates
Default Inage Duration

Default Audio Volume

Center Anchor Position

Edge Blend

| control | conditions | video In

Soft Edge Blend Curve

Mote: Left side of curve is outer part of edge blend

Specifies the frame rate used by the display computers. This setting lets
WATCHOUT optimize its behavior to match the frame rate of any video being
used in the presentation, as well as the display devices. Your display computers
should use a matching refresh rate (see page 28 for more information).

Specifies the fade out and fade in rates for the standby command (page 134).
Display duration used for images added to timelines.

Volume level used to play audio not governed by a Volume tween track. Set
this to a value below 100% to provide for some additional headroom when
controlling the playback volume.

When checked, the anchor point will be aligned with the center of the image
when you drag an image to a timeline or the Stage window. See “Anchor Posi-
tion” on page 172.

Drag the round dot to adjust the edge blend curve. Although it is possible to
add more points to the curve, this is generally not required. The same curve is
applied fo all edges. The left of the curve corresponds to the outer (dark) edge
of the gradient. Your display computers must be online for you to see the effect
of the edge blend curve while changing it.

IMPORTANT: Before attempting to adjust the edge blend curve, make sure
your projectors are set up properly (see page 246). If not, it may be impos-
sible to get a proper edge blend.

Double-click a point to view and edit its value numerically, or to change its
type. This also allows you to precisely copy the edge blend curve from one
presentation to another.

HINT: Enlarge the window for better precision in adjusting the curve.
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General | Edge Blend

Go Online Automatically After Opening Show

Production Computer Contral: TCR/IP

LDP

Control

Conditions | Video In | 3D

Timecode Control of Main Timeline (LTC EBU/SMPTE)

Timecode Format: | Auto
Time Offset: |0.0

MIDI Show Control, Device ID: | O

MSC Cue Lists: | Ignore Command (do nothin

DM 512 Universe, In: 0 Cut: 1

Default Dynamic Image Server Address:
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This tab provides various options for controlling the WATCHOUT production
software from the outside.

NOTE: For more control options, see “Inputs” on page 197.

Go Online Automatically. When selected, WATCHOUT will automati-
cally attempt to connect to the display computers when opening this show.

Production Computer Control (TCP and UDP). Activates external
control of the WATCHOUT production software. This allows you to control
your WATCHOUT presentation from a touch panel or other computers and
control systems. The control protocol has provisions for positioning, starting
and stopping the presentation, as well as other miscellaneous functions. See
“Production Computer Protocol” on page 251.

NOTE: This control feature is not to be confused with the display cluster
control capability, described in Appendix E. While they both perform
similar functions, one controls the production computer and the other
controls the display computers directly, without the need for any production
computer being present during playback.

Timecode Control of Main Timeline. Enables synchronization of the
main timeline of the production software by an external timecode signal. When
selected, also specify the format of the expected timecode as well as any offset
to be added to the external timecode to make it match up with the timeline. Use
a negative offset if the external timecode specifies a later time position. See
“Timecode Control” on page 84 for more details.

MIDI Show Control. Enables control of WATCHOUT using the MIDI Show
Control protocol, available in many lighting consoles. See “MIDI Show
Control” on page 275 for details on the various options.
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General | Edge Blend | Control | Conditions | video In

[, B S TR R

Enabled Layer Conditions

Enabled Layer Conditions

[T "R }

11
12
13
14
15

16
17
13
19
20

21
22
23
24
25

27

29
30

DMX-512 Universe. Specifies the Artnet protocol “universe” number to be
used to receive and transmit DMX-512 data. This relates to the DMX-512 Input
and Output respectively. See page 201 for more details on how fo use DMX-
512.

Default Dynamic Image Server Address. The default server address
used by Dynamic Image media items, if not specified explicitly (see “Add
Dynamic Image” on page 148).

Specifies which layer conditions will be enabled. Each layer in the Timeline
window can be associated with a condition (see “Condition” on page 104), in
which case media on that layer will only appear when the corresponding
condition is enabled. You can specify any combination of conditions.

Layer conditions are particularly useful together with external control of display
clusters, either using Dataton PICKUP (see “Personalized or Multi-lingual
Audio” on page 82) or other external control means (see Appendix E “Display
Cluster Protocol”). For instance, the set of enabled layers in WATCHOUT can
be governed by the language selection in PICKUP; matching fexts and other
language-dependent images in the presentation.

NOTE: The Stage window normally previews media from enabled layers
only. This behavior is governed by the “Preview Options” sub-menu on the
Stage menu.
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Video In

Device 1: |Osprey—2l0 Video Device 1 '|
Device 2t |None v|
Device 3: |None v|
Device % |None i |
Device 5: |None v|
Device 6: |None h |
Device 7t |None v|
Device 8: |None - |

3D Perspective and Stereoscopy

\/
Sl
A

Vanishing point symbol.
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Associates video input cards in the production computer with video input
device numbers, subsequently used in “Live Video” media (see “Live Video” on
page 47). This allows you to view live video in the production computer, if
desired. It serves the same purpose in the production computer as the “Video
In” menu does in the display software (see illustration under “Add Live Video”
on page 145).

NOTE: The “Video In” settings in the Preferences dialog box apply only to
the production computer. Each display computer has its own, independent
assignment of video input devices. This allows you to have different configu-
rations of capture cards in the various computers.

If you don’t want to preview live video in the production computer’s Stage
window, choose the “Thumbnail” stage preview mode in the “Live Video”
media item (see “Live Video” on page 47). Doing so still allows you to assign
video input device numbers for use in the display computers, while disre-
garding any setting for the corresponding video input device number in the
production software. In this case, you can ignore the settings in the “Video In”
section of the Preferences dialog box.

These settings control the perspective of images rotated or moved in 3D space.

Vanishing Point. As images move away from the viewer along the Z axis,
they move towards the vanishing point. In general, you want this point to be at
the center of the stage, which can be accomplished by clicking the Center
button. You can also enter the coordinate of the vanishing point manually. The
position of the vanishing point is indicated by a symbol in the Stage window,
displayed only while editing the settings in the Preferences dialog box.

Perspective. Images rotated around the X or Y axes appear distorted
according to the perspective. A smaller value results in a more exaggerated
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General | Edge Blend | Control | Conditions | Video In

¥: 1384 px. Center

3D Perspective

Vanishing Point, X: 1944

Perspective:

Stereoscopy

Eye Distance:

U

wide

0

tele

50

150

mm edq.

pixels

EDIT MENU

Undo/Redo

perspective. You may think of this value as controlling the focal length of a lens
used to view the images, where a wide angle lens (smaller value) results in a
more pronounced perspective. This value also controls the degree to which
images moved along the Z axis (towards or away from the viewer) change
their apparent size.

HINT: Sometimes, the perspective effect can make it harder to edit the posi-
tion and orientation of images in the Stage window. If so, turn off the
perspective using the Perspective command (see page 136). This command
affects the preview only — not images displayed on screen.

Eye Distance. When displaying images using stereoscopic projection, this
setting controls the amount of left/right image separation that's applied as a
function of the distance from the zero parallax plane (i.e., the screen).
Depending on the physical size of the screen used to view the presentation, you
may need to adjust this value. For comfortable viewing, the left/right separa-
tion should not exceed 60 mm on screen (approximately 2.4 inches). See “3D/
Stereoscopy” on page 78 for more details.

IMPORTANT: This setting has no effect on stereoscopic video being used in
your presentation, as the eye separation has already been baked into the
video itself. Attempt to keep the amount of physical eye separation of
stereoscopic video within the same limits as other stereoscopic images, as
mentioned above.

The Edit menu contains commands applying to the current window or currently
selected obijects (for example, displays, cues or tween points).

Reverts recent changes you’ve made to the presentation.
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Cut

Copy

Paste

Clear

Select All

Select to End
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Transfers selected objects to the clipboard, allowing them to be pasted in else-
where. Use this, for example, to move cues to another position along the
timeline, or to another presentations.

Copies selected objects to the clipboard, allowing the copies to be pasted in

elsewhere. Use this, for example, to transfer display configurations or cues
between presentations.

NOTE: When transferring cues between presentations in this way, any

media associated with these cues will transfer along with the cues, and will

be automatically added to the Media window in the target presentation.
Pastes the most recently cut or copied objects into the current window.
Removes selected objects without altering the contents of the clipboard.

Selects all objects in the current window.

Applies to timeline windows. Selects all cues from the current time position and
forward.
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Specifications Opens the Specifications dialog box for the selected object. This is equivalent
to pressing the Enter key or double-clicking the object.

ofe . . 7
Example specifications dialog Image [
box for a still image.
Image File:  MediaImages Ball.psd
Transparency: l.ﬂ.uto Detect vl
[ oK l [ Cancel l
b A

See “Display Specifications” on page 158 and “Cue Specifications” on
page 170 for more details. For media proxy items, see page 139.

Move e | Moves the selected objects by a specified
Move X number of pixels. Applies to cues and
. _ displays. When applied to cues, it moves
SE.Emes L S the stage positions of media displayed by
¥ Distance: | 0 pixels the cues.
Z Distance; | 0 pixels
oK l ’ Zancel
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Find/Replace

Search text.

Finds and optionally replaces specified text. When applied to the Media
window, this allows you to locate media items by specifying the name of the
media file, or any part of its path name. The command operates on the infor-
mation shown in the “File Location” column of the Media window, indicating
the relative or absolute path to the media file.

- !
Find/Replace &J

=]

TGS

Check this box to replace the
found text.

Distinguishes “Mike” from “mike”
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Replace with: Replacement text.

@) One at a Time All at Oncei F"nds/reﬁ/aces one ata
time or all at once.

Case Sensitive

Find in Current Selection Only Seamhes. current/y
selected items only.

| Find | | Cancel |

. A

You can use the Replace function to update the path to media files after they
have been moved to another disk or folder. For instance, if you start out with
your media files on a shared server during the early stage of production, you
may later want to move all media files into a sub-folder of the folder containing
the presentation file. After transferring the files, use the Find/Replace
command to change the absolute part of the path name (beginning with a */*
character) to a relative (that is, beginning with the name of a folder located in
the same folder as your presentation).

As an example, assume that the media files were stored in a folder named
“WATCHOUT/Production1/Media” on a network volume named “E:” during

Chapter 8  Commands



A leading '/’ character indicates

production. You have now copied these files into a folder named “Media”
located in the same folder as the WATCHOUT presentation file. You would
then enter the following values into the Find/Replace dialog box to update il
relevant media paths accordingly.

Find/Replace I‘ﬂ_‘E-J

an absolute path.

FiReh—E: [Shows/Production/Media/

Check to replace.

Choose “All at Once” to change
all matching items, or “One at a
Time"” to review each change
before proceeding.

| Replace with: Media/ NOTE: No Ieading ’//
character indicates a

[

Finding Cues

Using QuickFind

Find/Replace Again

L folder relative to the

folder containing the
Find in Current Selection Only presentation file.

Case Sensitive

[ Find ] | Cancel |

e 4

The Find command can also be used in timeline windows. In this case, it allows
you to search for Control cues by name or media cues by the name of their
associated media. The latter is useful in finding cues using a particular media
item. The timeline is first searched in the forward direction from the current time
position. If not found, it is then searched backward:s.

The QuickFind feature allows you fo jump straight to a Control cue by pressing
a single function key on the keyboard. Simply name the cues F1, F2, F3, efc,
and then press the corresponding function key. See “Using Find and Quick-
Find” on page 195 for more details.

Repeats the most recent Find/Replace command.
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Snap When enabled, objects exert gravity on each other as they are dragged with
the mouse, making them snap together. This makes it easier to align images,
cues and tween points.

* When dragged in the Stage window, images will snap to the edge, center
or corner of displays and other images.

* Cues will snap to adjacent cues when dragged in a timeline window.

* Tween points snap to other tween points within the same cue, as well as to
the beginning and end of the cue.

e Cues and tween points snap to the current time position. For this to work,
first turn off “Click Jumps to Time” on the Timeline menu.

HINT: When working in a crowded stage window, it may be hard to see
what's snapping to what. If so, zoom in on the area of interest (see “Setting
the Stage Scale” on page 97) and disable the preview of layers that get in
the way (see “Disabling Layer Preview” on page 103).
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STAGE MENU

Add Display

Scale

View

The Stage menu applies specifically to the contents of the Stage window.

Adds a new display of the specified size to the Stage window. After adding a
display, open its specifications dialog box to enter its specifications (see
“Display Specifications” on page 158).

IMPORTANT: Displays can not be added while Online is selected on the
Stage menu.

The secondary menu provides some common display sizes as shortcuts. You
can, however, enter any size in the display’s dialog box as long as it is
supported by the physical display and the interface card in the display
computer.

NOTE: Displays are added to the current stage tier (see “Using Stage Tiers
for Complex Display Arrangements” on page 98). Move displays between
tiers using the Cut and Paste commands

Sets the viewing scale of the Stage window. A larger preview gives you greater
precision in positioning displays and images using the mouse.

HINT: In addition to these fixed scale factors, you can zoom to any area of
interest using the mouse while holding down the Control key (see “Setting
the Stage Scale” on page 97).

Rotates the Stage window preview so that you can view images, motion paths
and other elements from the left or top instead of the front. This is useful when
positioning images in 3D space, or editing complex motion paths. See “3D
Views” on page 100.
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Manage Display Computer

132

Remote Access

Power Down

Power Up

The commands on this sub-menu allows you to operate the display computers
from the production computer. This is particularly useful if the display
computers have no mouse or keyboard connected.

Opens a remote access window onto the desktop of displays selected in the
Stage window. For this to work, WATCHOUT display software has to be
running on the display computer. The WATCHOUT display software will be
reduced fo its window mode, allowing you to see the desktop of the display
computer. While in this mode, you can interact directly with the display
computer, for instance to delete files, defragment hard drives or similar house-
keeping chores.

NOTE: Take care not to do anything that causes the display software to
close, as doing so also terminates the remote access session.

End the remote access session by closing the desktop window of the display
computer. WATCHOUT display software will be restored to its full screen mode
by the Online command.

Turns off the power of selected or all display computers. This quits
WATCHOUT display software, terminates Windows and turns off the
computer. As part of this procedure, the WATCHOUT production software also
learns the hardware address of the display computers, which can then be used
by the Power Up command.

Sends a “Wake on LAN” command via the network to selected or all display
computers. If properly configured, this will power up the computer(s) as if their
power switch had just been pressed. Put a shortcut to the WATCHOUT display
software into the Startup folder of the display computer to make it launch
WATCHOUT automatically.
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Tier

B stage <<< OFF .,

On Tir:rSicIEE

=R AER (>3

Main

Add

Rename

IMPORTANT: There are a two prerequisites for this command to work:

* The computer must be configured to “Wake on LAN” (sometimes referred
to as “Magic Packet”). This setting may be found under the “Power
Management” tab of the Local Area Network Connection’s Properties
dialog box, or in the computer’s BIOS settings.

* The production computer must at some point have given the Power Down
command to that display computer, allowing it to learn the computers
network card hardware address.

Manages stage tiers, which are useful for building elaborate display arrange-
ments (see “Using Stage Tiers for Complex Display Arrangements” on page

98).

Selects the main stage tier. There’s always at least one stage tier. Any addi-
tional stage tiers will be listed below “Main” on this sub-menu.

NOTE: In order to add or manipulate displays, you must first select their
stage tier using this menu. Inaccessible displays are shown with a dotted
outline in the Stage window, and a small text will appear when you point
at such a display, telling you which tier it resides on.

Adds another tier to the stage, and selects it as the current tier. Any displays
you add or paste will now go onto this tier.

Allows you to change the name of the currently selected stage tier.
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Online

Update

Standby
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Connects the production computer to the display computers. Once connected,
the display computers will follow you as you jump around on the timeline and
start/stop the presentation.

NOTE: Choosing “Online” also locks all displays in the Stage window. You
must deselect “Online” in order to make any changes in the Stage window.

A stop sign inside a display in the Stage window indicates failed connection to
that display computer (see “Connecting to the Display Computers” on page
79). Other errors are reported in the Message window.

Updates all connected display computers with any changes you’ve made to the
presentation, including transferring new or modified media files to the display
computers.

Causes all display computers to fade to black, or to the image of any standby
layer (see “Perform Normal/In Standby” on page 104). Also fades the audio.
Useful if you want to pause the show in a smooth way — possibly to jump to
another position along the timeline. Give the command again to restore
normal image display. While online in standby mode, an indicator is shown at
the top of the stage window.

HINT: A standby indicator can also be added to the Status window (see
page 112).

The fade-out and fade-in times for the Standby command are set in the
Preferences dialog box (page 120).
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PREVIEW MENU

Click Selects Frontmost Image

Preview Quality

The items on this menu control the preview of cues shown in the Stage window.
These commands do not affect the display computers or what appears on their
outputs.

When this option is selected, clicking an image preview in the Stage window
always selects the corresponding cue in the Timeline window. While this is the
most natural behavior in many cases, it may get in your way if you want to
move an image that appears partially obscured behind another image. In this
case, uncheck this menu option, select the cue corresponding to the image to
be moved, then drag the image in the Stage window.

Control the overall preview quality of images in the Stage window using the
following four commands.

Wireframe. Displays all images as boxes with the name of the media item,
rather than showing the image. This is sometimes useful when trying to position
images, or fo track down images obscured by other images.

Thumbnails. Uses low resolution thumbnails of images and video for the

Stage window preview. While the image quality in this mode is very low, its
performance is high — particularly when dealing with numerous, very large

images.

Video as Thumbnails. Uses low resolution thumbnails as video preview.
Speeds up editing of presentations that have many large video clips playing at
the same time.
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Perspective

Masked by Displays.

Outline Dimmed Images

Play Audio Media
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Best Quality. Renders high quality preview of all cues except those explicitly
set to “Stage Preview: Reduced” (page 175).

HINT: As an alternative to selecting global thumbnail preview for images or
video, you can set individual cues to preview as thumbnails by selecting
“Reduced” on the “Stage Preview” pop-up menu in each cue.

In general, you want the Stage preview to match what you see on screen in
terms of image placement and perspective. However, the perspective view can
make some editing operations harder. If so, you can turn off the perspective
preview using this command, causing the Stage window preview to appear in
an ortographic mode.

NOTE: The amount of perspective applied to images rotated or positioned
in 3D space is controlled by the Perspective slider in Preferences (see
page 124)

Masks images to the areas inside the displays. This provides a more accurate
representation of what is actually shown by the display computers. However, it
also makes it harder to edit the presentation, since images positioned outside
the displays disappear.

When an image is dimmed using an opacity tween track, it may become hard
to see and manipulate in the Stage window. Selecting this option causes a thin
frame to be displayed around such images, making them easier to see.

By default, the production computer plays audio cues for all displays. You can

turn off this behavior using this menu option, thereby reducing the processing
overhead associated with audio playback.
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Preview Standby Layers

No / All / Enabled Conditional
Layers

All / Active / Specific Stage Tiers

When activated, the Stage window will show the same images as the display
computers while in standby mode (that is, any images from standby layers -
see “Perform Normal/In Standby” on page 104). This allows you to edit such
images through the Stage window.

However, in most cases, you probably prefer to see the normal images in the
Stage window even while in standby mode, in order to preview and possibly
edit those while the display computers show the standby images. This can be
accomplished by un-checking the “Preview Standby Layers” menu item.

These three menu items control to what extent images originating from condi-
tional layers appear in the Stage window. (See “Condition” on page 104 and
“Enabled Layer Conditions” on page 123 for more information on conditional
layers.) Generally, you want images originating from enabled layers only to
appear in the Stage window, which is accomplished by choosing “Enabled
Conditional Layers”. To preview images from all conditional layers, regardless
of whether or not they are enabled in the Preferences dialog box, select “All
Conditional Layers”.

Just as timeline layers can use conditions to enable/disable their cues (as
described in the previous paragraph), timeline layers can also be associated
with stage tiers. Cues on such a layer will only appear on displays on those
specific tiers. The commands in this group of the Preview menu control what's
shown in the Stage window in this case. By selecting “All Stage Tiers”, the
Stage window will preview cues regardless of their stage tier association.
Select “Active Stage Tier” to preview cues on layers associated with the tier
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specified on the Stage Tier sub-menu. Selecting “Specific Tiers” brings up a
dialog box where you choose any combination of stage tiers to preview.

NOTE: Layers set to All Stage Tiers in their Timeline Layer Settings dialog
box (see page 151) will always be included in the preview, regardless of
the preview mode chosen using these menu options.

Background Color Sets the background color of the Stage window. If your source material is hard
to see on the default (black) background, then change to another color.
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MEDIA MENU

Add Media File

Add Proxy

NOTE: Available options vary

based on the kind of proxy
added.

The Media menu applies specifically to the contents of the Media window.

Opens a dialog box where you can choose a file to be added to the Media
window. Alternatively, simply drag the file into the Media, Stage or Timeline
window.

Adds a proxy media item of the kind specified. Use a proxy to handle media
that can not be added simply by dragging into the Media window, as
described under “Using Media Proxies” on page 63.

( Video Proxy ﬁ |

Pre-split: || Pre-split Files for Multiple Displays
Stereoscopic: || Use Separate "Left™ and "Right” Files

File /Folder:

File Transfer: () Manual @) Automatic [_| Auto-Refresh on Update

Duration; | pLOA]

Preview: Choose...
Thumbnail: 'g
HaH
Dimensions; Width: 800 Height: &00
Transparency: ’.Auto Detect v]
[ Ok ] [ Cancel

Chapter 8~ Commands 139



140

Pre-split

Stereoscopic

This option applies to video media only. Check this if you have pre-split a large
movie, as described on page 42. In this case, the resulting files must be placed
in a folder specified in the File/Folder field. This folder must contain one file
per display intersecting the movie, each file named after its target display.

For example, assume you have a large video called “LargeMovie.mpg” that
intersects two displays named “Display 1” and “Display 2”. You would then
pre-split the video into two files. Name those files “Display 1.mpg” and
“Display 2.mpg” and put them in a folder named “LargeMovie”. Finally,
specify that folder in the File/Folder field of the video proxy.

IMPORTANT: Always append the proper file extension to the name of either
the video files or the folder containing the pre-split files. This is needed to
ensure that the correct video playback mechanism is used. By default,
Windows may not display filename extensions. To show file extensions,
choose “Folder Options” on the Tools menu in Windows Explorer, click the
View tab, and uncheck “Hide extensions for known file types”.

Select this option to play stereoscopic video. In this case, you must supply sepa-
rate files corresponding to the left and right eye’s viewpoint. Those files must
be placed in a folder selected using the Browse button. Name the files Left and
Right respectively, appending the proper file type extension. See “3D/
Stereoscopy” on page 78 for more details.

You can combine Pre-split and Stereoscopic videos by naming each video
according to the display as well as its eye affinity, separated by a dash. For
instance, fo present a stereoscopic pre-split across two edge-blended projec-
tion screen areas, name the files as follows:

Display 1-Left.mpg Display 2-Left.mpg
Display 1-Right.mpg Display 2-Right.mpg
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File/Folder

File Transfer

Auto-Refresh on Update

Duration

Preview

The title of this field reads “Folder” if “Pre-split Files for Multiple Displays” or
“Use Separate Left and Right Files” is selected, otherwise it reads “File”. In this
field you specify the file or folder associated with the media item. You can use
the “Choose” button next to the field to choose an existing file/folder. If you set
“File Transfer” to “Manual”, you would instead type the fictive, relative path to
a file that may not exist on the production computer, but will be provided
manually to the display computer.

Specifies whether the file will be transferred manually or automatically from the
production computer to the display computers. Normally, you would choose
“Automatic”. You may choose “Manual” if the file is to be provided later,
directly to the display computer, or if the file is not yet available.

NOTE: If you choose “Automatic”, WATCHOUT will make sure that the file/
folder you specified actually exists prior to closing the dialog box. If you
choose “Manual”, it becomes your responsibility to provide the file, and
WATCHOUT will not verify its existence.

If selected, an updated media file associated with this proxy will be transferred
to the display computers whenever you use the Stage Update command,
without first having to use the Media Refresh command.

IMPORTANT: When using this feature, media files must maintain their orig-
inal size. If required, you can plan ahead by making the original larger
than necessary to accommodate future changes.

Enter the duration of the media here. Applies to moving images (video) and
sound only.

Allows you to choose a scaled down version of a large pre-split video for
preview purposes. If not specified, the thumbnail image will be shown instead
in the Stage window preview.
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Thumbnail

Dimension

Transparency

Allows you to choose a thumbnail image to represent the proxy in the Media
window, inside cues and in the Stage window preview. If not specified, a
default icon will be displayed.

Specifies the size of the image. Applies to still and moving images.

Allows you to specify whether the image contains transparent areas, as well as
the form of transparency used. Normally, WATCHOUT determines this from
the information in the media file, but when using a proxy, you must specify this
manually. Setting this incorrectly may cause the image to display without trans-
parency or not at all. Applies to still and moving images.

The types of transparency supported by WATCHOUT includes:
* None. The image or video has no alpha channel.

e Straight Alpha. The transparency information affects the alpha channel of
the image only.

e Pre-multiplied with White. The transparency affects both the alpha channel
and the pixels in the image so that the pixels in fully transparent areas are
white. This is often used in material produced for printing purposes.

* Pre-multiplied with Black. The transparency affects both the alpha channel
and the pixels in the image so that the pixels in fully transparent areas are
black. This is often used in material produced for video compositing
purposes.
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Add Composition

Add Computer Screen

s

Computer Screen 2
Mame:
Address:

Screen: 0 (0 is default)

Password:

Stage Preview: (@) Live Thumbnail
Dimensions
Width: &40 Height: 430

QK | | Cancel

Add a Composition to the Media window. A composition allows you to group
images together (including their tween tracks) in a way that can subsequently
be used as a media item on other timelines. See Chapter 6 “Using Composi-
tions” for some examples.

See “Composition Settings” on page 154 for a description of the fields in the
dialog box shown by this command.

This feature allows you to incorporate a live image of a computer screen into
WATCHOUT. This can be used to show Excel graphics, Powerpoint slides, a
Web browser, or similar software applications, as part of your presentation.

The image displayed on the source computer’s screen is sent continuously via
the network to the WATCHOUT display computers, where WATCHOUT
composites it with other media. For example, you can put a plain Powerpoint
presentation on top of a large, high-resolution background, thereby enhancing
it with all the high-quality presentation capabilities of WATCHOUT.

To incorporate such a computer screen into your presentation, follow these
steps:

e Install, activate and configure VNC server software on the remote computer
(see “VNC Server Software” on page 20).

* Add a Computer Screen media item to the Media list using this command
on the Media menu. Configure it as described below.

* Drag the computer screen object from the Media list onto the Stage, and
program it using cues as any other image element.

The same capabilities apply to computer screen images as any other images.
For instance, you can program its position, scale and opacity. Since the
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images are sent across the network to all display computers, you can show the
computer display across multiple display computers.

Computer Screen Settings. In the Computer Screen dialog box, type the
IP number of the remote computer into the Address field, and the VNC pass-

word into the Password field. Set Dimensions fo the size of the display of the

VNC server (reducing the resolution may improve performance).

The Screen field is rarely used, and should generally be set to zero. It may be
used with some implementations of VNC server software which support
multiple screens or work-spaces.

Set “Stage Preview” to “Live” if you want to preview the Computer Screen in
the Stage window of the production software. Otherwise, set this to “Thumb-
nail”. This setting affects the Stage window preview only — not what's shown by
the display computers.

NOTE: The computer that's being viewed does not require a WATCHOUT
license key.
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Add Live Video

Associate a video input device

number with your video input{(s).

Video inputs available on the
display computer appear here.

This feature allows you to display live video, such as a camera feed, as part of
your WATCHOUT presentation. The live video feed must be connected to each
display computer that is expected to show it. For instance, if you want to show
live video across two displays, the video signal must be fed to both display
computers (typically using a video distribution amplifier). See “Live Video
Input” on page 224 and page 18 for more details.

To activate the Live Video feature, follow these steps:
*  Start WATCHOUT display software on the display computer.
 Press Ctrl-W to switch to window mode.

e On the “Video In” menu, make sure that your video input device is
associated with the desired device number.

e Connect a video source to the video input.

EDataton WATCHPOINT
File | Wideo In Help

Device 1y F Mone
Device 2 “F

Decklink Yideo Capture
Device 3 v P

Device 4
Device 5

Device &
Device 7
Device &

WATCHOUT
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MName:
Input Device: 1

5ignal1nput:|Composite v : 1

Video Standard: |0ﬂ1er v|
Deinterladng: |None vl
Stage Preview: () Live Video @) Thumbnail
Trim Edges (pixels):
0
0 a
0

Dimensions (after trimming):

Width: &40 Height: 480

| Ok || Cancel |

Live Video (=3
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To use Live Video in your presentation, do as follows:

* Add a Live Video media item to the Media list using the command on the
Media menu, configuring it as described below.

* Drag the Live Video object from the Media list onto the Stage or a timeline,
just like any other media object.

Live Video supports the same capabilities as video played from disk, allowing
you to program its position, scale, rotation and opacity.

To show live video across multiple displays, you must connect the video signal
to each of those display computers. Furthermore, this video signal must be
associated with the same input number on each display computer that is to
display it. See “Live Video Input” on page 18 for more details.

Live Video Settings

In the Live Video Media dialog box, set “Input Device” to the device number
selected on the “Video In” menu shown in the illustration on page 145. Set the
“Signal Input” and “Video Standard” as appropriate for your video connection
and source. If your video input interface has multiple inputs for the same kind
of signal, enter the desired input number in the field to the right if the “Signal
Input” pop-up menu.

NOTE: Although WATCHOUT does support FireWire inputs, this kind of
signal is generally not recommended. A FireWire video feed introduces a
significant delay in the video processing, as well as reducing performance
and image quality due to the DV data compression.

Deinterlacing. Video originating from most video cameras uses an inter-
laced signal, just like a PAL or NTSC TV set. Presenting such a video signal on
a non-interlaced display device, such as a video projector or other display
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device designed to be used with computers, results in visual artifacts often
referred to as “combing” around the edges of moving objects. Use the Deinter-
lacing pop-up menu, set to “Good Quality” or “Best Quality” to rectify this
problem when required.

IMPORTANT: Do not use this feature unless necessary. Some video material
and some cameras that can be set fo a “progressive scan” mode do not
need deinterlacing, and using it may reduce the image quality.

Stage Preview. Set o “Live” if you want fo preview the Live Video in the
Stage window of the production computer. Otherwise, set this to “Thumbnail”.
This setting affects the Stage window preview only — not what's shown by the
display computers.

NOTE: In order to preview Live Video in the Stage window of the production
computer, this computer must have the appropriate video capture capabil-
ities, and the video signal to preview. Set the input associations for the
production computer in Preferences (see “Video In” on page 124).

Trim Edges. The fringes of a video signal sometimes contain noise. These
four fields allow you to selectively trim each of the edges of the video image to
remove such noise.

Dimensions. For most video standards, the dimensions are fixed by the
standard. However, when selecting “Other” on the “Video Standard” pop-up
menu, you can manually enter the desired dimensions. Use this, for example,
to enter the size of a computer signal brought into WATCHOUT using a DVI or
VGA capture card (see page 224).

NOTE: The dimensions shown are after any edge trimming. For example, if
the original image is 640 by 480 and you trim 10 pixels at each edge, the
resulting dimensions become 620 by 460.
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Using Multiple Video Inputs  WATCHOUT supports up to eight video input devices. The number of video
inputs that can be displayed simultaneously depends on your computer hard-
ware, type of video input device, efc.

Most video input devices have multiple connectors — often for different kinds of
video signals (for example, Composite and S-Video). You specify which one to
use in the Live Video media dialog box. Add more Live Video media objects to
access different inputs on the same device. Generally, you can only display
one input at a time from any given device. Furthermore, it's generally not
possible to make a clean switch back-to-back from one signal to another on the
same input device. You need to leave a couple of seconds between the end of
the cue displaying one input and the beginning of the cue displaying the other.

Add Dynamic Image Adds a media item for viewing images originating from a “WATCHOUT
) . namic Image Server” (see page 217).
Dynamic Image [&J Dy 9 ( pag )

Name. The name used to refer to the media item.

Mame:

Server Address. The IP number of the computer running the dynamic
image server application. If left blank, WATCHOUT will use the address speci-

Server Address:

Leave Sarver Address empty to use

deful sdiress from Freferences fied in the Preferences dialog box (see “Default Dynamic Image Server
Stage Preview: @) Live Thumbnail Address” on page ]23)
Dimensions
. Height: 480 Stage Preview. Controls whether the production software’s Stage window

will display the live dynamic image or a static place-holder.

serverFa NOTE: Live preview is not supported when running the dynamic image

Farameters: server software on the WATCHOUT production computer.

o [ coneel ] Width/Height. The dimensions of the dynamic image. Generally, this
) should match the actual source image file. But in some cases it may be conve-
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New Folder

Large Thumbnails

Refresh

nient to enter a different value here, which will make the dynamic image server
scale the image accordingly.

Server Path. The path to the still image or SWF file on the dynamic image
server. This is specified relative to the location of the image server application.
For example, if a file named “CNN_News.swf” is in a folder named Dynimg,
located next to the “WATCHOUT Image Server” application, set this to:

Dynl ng/ CNN_News. swf

Use the -f command line parameter to specify an dlternate location of the
served content (see “Alternate File Location” on page 218).

Parameters. Additional parameters passed to the dynamic image being
served. See “Dynamic Image Parameters” on page 221 for details.

Adds a new folder to the Media window, allowing you to group related media
items. Any such group of media in the Media window is independent of the
folders on your hard disk, and serves merely as a means to organize items in
the Media window.

Displays larger thumbnail images in the Media window. This gives a better
preview of each image, but reduces the number of items visible in the list.

NOTE: The size of wide thumbnails in the Media window is also affected by
the width of the Thumbnail column. Make this column wider to see wide
thumbnails.

Refreshes items in the Media list by reloading their information from the
associated media files. A dialog is displayed allowing you to refresh media
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that has been changed or all media regardless of the file’s last modified time-
stamp.

Select Unused Selects all unused items in the Media window. After reviewing the selection,
you can choose Clear on the Edit menu to remove the unused media items.

IMPORTANT: Only media items directly or indirectly associated with cues
on the Main Timeline, or any auxiliary timeline, are considered as being
used. Specifically, media items used in compositions are only considered
used when the composition itself is being used. Hence, you can prevent a
composition and its media from being considered unused by adding it to
an auxiliary timeline.
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TIMELINE MENU

Click Jumps to Time

Add Play / Pause Control Cue

Adding and Removing Layers

Layer Settings

The Timeline menu applies specifically to the contents of timeline windows. It is
only available when a timeline window is selected.

Deselect this option to keep the time position stationary while manipulating
cues and tween points. The state of this mode is reflected by the color of the
current time indicator.

HINT: Turn off this option to use the current time indicator as a ruler for
aligning cues and tween points. See “Snap” on page 130 for more details.

Adds a Control cue at the current time and selected layer. When reached
during playback, the cue will perform its programmed action. See “Control
Cue” on page 193 for full details.

HINT: When using Control cues, dedicate a layer rather than mixing them
with other cues. This makes them easier to find and prevents them from
getting obscured by other cues.

Choose “Append Layer” to append a layer to the timeline, or choose “Insert
Layer” to insert a layer in front of the current layer. Choose “Delete Layer” to
delete the current layer. A layer containing cues can not be deleted.

Opens a dialog box that allows you to rename the layer as well as set various

layer attributes. See “Layer Name and Attributes” on page 103 for more
details.
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Timeline Settings

Jump to specified time position.

Total duration of the timeline.
Extended automatically as more
cues are appended.

Auxiliary Timeline Settings

The name of the auxiliary time-

line (shown in the Task window).—————————Name: Marquee Lights

Jump to specified time position.

Total duration of the timeline.
Extended automatically as more
cues are appended.

152

Choosing this command while the Main Timeline Window is active will display
the settings associated with the main timeline.

Main Timeline @

— Time Position: Eﬂ

Duration; 10:00.0

[ OK ]| Cancel |

HINT: Typing a value into the “Time Position” field jumps to that time. This
is offen more accurate than trying to click a specific time in the time ruler.

Choose the “Timeline Seftings” command to displays the seftings for an active
auxiliary timeline window.

Auxiliary Timeline 3]

— Time Position: m

Duration; 10:00.0

Stacking Order: |TaskListOrder  ——— Rendering order in relation to

other auxiliary timelines.

[ QK ]| Cancel |
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Stacking Order; Task List Order

Always on Top

Above Edge Blend

This is the default stacking order. In this mode, multiple active auxiliary time-
lines render their images in the order in which they are listed in the Task
window. You can change this order by dragging tasks up or down in the Task
window, thereby affecting how multiple, active and overlapping auxiliary
timelines inferact on screen.

In this mode, the auxiliary timeline will render its images on top of all other
auxiliary timelines set to “Task List Order” or “Always on Top” when activated.
This is useful, for example, when you have a group of mutually exclusive time-
lines, where each new timeline started should supersede the previous one.

HINT: You can then use a Control cue to stop the previous auxiliary timeline
in the group. See “Controlling Other Timelines” on page 194.

In this mode, the auxiliary timeline will render its images on top of all other
timelines when activated. Furthermore, no edge blend will be applied to its
images. This is useful in two specific cases:

*  When displaying line-up images. During line-up you want fo see the full
image all the way out to the edge to make sure that the image fits precisely
onto the display chip in the projector.

® When showing a live video image on a display partially intersecting other
displays lacking capture cards for this live video input. Putting this live video
image on an auxiliary timeline set to render above the edge blend avoids
the feathered edge that would otherwise be applied to the intersecting
areas.
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Composition Settings

The name of the composition
(shown in the Media window).

Jump to specified time position.

Duration of the composition.

To displays its settings, choose “Timeline Settings” while a composition’s time-

line window is active.

e

When selected, the composi-

tion’s duration will not be auto-

matically extended.

Lock Duration

Reference Frame

154

Cormposition @
Bl Car w engine|
N cosiion: 0.0 The reference frame is dlsp/gyed
as a gray, dotted rectangle in the
Duration: 10.0 Stage window while editing the
P composition. It is also u§§d to
manipulate the composition
Reference Frame:
when subsequently used from
= Topc | 100 —1— other timelines.
Width: 1934 Height: 600
[ Ok ] | Cancel |

This option is useful for compositions designed to be looped. Often such a loop
is designed with a particular cycle time in mind, set as the duration of the
composition. In this case, check this option to avoid having the duration
extended automatically as cues are added or edited.

By default, the reference frame is set to enclose all displays on the current stage
tier when the composition is created. You can set the reference frame to any

size you want, but it is generally a good idea to make it about the same size
as its content. This frame is displayed as a gray rectangle in the Stage window
while the composition’s timeline window is active. Furthermore, it is also used
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TWEEN MENU

WINDOW MENU

HELP MENU

to select and manipulate the composition as a whole when used as a media
item on other timelines.

NOTE: The reference frame doesn’t constrain or clip the content of the
composition. Images may extend outside the reference frame if desired.

The Tween menu is available when a media cue is selected. It allows you to add
tween tracks to the cue. Likewise, tween tracks can be removed by unchecking
the corresponding item on the Tween menu.

NOTE: The items available on the Tween menu vary depending on the
selected media cue. For instance, Volume tweening is only available for
sounds and videos — not for still images.

Read more about the various kinds of tween tracks on page 179.

This menu provides access to all standard windows, such as Stage, Media,
Main Timeline, etc. Other windows, such as Composition and Auxiliary Time-
line windows are appended to this menu while open, providing a quick way to
switch among them.

NOTE: To open an Auxiliary Timeline or Composition window, double-click
the corresponding entry in the Task and Media windows respectively. A
Composition window can also be opened by Alt-double-clicking a cue for
that composition.

This menu provides quick access to the WATCHOUT User’s Guide and the
release notes with the latest news on the current version.
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9 DISPLAYS

Adding Displays

Selecting Displays

Positioning Displays

Displays include projectors, monitors, video wall cubes and plasma screens.
Make sure you install and configure your displays properly, as described on
page 17. Read more about different display technologies on page 239.

To add a display to the Stage window, choose “Add Display” on the Stage
menu. This menu includes most standard display sizes. The size can be altered
afterwards using the “Display Specifications” dialog box (page 158).

NOTE: Displays can be grouped into stage tiers. When using multiple tiers,
new displays are added to the current tier. Likewise, you must select the
proper tier before you can manipulate its displays. See “Using Stage Tiers
for Complex Display Arrangements” on page 98 for more details.

Click a display to select it. Shift-click to select multiple displays. Alternatively,
drag from a point outside all displays to use the selection rectangle. To de-
select all displays, click outside all displays in the Stage window.

NOTE: You must activate the Stage window before you can select displays.
To activate the Stage window, click its title bar. Displays can not be manipu-
lated if “Online” on the Stage menu is active.

Drag a display to the desired position using the mouse. Press the Shift key
while dragging to constrain the movement to horizontal or vertical only. For
best precision, enter the exact position using the “Display Specifications”
dialog box (page 158).
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Removing and Duplicating Displays  To remove a display, first select it, then choose “Cut” or “Clear” on the Edit
menu. To duplicate it, first choose “Copy” then paste the duplicate back into
the Stage window. When pasting a display, keep in mind that the duplicate
initially occupies the exact same location in the Stage window as the original
did. You must move the duplicate to another location and change its name and
address before using it.

DISPLAY SPECIFICATIONS Double-click a display to open its Display Specifications dialog box. You must
) ~ activate the Stage window before you can select displays. To activate the Stage
Display i window, click its title bar. Displays can not be manipulated if “Online” on the

General | Geometry | Color & Stereo Stage menu iS OCHVe.

— 1] Name. Specifies the name of the display.

s R0 K IMPORTANT: This name is also used to identify pre-split movie files, as de-
ree: I (res omecin scribed under “Pre-splitting Large Movies” on page 42. Thus, if you use
coor: [ [ crec-. | such pre-split movies, you should not change the name of the display after
Disply Resoluton: creating those movies, or you'll have to rename the movies accordingly.
Width: 1520 Height: 1080

Address. Specifies the IP address of the display computer that manages this
display. This is typically the numeric address of the display. However, if the

isplay computer is accessible by name (by means of a Domain Name Server),
you may enter the DNS name in this field instead.

Stage Position and Size of Display:
Left: 3000 Top: 3000

Width: | 1320 Height: | 1080
/| Width and Height same as Display Resolution
HINT: In most cases, all display computers are on the same subnet, which
means that the first part of their IP address is identical, and only the last
group of digits differ (as shown in the illustration on page 27). In this case,
you can enk;r the common part of Lheh address in IrreLertTnces (see ”DFi;pby
— Address Prefix” on page 120), and then enter only the last group of digits
Lo in the Display Specil?icgtions dialog box. For instozmlce, if the complete

Rotation: 0 degrees dockwise

Stage Position of Display Center:
¥ 3960 ¥: 3540 pixels
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address is “192.168.0.51”, you would put “192.168.0.” into the “Display
Address Prefix” field in Preferences (note the trailing period), and then put
51 into the Address field in “Display Specifications”.

Output. Selects the output number of the graphics card to which the display
is connected. This allows you to drive multiple displays from one computer by
entering the same Address but different Output numbers.

Peer and Test Connection. Indicates the on-line status of the associated
display computer. You can use the “Test Connection” button to verify the ability
to connect to that particular display computer. This can be useful when trouble-
shooting a system.

Color and Change. Allows you to change the color of the display’s outline
in the Status window.

Display Resolution. Physical resolution used by the display computer for
the signal fed to its projector or other display device. WATCHOUT allows you
to specify any resolution. However, the allowable settings are ultimately deter-
mined by the display device and graphics card.

IMPORTANT: When using multiple outputs from a single display computer,
all outputs must use the same resolution.

Stage Position and Size. Determines the position and dimension of the
display in the Stage Window. Normally, the dimension here matches the phys-
ical resolution of the display. You can override this by deselecting “Width and
Height same as Display Resolution”, allowing you to enter different values.
Doing so will make WATCHOUT scale the image to match the resolution.

HINT: This is particularly useful if you have to play a show made for a
specific resolution on projectors that can’t handle that resolution.
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GEOMETRY CORRECTION

160

Rotation. Rotates the display to an arbitrary angle. This allows you to use a
vertical display format, as well as other creative display arrangements as
shown in the illustration under “Alternative Display Layouts” on page 10.

NOTE: Edge blending will only work properly between displays that are on
the same stage tier with the same rotation angle and stage size.

Stage Position of Display Center. This field is similar to the Left and
Top fields in the “Stage Position of Display” field above, but indicates the
center of the display rather than the top left corner. The center is often more
relevant when the display is rotated to an arbitrary angle.

These settings allow you to compensate for any errors caused by projection off-
axis (perspective), on a curved surface or for minor optical distortion.

NOTE: Projecting straight from the front on a flat surface always gives the
best image. Use geometry correction only when absolutely necessary.

The numeric fields at the bottom of the dialog box show values corresponding
to the currently selected point and handle. The buttons next to each numeric
field adjust the value with single pixel accuracy.

HINT: Go online before opening the Display dialog box to see the changes
on screen as you make them.

Corner Shapes. Adds bezier handles to the corners, allowing you to
compensate for minor optical distortion, often associated with wide-angle
lenses (as exemplified on page 249).

Constrain Points. Limits the freedom by which points can be moved to keep
them within realistic bounds. For example, it doesn’t allow points to be moved
outside the active display area. Deselect this checkbox for increased flexibility.
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Perspective Correction

Drag a corner point to adjust the
perspective.

The location of the selected point
can be adjusted numerically.

Used to transfer the geometry
settings fo other displays.

Smooth. Avoids abrupt kinks in points by keeping all tangents straight.
Uncheck to allow opposing handles to move independently of each other.

To compensate for the keystone-shaped image caused by off-axis projection,
choose Perspective on the Correction pop-up menu and drag the corners of the
grid until the image appears rectangular on screen.

Display

General | Geometry | Calor

Correction: |Perspecﬁ\re b

=

Corner Shapes

- Enable “Corner Shapes” to
compensate for optical
distortion.

| Constrain Points o
{| Copy |[ QK ] | Cancel
Chapter 9 Displays
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Horizontal or Vertical Correction

Adjust the curvature by dragging
the yellow handles.

Sets the curvature numerically.

Adds bezier handles to the top/bottom or left/right sides, allowing you to
compensate for projection on a curved surface.

Display @

General | Geometry | Calor

Correction: |Horizontal - Corner Shapes

Examples of

screens requiring
ENSP RSl °o4- horizontal and

Mirrors adjustments vertically.

162

/| Constrain Points e il ~ 7] smooth vertical correction

respectively.

| Copy | [ QK ] | Cancel |

HINT: If projecting from a plane at the center of the screen, select the
mirroring checkbox to adjust both sides together. You may need to uncheck
this checkbox for the final adjustments.
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Full Correction

Rectangular handles control
the distribution of grid lines.

Sets distribution of grid lines
numerically.

Drag a corner of the dialog
box to enlarge it for better
precision.

Adds bezier handles to all sides, allowing you to compensate for projection on
spherical surfaces.

Display

=

General | Geometry | Calor

Correction: |Full hd |

White circles indicate
mirrored adjustments of
points.

Corner Shapes

x[0 & @ —[0 |5 ———+— Selects one of the handles
vo EH@Z . 4o attached to each point.

] Constrain Points i 87 = 7] smooth

Copy Paste [ QK ] | Cancel

Examples of spherical
surfaces requiring full

correction.
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Adding Correction Points In Full correction mode, you can add control points to the grid by Control
clicking at the desired location. This can be used to handle geometry adjust-
ments when projecting on asymmetric or uneven surfaces, such as a three
dimensional map.

Display @

General | Geometry | Calor

Correction: |FL|II v| W | Corner Shapes

Control-click in grid to add

points.

To delete such a point, select
it and press the Delete key.

For maximum flexibility in
adjusting points, deselect
Constrain and Smooth.

. = f - X N .
Drag a corner of the dialog ConstrainPonts 450 [ [#fsmoot

box to enlarge it for better
precision.

Copy Paste QK ] | Cancel |
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COLOR & STEREOSCOPY

Select the Color & Stereo tab

Ideally, all projectors in a system should be properly color matched. However,
sometimes you may have to deal with projectors with different lamp life or
other minor discrepancies. In such cases, WATCHOUT lets you adjust the color
balance of a display device, making the overall image look more uniform.

( Display ﬁ ]

to make minor adjustments to
the color balance of a display
device.

Use a test image showing gray
bars to adjust the color balance.

Color corresponding to white for this display.

Red: [J w0 %
I

Green: G 100 %o
I

Blue: [J w0 =%
|

Stereoscopic Assignment:

[ OK ][ Cancel ]

NOTE: Di5p|qy computers need to be online for you fo see the chqnges as
you move the sliders.
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Stereoscopic Assignment

USING MULTIPLE DISPLAY OUTPUTS

166

Controls the stereoscopic channel reproduced by this display device. You must
use separate projectors for the images reproduced for each eye in a stereo-
scopic presentation. Select the appropriate eye affinity on this menu. Leave this
set to None for normal (non-stereoscopic) presentations.

For proper reproduction, each projector in a stereoscopic pair must be
equipped with filters matching those used in the glasses worn by the viewers.
Please contact your projector vendor for details on supported 3D projection
technologies. See “Stereoscopic Presentations” on page 86 for more details.

IMPORTANT: You must place the related left and right eye projectors at the
same stage position. To avoid WATCHOUT attempting to create edge
blends for those overlapping projection areas, place the set of left eye and
right eye projectors on separate stage tiers (see “Tier” on page 133).

WATCHOUT supports up to six displays connected to one display computer.
These displays operate independently of each other. Each display can be freely
positioned and rotated. The number of displays that can be connected to a
display computer depends on the number of graphics card outputs available.

To drive multiple displays from one computer, first make sure the displays
appear in the Windows Display Control Panel (see page 28). Then enter the
Output number of each display in its Display Settings dialog box (page 159),
using the same computer Address for these displays. Note that all outputs from
one display computer must use the same resolution.

IMPORTANT: Connecting multiple displays to one computer increases the
load on that computer. You will need a more powerful computer, with a
multi-core CPU and a fast disk drive or SSD, to drive multiple displays. For
best performance, you may need to limit the number of displays.
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10 CUts

Adding Cues

Selecting and Positioning Cues

Cues are the active objects of WATCHOUT. They control when media appear
on stage, as well as more dynamic behavior such as positioning and opacity.
Cues exist on layers in timeline windows. The layers determine the stacking
order of media on stage.

To add a cue to a layer in a timeline window, drag a Media window item, or
a media file, to the layer or the Stage window. Media files can be dragged
directly from your hard disk.

IMPORTANT: Whenever possible, keep all media used in a presentation in
a sub-folder of the folder containing the show file. Doing so allows
WATCHOUT to refer to the file using a relative path specification, making
it easier to move the presentation with all its media references intact.

When you drag media into the Stage window, the cue will appear on the
currently selected layer (as indicated by a yellow line under the layer’s name)
and at the current time position. When dragging into the timeline, the cue
appears at the layer and time you drag it to.

Click a cue to select it. Shift-click to select multiple cues. Alternatively, drag
from a point outside all cues to use the selection rectangle. Use “Select All” on
the Edit menu to select all cues on all layers. To de-select all cues, click in the
white space of any layer in the Timeline window.
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Selecting Cues using the Arrow Keys

Cutting, Pasting and Deleting Cues

Changing a Cue’s Media Position
On Stage

168

You can also select a cue by clicking its preview image in the Stage window.
This allows you to determine which cue corresponds to a particular image on
stage.

To position selected cues, drag them using the mouse. To drag cues to another
layer without altering their time positions, press the Shift key while dragging.

If you want to position a cue numerically, cut it, go to the desired time position
using the Timeline Settings dialog box (page 152), then paste it. Alternatively,
use the cue’s dialog box (see “Cue Specifications” on page 170).

Press the right or left arrow keys on the keyboard to select the next or previous
cue on the currently selected layer. Pressing the Shift key as well selects the next
or previous cue on any layer. Pressing the up and down arrow keys changes
the currently selected layer.

Use Cut, Copy and Paste on the Edit menu to move or copy cues within a
presentation or to other presentations via the clipboard. When transferring
cues to other presentations in this way, any media associated with those cues
will automatically be added to the target presentation.

To delete cues without altering the content of clipboard, select the cues then
choose “Clear” on the Edit menu.

Cues contain information on where the media will appear on stage. To change
the stage position, do one of the following:

* Drag the preview image in the Stage window. You can change the stage
position of multiple cues at the same time by first selecting those cues.
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e For precise adjustments press Control-arrow. Add the Shift key for greater
increments.

¢ Double-click a cue and change its “Initial Stage Position”. If the cue has
Position tween track, this will relocate the entire motion path.

¢ Double-click one of the cue’s Position tween points.

IMPORTANT: If a cue has a Position tween track, click the desired tween
point to go to its time before moving the image using the mouse or the arrow
keys. If the timeline isn’t positioned exactly at the tween point, a new point
will be added. This assumes “Click Jumps to Time” is selected on the Time-
line menu.

HINT: You can move the stage position of multiple cues using the Move
command (page 127). This is particularly useful when merging cues from
shows having different display positions.

The stage position of the anchor point is shown numerically in its Position tween
track, if any. See “Positioning Media on Stage” on page 65.

Changing a Cue’s Duration To change the duration of selected cues, drag the bar at either end of a cue. If
the cue has tween points, they will remain stationary in relation to the timeline.
To stretch the tween points with the cue, press the Alt key while dragging the

end of the cue.

Drag either end to change the HINT: Either end of the cue will snap to the current time position if “Snap”
duration of all selected cues. is selected (see “Snap” on page 130). For this to work, you must first
deselect “Click Jumps to Time” on the Timeline menu.
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Replacing a Cue’s Media

CUE SPECIFICATIONS

170

To set the duration precisely, type the desired duration into the cue’s dialog
box (see “Cue Specifications” on page 170).

NOTE: If you extend the duration of a movie beyond its natural duration, it
will by default stop at the last frame. Alternatively, you can make the movie
run repeatedly in a loop by choosing the “Loop” behavior in the cue (see
“Looping” on page 175).

To change the media associated with a cue, drag new media onto the cue. You
can drag either an item from the Media window, or a new media file from your

hard disk.

HINT: If you want to replace all instances of a certain media file, you can
change the file association of the item in the Media window instead, as
described under “Changing the File Association” on page 108. Doing so
will affect all cues associated with that media item.

Specifies the settings of the current cue. The options available vary with the
kind of media that is controlled by the cue. To open a cue’s specifications
dialog box, select the cue and choose “Specifications” on the Edit menu, or
simply double-click the cue.
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Video Cue

S|

Basic | Advanced

The time when the media will
appear on stage.

Starting offset into sound or video.

Stage position of anchor point at
the start of the cue.

Time: E

/7

Automatic

Duration: 27.8
Pre-Roll; (0.0

In-Time: 0.0

Media: Locate Media

BartGlow2,m2v

Initial Stage Position:

X371 ¥i 3400 rlE

Anchor Position within Image:

o712 ¥i 400 0

Position of anchor point within
image, relative to image'’s top left
corner.

SetTo:l Top Left ] l Center }

[ (04 ] ’ Cancel

)
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How long the media remains
visible on stage.

Media will be pre-rolled auto-
matically (uncheck to specify
pre-roll time manually).

Locates associated item in the
Media window.

Sets the top-left or center
position for anchor point.

171



In-Time

Anchor Position

Initial Stage Position

Locate Media

172

Specifies a starting offset for a sound or movie. For example, a certain movie
may have ten seconds of black at the beginning. To skip those fen seconds, set
the in-time to 10.

Determines the position of the image anchor, relative to the upper left corner of
the image. The anchor of a selected cue is displayed as a crossed circle in the
Stage window. When scaling or rotating an image, the anchor specifies the
point that remains stationary.

HINT: A checkbox in the Preferences dialog box determines the initial posi-
tion of the anchor point for new cues. See “Center Anchor Position” on
page 121.

If the cue has no Position tween track, this field controls its media position on
stage. Otherwise, this is the position of the first tween point. Changing this
position moves the entire motion path, if any.

HINT: To move the position and motion paths of a set of cues, first select the
cues, then choose Move on the Edit menu.

Locates the associated item in the Media window, automatically opening any
enclosing folder.

HINT: Double-clicking a cue on a timeline while pressing the Alt key opens
its associated media item. This shortcut is particularly handy when you want
to open a Composition associated with a cue, as it allows you to go straight
from the cue into the Composition.
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Advanced Cue Specifications

( Video Cue @ |

Continue to play even if timeline
stops.

Controls how overlapping images
cover each other.

The stage window preview quality
of this cue.

Make the image rotate automati-
cally to point in the direction of its
motion path, and controls what
image axis fo consider as pointing
forward.

Behavior: [ Free Running Loop sound or movie when
[ Looping cue is extended past media’s
Stacking: [Default v natural duration.
Blend Mode: [Norma =] Contro/s how overlapping
images blend together.
Preview: [Best Quality vl

Allows an image to be
Masked by Layer Above: masked by the image on the
layer above, and to suppress
rendering of the image used
as mask.

[7] suppress Rendering {for use as Mask only)

[ Auto-orient along Motion Path

Forward Motion Direction: | X+
Allows for external control of
[|External Control of Position, Scale & Rotation ——1 position, scale and rotation
using an Input.

[ (04 ” Cancel ]

Pre-Roll

Video needs to be pre-loaded and prepared a few seconds ahead of its
appearance. When set to “Automatic”, this time is calculated automatically.
This is the appropriate setting in most cases.
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Pre-roll indicator. Drag to change ——

pre-roll time.

Free Running

174

However, certain video files may require extensive computer resources when
prepared. This may have an adverse effect on already visible, moving media.
Although this is unavoidable, you may be able to reduce the impact by moving
the moment when the preparation occurs backwards to a more appropriate
time.

When specifying the pre-roll time manually, a pre-roll indicator appears in the
timeline window. Adjust the pre-roll time by dragging the start of this indicator.

s

- Main Timeline
0:55.780 ;50 0:35 1:00

ArmCyde.mov ﬂ

@ BeyelEye.psd

Causes sound, movie or composition media to continue to play even if the time-
line is paused. This is particularly useful in speaker support or conference situ-
ations, where you may be cueing the timeline manually. While waiting at a
pause cue, you may still want to have something moving on stage.

m

HINT: Free Running and Loop behavior can be combined to create
continuous playback of undetermined duration.
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Looping

Stacking

Preview

Causes sound or movie media to loop (re-start from the beginning) when
played past its duration. This is particularly useful for short, cyclical anima-
tions, where the movie then contains only a single cycle.

NOTE: To see the effect of this behavior, the duration of the cue must be
extended past the media’s natural duration, or made free-running.

When using WATCHOUT in its traditional 2D mode, images originating from
higher timeline layers cover images from lower layers. This is the behavior
obtained when choosing “By Layer”. However, when positioning and moving
images along the Z axis (towards or away from the viewer), you may want
images closer to the viewer to always appear in front of more distant objects.
In many cases, this can be accomplished by placing the cues onto layers in a
matching order, which is the preferable solution. When this is not possible,
choose “By Z-Depth” instead, to make images with lower Z position appear in
front of images with higher Z position.

NOTE: Images with transparent or semi-transparent areas may not blend
with other objects as expected when using “By Z-Depth”. If so, re-arrange
the cues onto layers in the desired front-to-back order.

The “Default” option is identical to “By Layers” for cues on the Main Timeline
or Auxiliary timelines. For cues in compositions, this setting makes images
inherit the corresponding setting of the cue that plays the composition.

Controls the maximum Stage window preview quality. Set to “Reduced” to
preview the image using its thumbnail. Set to “None” to suppress preview

Chapter 10 Cues 175



Blend Mode

Masked by Layer Above

176

altogether. When set to anything besides “Best Quality”, the name of the cue
is shown in italics to indicate this.

NOTE: The preview quality is ultimately constrained by the setting on the
Preview menu (see “Preview Quality” on page 135). The cue setting speci-
fies the maximum quality by which the cue will be previewed.

These options control how the image interacts with other images that it over-
laps on stage. They perform similar to those with the same name in applica-
tions such as Adobe Photoshop.

* Normal makes the top image completely cover the bottom image (unless it
has transparent areas or opacity applied).

e Add results in a very bright image, suitable for adding highlights to other
images. Black areas in the overlapping image have no effect.

* Multiply results in a darkened image. White areas in the overlapping
image have no effect.

* Screen is similar to Add, but softer and often produces a more pleasant
effect.

* Lighten keeps the lightest parts of the images.
* Darken keeps the darkest parts of the images
* Linear Burn is similar to the Multiple mode, but produces a more intense

result.

Allows you to use one image or video as a mask for another one. The image
to be used as a mask must be placed on the layer immediately above the one
to be masked. If the mask image has an alpha channel, choose the “Alpha
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Mask” mode. Otherwise chose “Luma Mask” to use the brightness of the image
to create the mask. Choose the “Inverted” version of each mask mode to
reverse the mask.

Italics indicate “Suppress
Rendering” selected.

-Lineup = .StageTier Left <<<O@FF.. = EI EK

Image used as mask with
“Suppress Rendering”
selected.

Image being masked,
with “Alpha Mask”

selected. = |

Red dots indicate mask.

my| pmp

Resulting image.

Masking is indicated by red dots running along the top of the masked cue.

Suppress Rendering When using an image as a mask, you often don’t want the image itself to be
rendered — only its masking effect. Select this checkbox in the cue that controls
the image used as a mask to obtain only the mask effect.

NOTE: Select “Masked by Layer Above” in the cue of the image being
masked, and select “Suppress Rendering” in the cue of the image being
used as a mask.

When this option is selected, the cue’s name is shown in italics
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Auto-orient along Motion Path

Y.
Z+
z—~

X-<:I Image |:>X+
r L

Y+

External Control of Position,
Rotation and Scale
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Causes an image to rotate according to its motion direction at any given time.
This is useful when animating an object that should always point along the path
of motion, such as an airplane (see illustration on page 76).

The “Forward Motion Direction” options control the orientation of the image as
it moves along the motion path. Choose the direction you want to be consid-
ered forward, with the default value being the right edge of the image (X+).

NOTE: In some cases you may also need to apply Rotation to the image to
make it point in the desired direction.

Usually, you control image position, rotation and scaling using the corre-
sponding tween tracks alone. However, you may occasionally want to control
these parameters from an external source, such as a MIDI or DMX input, or via
the network (see “Inputs” on page 197). Select this checkbox to allow for such
external control. Add the desired tween track and use its formula button to
assign the control source to the desired parameters (see “Controlling Tween
Tracks” on page 202).

IMPORTANT: Selecting this option significantly increases the load on all
your computers. Do not choose this option unless necessary.

NOTE: For still images, this option is only available when “More Effects and
Capabilities” is selected for the image (see page 36).
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TWEEN TRACKS

To add or remove a tween track,
first select the cue then choose the
desired type on the Tween menu.

Tween tracks of the selected cue
appear in the tween pane.

Formula button linking the tween
track to an external control input.

Tween tracks control the appearance of media on stage over time. Depending
on the type of media associated with the cue, you can add one or more tween
tracks. Opacity, Position, Scale, Rotation, Crop, Color and Tint apply to
images. Volume applies to movies and audio media. Most tween tracks also
apply to composition cues.

B WATCHOUT + Yo2 = | B el

File Edit 5tage Preview Media Timeline Tween | Window Help

. Main Timeline

External Control of Tween Tracks

| parp G

The following pages describe each kind of tween track. See also “Tween
Tracks” on page 69 for more details on how to use tween tracks in general.

Most parameters can be controlled by external inputs, or by a combination of
tween track and external input. Those are indicated by a round formula button,
as shown in the illustration above. See “Controlling Tween Tracks” on page
202 for more details. See also “External Control of Position, Rotation and
Scale” on page 178.
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Opacity

Opacity EXS
Time: | PR

Point Type: Smooth
Opadty: 7174 %

| QK | | Cancel

Volume

Volume 3]

Time: IR
Point Type: Smooth
Volume: 64 %o

| QK | | Cancel

Balance
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Controls the opacity (transparency) of an image. To change the opacity, either
drag the tween point vertically in the tween track, or double-click it to change
its value numerically. See “Opacity” on page 72 for more details.

The “Time Position” field specifies the position of the tween point along the
timeline. This must be a time within the time span occupied by the cue.

The “Smooth” checkbox allows you to change a corner point into a smooth
point, and vice versa.

HINT: The opacity curve is also displayed in the cue’s body, allowing you
to see it even when the cue isn’t selected.

Controls the audio volume of audio media and video containing audio. Its
behavior is identical to that of the Opacity tween point, described above. See
“Volume” on page 72 for more details.

HINT: The volume curve is also displayed in the body of a cue assigned to
an audio media item, allowing you fo see the curve even when the cue isn’t
selected.

NOTE: When a Volume tween track isn’t used, the volume is controlled by
a sefting in the Preferences dialog box (see “Default Audio Volume” on
page 121).

Controls the left/right audio channel balance. Applies to audio media and
video media containing audio.
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Scale

)

M stage <. [= |[= |[ 52 |

|
As an alternative to the Scale
dialog box, simply drag the
scaling handle. Press Shift to
maintain the image’s propor-
tions as you drag.

Non-uniform scaling results in a
split scale curve, allowing you to
adjust horizontal and vertical
scaling independently.

Scales an image in relation to its anchor position (see “Anchor Position” on

page 172).

Time: 13.872
Point Type: || Smooth
Constraint: .:{' Maintain Proportions

Scale, X: 7941 ¥i 741 o

Scale [==]

Image Size, X: 95 ¥= | 25 pX.

I (0]4 | | Cancel

™

You can specify either the scale factor (relative to the image’s natural size), or
the desired size of the image on stage. Negative values flip the image.

To scale the width and height by different values, first uncheck the “Maintain
Proportions” checkbox.
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Position

Paosition

Time:

Incoming: || Smooth  Speed:

Outgoing: ||| Smooth  Speed:

Link Handles
Location

X 4744.10

Y: 384225 A

1

1

0

QK

|| Cancel |
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Positions an image on stage. To change the position, drag the image or one of
the motion path handles shown in the Stage window when the cue is selected.
To set the position numerically, double-click the Position tween point and type
the desired position of the anchor point into the “Location” field.

HINT: To move the entire motion path, first select all the Position tween
points, then drag the image. Or use the Move command on the Edit menu.

The “Speed” fields control the speed of motion into or out from the point. A
value of 1 results in the normal speed required to move linearly to the next
point. Smaller values make the image go slower and greater values go faster.
The speed is indicated by white dots along the motion path (see below), and
can also be controlled using the speed handles (visible only for smooth points).

Using the Z position field, you can move the image along the Z axis, away
from or towards the viewer. The Z position can also be controlled by dragging
the Position tween point vertically, with the position indicated numerically next
to the tween track. Moving the image along the Z axis changes its perceived
size according fo the amount of perspective selected in the Preferences dialog
box. When images move away from the viewer, they move toward the
vanishing point, which is also set in the Preferences dialog box. See “3D
Perspective and Stereoscopy” on page 124.

Normally, images overlap and obscure each other according to their layer
order. When using Z position, you may want images closer to the viewer to
obscure images farther away. If so, select “By Z-Depth” in the cue’s specifica-
tions (see “Stacking” on page 175).

When positioning images along the Z axis, it may be hard to see where the
image is when viewed from the front. If so, choose “View, Left” or “View, Top”
on the Stage menu to rotate the stage preview. These views also allow you to
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Moving along a Path

edit the Z position by dragging the image or its position tween points in the
Stage window.

HINT: In some cases, it may be easier to edit the position of an image in the
Stage window by first deselecting Perspective on the preview menu (see
“Perspective” on page 136).

The “Smooth” checkboxes allow you to create curved motion paths, as shown
under “Moving Along a Curved Path” on page 76. When selected, a direction
handle appears attached to the point, controlling the direction of motion into
or out from the point.

B8 stage <<< OFF LINEs>>> (== ]=E]
Smooth Position tween points
create a curved path. S
White dots along the motion path | . .
indicate the speed of motion.
Speed control handle. 3 i

‘ )

Link Handles  Select “Link Handles” to make sure that the motion through a tween point is

perfectly smooth. When selected, the directional handles on either side of the
point are linked so they always point in opposite directions.
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Rotation Z
Rotation @
Time:

Point Type: || Smooth

Angle: +173.3 ® .
Revolutions: 0

QK | | Cancel |

. Stage <<.. | o || & |[ EE

____________________________________

Anchor Rotate by dragging
point. the handle...
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Rotates an image around its anchor point (see “Anchor Position” on page
172). You can rotate the image by a specified number of revolutions or
degrees, or a combination of the two. (For example, to rotate 2.5 times, set
Revolutions to 2 and Degrees to 180.)

Alternatively, drag the rotation handle in the Stage window or the Rotation
tween point in the tween pane.

HINT: You can also make an image rotate automatically to orient itself
along a motion path, as described on page 178.

. Main Tirneline EI@

2:17.517 | 210

¥ Rotation
+48.6°

...or a rotation tween point.
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Rotation X and Y

Key (Green/Blue)

Key (Selective)

Similar to the Rotation Z tween track described on the previous page, but

rotates the image around its X (horizontal) or Y (vertical) axes instead, making
it appear in perspective. The amount of perspective applied is specified in the
Preferences dialog box (see “3D Perspective and Stereoscopy” on page 124).

HINT: To edit the amount of X or Y Rotation interactively in the Stage
window, first change the viewpoint using the View command on the Stage
menu (see “View” on page 131).

Makes a green or blue background transparent. This is sometimes referred to
as a “green screen” or “chromakey” effect, and is typically used with live
video, although it can be used with any kind of image. Adjust the Threshold
and Contrast parameters for best effect.

HINT: For non-rectangular video playback, you can often use a pure green
or blue background, combined with this tween track, as an alternative to a
true alpha channel. This allows you to use to use more efficient video codecs
than QuickTime Animation, such as MPEG-2 or H.264.

Makes any specific, pure color transparent. This can, for example, be used to
make a black background transparent (sometimes referred to as a “luma
keyer”). Select the color using the color swatch, then adjust the Threshold and
Softness parameters for the desired effect.

HINT: Use this feature to display Powerpoint slides, fed through a capture
card Live Video or a Computer Screen media item, on top of a background
produced in WATCHOUT. Specify a suitable background color in the

Powerpoint presentation, which is then made transparent using this effect.
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Corners

An image being mapped onto an
object using a Corners tween track
to position each of its four corners.

Offsets the four corners of an image individually, allowing it to be mapped
onto another image or real-world object. As the corners are moved, the image
changes accordingly to obtain a matching perspective (see below). While this
alters the perceived perspective of the image, the image remains flat (2D).

Original image.

Corners pinned to a target object.

Wipe
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HINT: This tween track can also be used to skew the image by moving either
the top or right-hand side control points.

The various Wipe effects make an image appear gradually, starting from one
edge or corner and progressing towards the other. To see the effect, ramp up
the Completion parameter from 0 to 100% over time. Change the Angle

parameter to control the direction of the wipe. Adjust other parameters to your
liking by changing the parameter while the Completion value is around 50%.
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Black & White

Contrast & Brightness

Keep Color

Makes the image monochrome based on the color chosen in the Hue and Satu-
ration parameters. Adjust the Mix parameter fo restore some amount of the
original color, if desired.

HINT: The “Black &White” effect, with a carefully chosen source color, often
gives a better result than using the “Hue & Saturation” effect to desaturate
the image.

Adjusts the contrast and brightness of the image. This effect uses a spline curve
to adjust these values, similar to how you may use the “Curves” command in
Photoshop, thereby avoiding clipping in bright or dark areas.

Makes the image mostly monochrome, while retaining a certain color range.
First select the color to keep by clicking the color swatch or by adjusting the
Hue, Saturation and Brightness tween tracks. Then adjust the Tolerance and
Softness until you achieve the desired effect.
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Crop Use a Crop ftween track to move the edges of an image inwards. You can use
this to remove unwanted parts of an image, or as a creative effect to make text
or other elements appear gradually, as in the example shown below.

-

B Stage <<< OFF LINE»>> = |[3 [ 2] BS Main Timeline =eR==

4:15.041 | 410
1

¥ Layer 3

¥ Crop

Left

Adjust the cropping by dragging
the tween point corresponding to
the desired edge, or double-click
the point to set its value numerically.

Here the right edge of the image is cropped in a decreasing manner, revealing
the logo as a wipe effect, from left to right.

HINT: To specify a precise amount, double-click a tween point and enter the
value as a percentage or in pixels.
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Color

Click this button to change the — 1

color.

Use a Color tween track to specify the overall color of an image. The colors in
the image will be multiplied by the color you choose. You can think of the Color
tween track as the color of a light source illuminating the image. Normally, the
color of this light source is white. By changing the brightness or color of this
light source, you can influence the overall brightness or color of the image.

Start by selecting an image cue on the timeline and choosing “Color” on the
Tween menu to add the tween track. The default color is white, as indicated by
the small color swatch next to the tween track name. Click this swatch to
change the color.

i

. Main Timeline -
J:54.661

b
|

This brings up a dialog box allowing you to specify the color. Choose among
the following color models:

e HSB Sliders specifies the color by first picking a hue (a specific color) and
then the saturation (the amount of that co|or) and brightness of the color.
This intuitive color model is familiar to many artists and painters.
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* RGB Sliders specifies the color using an additive method based on the
amount of the three primary colors Red, Green and Blue. This color model
is often familiar to users with a web or computer background.

e CMY Sliders specifies the color using a subtractive method, where you
specify the filter density of an imaginative set of Cyan, Magenta and Yellow
filters. This model may be familiar to you if you come from a lighting back-
ground, where filters are often used to control the color of a light.

Color Chooser (3]
Choose a color model. HSB Sliders | RGB Siiders | CMY Siiders |
Hue: — 1) 156 %
Specify the color with the sliders, or T —
numerically in the text fields.
Saturation: U 30.64 o
| |
Brightness: U 100 24
—
This swatch indicates the resulting : —
Resulting Color: |
color.
[ 0K ] [ Cancel ]

NOTE: It doesn’t matter which of the three methods you use fo specify the
color. Use the method that feels most familiar to you.
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Click to reveal the sub-tracks.

Set the color by manipulating the
individual sub-tracks.

This method provides more
precise control over the color.

When using the HSB model, note that merely changing the Hue has no effect
unless you also specify a saturation and brightness greater than zero. Watch
the “Resulting Color” swatch as you drag the sliders to see the resulting color.
The preview in the Status window shows the color as applied to the image.

An dlternative way of specifying the color is to open the Color tween track to
reveal its sub-tracks.

i

- Main Timeline [ [ =] [

NOTE: The sub-
tracks always use
the HSB color
model.

HINT: Double-click a tween point to set its value numerically. As the hue is
specified by its color wheel angle, you can use this method to create
rainbow cycles by making the hue go through several revolutions.
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Tint

Hue & Saturation

192

Hue

Saturation

Gain

Offset

Use a Tint tween track to add color to an image. You can think of the Tint tween
track as specifying the color of translucent spray paint added to the image.
Normally, the Tint color is black, meaning that no color is added.

Another way of contrasting the Color and Tint tween tracks is to say that the
Color tween track primarily affects the bright areas of the image, while the Tint
tween track mainly affects the dark areas.

HINT: You can combine both Color and Tint on the same image.
Specify the color to be added using the same methods as described above for
the Color tween track.
Allows you to re-map the color spectrum of an image, as well as adjusting its
color saturation contrast and brightness.

Rotates the color spectrum of the image so that the chosen hue corresponds red
in the original image. This can be used for minor color balance adjustments alll
the way up to color inversion

Adjusts the color saturation.

Changes the contrast of the image by multiplying all its pixels by the specified
amount.

NOTE: This may result in clipping in bright areas. If you only want to change
the contrast, use the “Contrast & Brightness” effect instead.

Changes the brightness of the image by adding the chosen amount fo its pixels.

HINT: You can invert the image by setting the Gain to -100% and Offset to
100%.
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Channel Mixer

CONTROL CUE

Cue name. Used to jump fo a
named position. Name cues F1
through F12 to use function keys.

Control the enclosing timeline or
another, specified timeline.

Time position or Control cue
name fo jump fo.

Makes the timeline stop, pause or
run (possibly after jumping).

Re-mixes any amount of the original Red, Green and Blue color components to
the Red, Green and Blue color components of the resulting image.

The Control cue governs the behavior of timelines. The cue is performed when
the timeline runs past it. The Control cue can be used to make a timeline pause,
or jump to another position (by time or by name). To create a Control cue,
choose “Add Control Cue” on the Timeline menu (see page 151).

Control Cue

L ame: F2 Time: 8,918

Tell Timeline:

@ Current MNamed:

| Jump to:

X3

@) Time Position: 0.0
R Control Cue Named:

rse Only

m

Sedarcn ke
Stop (applies to Auxdliary Timeline only)
I Pause (@ Run

Jump-to-Run Delay: 0.0

Ok l | Cancel
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Name of auxiliary
timeline to control.

Makes timeline jump to a
time position or a named
Control cue.

Jumps backwards only
when jumping to a
named cue.

Introduces a delay

between the jump and the
restart.
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Creating Loops

Controlling Other Timelines

194

You can use the “Jump to” option fo create loops — causing a section of the
timeline to be repeated. When jumping, you have the option of automatically
restarting the timeline after the jump. In this case, it is often a good idea to
introduce a delay of a second or so fo allow the display computers to catch up
before starting. This is done using the “Jump-to-Run Delay” field.

To exit such a loop, use the QuickFind feature described below, possibly in
conjunction with the Standby command (see “Standby” on page 134).

Another option for creating loops is to use a free-running and looping compo-
sition. While slightly more complex, it gives better control over the loop exit. To
use that method, proceed as follows:

 Put the entire loop into a composition (see Chapter 10).

e Start it using a composition cue (see page 91).

e Select Loop and Free Running in the cue to make the composition loop.

* Make the Main Timeline pause during the loop.

* To continue affer the pause, fade out the looping composition cue.

A Control cue can also be used to start, stop and position auxiliary timelines.

To do so, select “Tell Timeline: Named” in the cue, then enter the name of an
auxiliary timeline into the field.

HINT: To name an auxiliary timeline, choose “Timeline Settings” while its
timeline window is open. Do not change the name of an auxiliary timeline
after creating control cues targeting it, or you will break the connection.
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Using Find and QuickFind Named Control cues can be used with the Find command to locate a position
along the timeline by name. A QuickFind feature allows you to instantly jump
to positions using the computer’s function keys. To use this feature, simply
name the Control cues “F1”, “F2”, etc, as in the example on the previous page.

IMPORTANT: The Control cue’s name field is case sensitive. When using
function key names, type an upper case F.
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| 7 INPUTS AND OUTPUTS

INPUTS

B Input (=[5 =]

Click this button to add an input.

Generic Input

Inputs and outputs act as gateways between WATCHOUT and other external
devices. Using industry-standard protocols, such as DMX-512, MIDI, TCP/IP
and Serial data communication, you can interact with the presentation envi-

ronment in many creative ways.

Inputs receive signals from the outside world. Those signals can then be used
to control and influence the behavior of WATCHOUT by starting and stopping
timelines and by controlling various cue parameters.

To create an input, first open the Input window using the Window menu, then
choose “Add...” from the pop-up menu located in the upper right corner of the
Input window. Depending on the type of input chosen, this displays a dialog
box allowing you to enter its specifications. See the following sections for
details on the various kinds of inputs.

NOTE: When you are using the production computer, inputs are managed
there. When not using a production computer, inputs are managed by the
primary display computer in each cluster.

Use a generic Input when you want to control its value using the WATCHOUT
control protocol. The default range of a generic input is O through 1, although
you may set the upper limit to any positive value using the Limit field in the
Generic Input’s dialog box. To control a generic input, use the setinput
command (see “setinput”’ on page 256 and page 267).
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Connecting a MIDI device Connect your MIDI device to a USB port (or other suitable MIDI interface) on
v your WATCHOUT computer. Many newer devices come with a direct USB
connection. Older MIDI devices often use a standard 5-pin DIN connector, in
which case you need a MIDI-to-USB adaptor, or other Windows-compatible

MIDI interface.

IMPORTANT: When using the production software, connect your MIDI in-
terface to the production computer. Otherwise, connect it to the primary dis-

play computer. Turn on and connect your MIDI interface and devices to your
computer before starting WATCHOUT.

MIDHoUSB
adaptor.

MIDI Controller Input A MIDI Controller Input brings in a knob or slider from a keyboard, or similar
signal from a MIDI-compatible device or software. This type of MIDI data is
sometimes referred to as a “Continuous Controller, “Control Change” or “CC”

message.
MIDI Controller =53]
The name used to refer to
this input in expressions. Mame: | MEi=s
Channel used for the message. ~———— channel: 1 Click “Learn” and move the

MIDI controller number. ———————— controller: 1 Learn —— controller to pick up the channel and
controller numbers automatically.

Data resolution for the controller — Resolution: @) Mormal (7 bit)
(usually 7 bits). High (14 bits)

Ok | | Cancel |
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A MIDI device with controller
knobs and note keys.

Enter the MIDI channel number and controller number to use, if you know
them. If not, click “Learn” and move the controller.

NOTE: The controller number used in the MIDI protocol is often not the same
as any number next to the knob on the device. Furthermore, many devices
have programmable controllers, so the actual controller number may vary
depending on the device’s configuration.

Do not select “Resolution: High” unless you know for a fact that the controller
transmits high resolution data. Regardless of the resolution being used,
WATCHOUT normalizes all controller inputs to a number in the range 0
through 1, as indicated in the Input window’s Value column.

When done, click OK in the MIDI Controller dialog box. Verify proper opera-
tion of the input by moving the controller and observing the bar graph in the
Input window.

B Input =5 | Ho |5

Mame | Description -

# ModWheel MIDI 1Contr 1 0,608

=

Indicates the current
"~ controller input value.
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MIDI Note Input A MIDI Note Input brings in MIDI keyboard messages, often referred to as
“Note On/Note Off" messages.

MIDI Mote 3]
The name used to refer to
this input in expressions. Mame: MiddleC
Channel the message is sent on. ———&hannel: 1

Click “Learn” and press the key to
MIDI note number. Mote: 60 7| Learn—— pick up the channel and note
numbers automatically.

| Ok | | Cancel |

When done, click OK in the MIDI Note dialog box, Verify proper operation of
the input by pressing the key and observing the bar graph in the Input window.
If the keyboard has velocity sensitivity, the velocity is indicated by the magni-
tude of the value.
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DMX-512 Input

DMX-to-Ethernet adapters from
Enttec and Kissbox.

DMX Channel e
MName: m

Channel: 1 1-512

Resolution: @) Mormal
_ High (16 bit}

Ok ] I Cancel I

A DMX-512 Input brings in the value of a DMX channel. DMX-512 is a
protocol used by most lighting consoles, dimmers, moving lights and other
similar devices.

WATCHOUT uses the computer network to receive DMX data using the Artnet
protocol (see http://www.artisticlicence.com/). Many modern lighting
consoles can send Artnet over an Ethernet network. In other cases, a DMX-to-
Ethernet adapter must be used. In either case, you need to know the DMX
channel number(s) to be used for WATCHOUT, as well as the Artnet Universe
number used to send those channels.

You must configure WATCHOUT to receive that specific Artnet Universe
number. This is done under the Control tab in the Preferences dialog box (see
“DMX-512 Universe” on page 123).

Add a “DMX-512 Input” to the Input window. When done, click OK in the
DMX Channel dialog box, and verify proper operation of the input by moving
the fader for the specified channel and observing the bar graph in the Input
window. WATCHOUT normalizes DMX values to a number in the range 0
through 1, as indicated in the Input window’s Value column.

Resolution. Some lighting consoles support high resolution (16 bit) values.
Such high resolution values are generally required to control, for example, the
position of images in WATCHOUT, since the standard 8 bit DMX resolution
(0...255) is too low for this purpose.

If your console is capable of outputting 16 bit DMX values, choose “High (16
bits)” for the Resolution setting, and enter the base (coarse) channel number.
WATCHOUT will derive the coarse 8 bits from this channel and the fine 8 bits
from the following channel.
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Controlling Tween Tracks

The formula button allows you
to control a parameter using
an input. The button turns
yellow to indicate that such
control is in effect.

202

Inputs can be used to control parameters of cues, similar to the way tween
tracks are used. This provides external control over most parameters. To use

this capability, add the desired type of tween track to

the cue, then click the

formula button located in the header area of the tween track. You may need to
click the triangle in the tween track header to reveal the formula button. Some

tween tracks have multiple controllable parameters.

[= ==

. Main Timeline

0:18.050

A red tween track

¥ Camera LiveCamera
* bk

curve indicates that
the parameter is over-
— ridden by a formula.

Clicking the formula button brings up a dialog box al

lowing you to enter the

control formula. By default, the formula consists only of the TweenValue item.

NOTE: In order to access the formula of some tween tracks, such as Position,

Scale and Rotation, you must first enable this in th
“External Control of Position, Rotation and Scale”

e cue’s seftings (see
on page 178). For still

images, you must also select “More Effects and Capabilities” in the media’s

specification (see “Optimize For...” on page 36).

Some tween tracks, such as Position, contain multiple

values, one for each

dimension controlled by the tween track (such as X, Y and X position).
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Enter the name of an input to
control the parameter using that
input. This example uses a MIDI
controller, as shown on

The TweenValue identifier represents the tween track itself. To control the
parameter using an input, simply enter the name of the input instead.

Pararneter

Formula governing the parameter being tweened:

(=3

page 198. Or enter a formula
combining inputs, numerical
constants, operators and the
original TweenValue. See
“Expression” on page 212 for
more details.

Triggering Tasks

Click in the Trigger column of a

task to enter its starting condition.

The result of the expression is applied to the parameter being controlled.
It may include the name of inputs, operators (+, - *, etc) and the name
TweenValue {which refers to the current value of the tweening curve).

QK | | Cancel |

You can use an input fo start an auxiliary timeline by entering the name of the
input in the Trigger column of the Task window.

. Task

Name | Status

TMAG Overlay S W ) |

A red border around the
— field indicates an error in
the formula.

Press Enter to complete the formula. The task will be started whenever the value
of the formula entered in the Trigger column becomes non-zero. You can

create more elaborate starting conditions by entering a more complex formula
including multiple inputs, numeric constants and operators. See “Expression”

on page 212 for more details.
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OUTPUTS

Creating Output Cues

Drag an output fo a timeline to
create a cue for it.

204

IMPORTANT: Most media cues need some time to prepare before they will
appear properly on stage. Therefore, it is generally a good idea not to put
such cues at the very beginning of an auxiliary timeline. Leave about a sec-
ond or so empty at the beginning of the timeline.

HINT: You can only use a trigger to start a task — not to stop it. To stop a
task, use another task with a timeline containing a control cue that targets
the timeline to be stopped. Trigger this second task using the desired condi-
tion. See “Controlling Other Timelines” on page 194 for more details.

Use Outputs to send data to other devices and systems from WATCHOUT. To
create an output, click the menu button in the upper right corner of the Output
window and choose “Add...” (see “Output Window” on page 110).

Outputs are controlled using cues. To create a cue for an output, drag the
output from the Output window onto a timeline.

. Output

Mame || Description

@ touselights DM 62

e OMX 1

Switch UDP 192.168.0.64
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DMX-512 Output

DME Output

Channel: 62

1-512

X

Marme: 1_._._."=' E*

[ ok

] | Cancel

Use a DMX-512 Output to control lighting and other devices which accept the
DMX-512 protocol. Specify the DMX channel number to use in the dialog box,
as shown to the left, and give the output a descriptive name.

You must also configure WATCHOUT fo transmit DMX data on the Artnet
Universe number used by the device(s) to be controlled. This is done under the
Control tab in the Preferences dialog box (see “DMX-512 Universe” on page
123). All devices controlled by WATCHOUT must be in the same Artnet

universe.

If the devices being controlled don’t have an Ethernet connector accepting the
Artnet protocol, you need an Ethernet-to-DMX interface, as shown under
“DMX-512 Input” on page 201.

A DMX-512 Output is controlled using a Fade cue, created by dragging the
output onto a timeline, as seen on page 204. This cue contains a single tween
track, allowing you to control the DMX output.

IMPORTANT: The DMX output is only controlled while the cue is active.
Jumping to positions on the timeline between Fade cues will not change the
output. To control an output over the entire duration of a timeline, the Fade
cue must have the same duration as the timeline.

NOTE: If you have multiple cues controlling the same output at the same time
(for example on separate timelines), the highest value will be chosen.
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String Output

Use a String Output to control devices that accepts text strings or other discrete
data packets through a serial or Ethernet port. For example, you can tell a
projector to power down by sending it a command through a serial port on its

display computer.

String Qutput

x5

Output Port Name: Switch

Select the kind of data port to use
on this menu.

For a network port, enter its IP
address and port number here.

[Network Port (TCP or UDP)

i |

| Metwork Address:

IF Port Mumber:

Select the desired IP protocol.

Using a Network Port

206

Protocol:

192.168.0.64

3002

TP @ UDP

[ o

] | Cancel

The settings in this part of the
String Output dialog box are
specific for the kind of port

selected on the menu above.

When using a network port, you must know the IP number (or DNS name) and
port number of the device to be controlled. You must also specify a protocol
type. UDP is a rudimentary protocol used by many simple devices, while TCP
is more common on computer-based systems. When using the TCP protocol,
WATCHOUT will open the connection (if not already open), send the data
packet, and close the connection affer about a minute of inactivity.
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Using a Serial Port  To use a serial port, connect the device to the COM1 port on any display
computer, and select that display computer on the pop-up menu in the String
Output dialog box. Select the data rate and parity mode according to the
specifications of the device being controlled.

I

String Output @

Output Port Name: m

Serial Port of a Display Computer v]
1 Selectadisplay computer that has
Display Computer: | -None Selected - | a serial port available, and set its
Data Rate: [9600 v] commuplcatlons para(n'efer's
according to the specifications of
Parity: [Nﬂﬂe "] the device to be controlled.
[ Ok ] [ Cancel ]

For more details on serial data communication and wiring, see

http://en.wikipedia.org/wiki/Serial port

http://www.airborn.com.au/rs232.html
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Sending a Data String A String Output is controlled using a String Cue, created by dragging the
output onto a timeline (see “Creating Output Cues” on page 204).

String Cue (=)
Name the cue fo state its purpose. ——name: On Time: 20.8374
Enter the data to send to the device Data to Send:
here. This can be plain text, hexa- ——— [anjson
decimal data bytes, or a combina- -
tion of bofh Prefix efJCh jLWO'C”g”L To send arbitrary data, type a dollar sign followed
hexadecimal byte with a $-sign. by two hexadecmal digits. For example, to send
a Carriage Return, type S0D.
[ Ok l | Cancel |

NOTE: The data is sent only when the timeline plays across the cue. It is not
sent when jumping fo or past the cue.
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| 2 TASKS AND EXPRESSIONS

The Task window allows you to create multiple auxiliary timelines, and to

Drag a task towards the top of the —
Task list to make its images appear
in front of other tasks’ images.

See “Task Window” on page 111
for more information.

specify their triggering conditions using expressions. Auxiliary timelines
behave very much like the main timeline, but can be started and stopped
independently.

If an auxiliary timeline displays images on stage, those images will appear on
top of any images originating from the main timeline. You can control the
order in which images from multiple, concurrent auxiliary timelines interact by
dragging the tasks to the desired order in the Task window.

B Task (===

Name | Status —— Click to add more tasks.

(m | » [E MY 32 — Task’s triggering expression.
P Crenshaw | . 0:28
J Jones uu
B Aru:lrr:u'-.'ﬁ uu
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AUXILIARY TIMELINE

Double<lick the task name to open ——

its timeline.

Click here to start, stop or pause
the auxiliary timeline...

...or click here after opening its
timeline window.

Starting and Stopping Manually

210

Double-clicking an item in the Task list opens its associated auxiliary timeline.

p [
.Task | = || =

fiame | Status | Trigger
Marquee Lights  [ElIEN
] » |

. P Crenshaw = | = ]

200, 08 10:00

K

HINT: Change the name shown in the Task list by first opening the auxiliary
timeline and then choosing “Timeline Settings” on the Timeline menu.
An auxiliary timeline has three primary modes:

e Stopped (red stop button is illuminated). In this mode, the timeline doesn’t
contribute to the stage.

* Paused (neither button is illuminated). In this mode, the time isn’t moving,
but any cues at the current time position does contribute to the stage.

e Playing (green play button is illuminated).

You can control these modes manually by clicking the buttons either in the Task
window or in the lower left corner of an open auxiliary timeline window.

NOTE: You don’t need to open an auxiliary timeline to run it. Just click its
play button in the Task window.
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Starting from an Input Alternatively, you can trigger an auxiliary timeline using an external signal,
brought in as an input in the Input window. For details on how to configure
inputs see page 197. “Triggering Tasks” on page 203 describes how you use
an input fo trigger a task. The task will be started when the value of the trig-
gering expression becomes non-zero. This expression may combine multiple
inputs and constants using operators (see “Expression” on page 212). For
example, to trigger a task when the input goes above 50%, enter an expression
such as this one:

ModWheel > 0.5

NOTE: The task will be triggered only when the value of the expression goes
from being zero to being non-zero. In order to trigger the task again, the
value must first return fo zero.

B Task =5 | Ho|F5c)

Mame

Margquee Lights
To see the current value of an
expression, point at the expression ——
using the mouse. 3 Jones : i

Starting from Another Timeline You can use a Control cue to position, start, stop or pause an auxiliary timeline
from another timeline. See “Controlling Other Timelines” on page 194.

NOTE: You can not control the Main Timeline from an auxiliary timeline.
Only Control cues on the Main Timeline can control the Main Timeline.
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Stopping an Auxiliary Timeline

EXPRESSION

212

An auxiliary timeline will stop automatically after playing to its end.

HINT: Set the length of an auxiliary timeline using the Timeline Settings
command on the Timeline menu while the auxiliary timeline’s window is
active.

Alternatively, use a Control cue (either on the timeline itself, or on another time-
line) to stop it. When stopped, its images will disappear from the stage.

An expression is a simple mathematical formula, combining values such as
inputs and numeric constants using operators in a way that yields a numeric
result. Expressions are used to:

e Start tasks, as described on page 211 and under “Triggering Tasks” on
page 203.

¢ Influence tween tacks (see “Controlling Tween Tracks” on page 202).

In its most basic form, an expression consists of a single value, such as an input
(this example assumes that an input with the name “ModWheel” exists in the
Input window — see “MIDI Controller Input” on page 198):

ModWheel

If this expression is used in the Trigger column of the Task window, that task will
be started when the ModWheel's value becomes non-zero (that is, when the
modulation wheel on the attached MIDI device is moved from its zero position).

Likewise, if this expression is used as a formula for an Opacity tween track, the
opacity will be controlled only by the modulation wheel (that is, the value of the
tween track itself will have no effect).
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Using Numeric Operators In some cases, you may want to combine multiple values. For instance, in the
previous example, you may change the expression so that the modulation
wheel modulates the value of the cue’s Opacity tween track by entering the
following expression into its formula dialog box:

Parameter (23]
Formula governing the parameter being tweened:
Enter an expression for a tween Tweenyalue * ModiWheel
track by clicking its formula
button (see page 202)- The result of the expression is applied to the parameter being controlled.

It may include the name of inputs, operators (+, - *, etc) and the name
TweenValue {which refers to the current value of the tweening curve).

| QK | | Cancel |

This expression combines the value of the ModWheel input with the value
coming from the tween track itself by using the TweenValue identifier, which
provides the enclosing tween track’s current value. Since both values are in the
range O through 1, multiplying them in this way will work as desired.

A|’rernc1tive|y, you may want fo combine the two values so that the opacity can
be controlled by either the tween track or the modulation wheel. This can be

accomplished by changing the formula to
TweenVal ue + ModWeel

Now the resulting image will appear on stage if the tween track or the external
input says so. Note that if both the tween track and the input are at their
maximum value, the result of the expression will be 2. However, the opacity
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Using Relational Operators

Using Logical Operators

214

value is effectively clipped to the range O through 1 (as the image can’t be
more than fully opaque or fully transparent). Most parameters work in this
way, with the notable exception of the color hue, as it allows the color wheel to
be rotated multiple revolutions.

When using expressions fo trigger tasks, it is often useful to specify a threshold
for the triggering value. If the input is used on its own, the task will be triggered
as soon as the input leaves zero. If you prefer the input to exceed a certain
value, you can use a “greater than” operator to test for this:

ModWheel > 0.5

This operator yields a value that is 1 if the value on the left hand side is greater
than the value on the right hand side, otherwise its value is 0. Likewise, if you
want to trigger the task when the value becomes zero (rather than when it
leaves zero), you can write:

ModWheel = 0
This uses the “equals” operator, yielding 1 if the value on the left is the same

as the value on the right, else it yields O.

Occasionally you may want to create more complex triggering conditions,
combining multiple inputs, so that the task will only be triggered when all
conditions are met. That can be accomplished using the “and” operator:

MbdWheel > 0.5 && M ddl eC

This will trigger the task when the modulation wheel is above 50% and the
MiddleC key is pressed (assuming here that MiddleC is a MIDI Note input).

Chapter 12 Tasks and Expressions



List of Operators This is a list of the operators supported by WATCHOUT, shown in their order

OF precedence.

Operator

Description

()

%
+ -

< <= >
>= = | =

Parenthesis. Used to group sub-expressions.
Unary Minus.

Multiplication, Division and Modulo.
Addition and Subtraction.

Less Than, Less Than or Equal To, Greater Than, Greater Than
or Equal To, Equal, Not Equal.

Logical And.
Logical Or.

Most operators work as expected. The Modulo operator yields the remainder
of an integer division. All other numeric operators yield results with fractional
digits. All relational operators (<, >, efcetera) yield 1 if the relation is true, O if
it is false. Likewise, the logical operators yield 1 for true and O for false.
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| 3 DYNAMIC IMAGES

[ WATCHOUT Dynamic Image Server [ E et

File Help

~) dataton

7| /E:/Readersnf

Latest news from CNN World

Image Types

The WATCHOUT Image Server is a separate program that allows you to incor-
porate up-to-date text, images and graphics into your presentation. It renders
the requested images, and sends the result to your display computers via the
network. This is somewhat similar to the way a VNC Server provides images
for a “Computer Screen” media item, but provides for greater flexibility and
programmability.

Being a server application, the program doesn’t offer much in terms of user
interface. It simply runs on a computer connected to the network and responds
to image requests from WATCHOUT. Using the Open command on the File
menu, you can manually open supported files to preview them on screen.
Images are also displayed while they’re being served to WATCHOUT.

NOTE: As the Image Server runs as a separate application, it requires its
own WATCHOUT license key.

The Image Server can serve two types of images:

e Astill image.

e A SWF file (Adobe Flash).

For still images, the Image Server accepts the same kinds of images that you
can generally use with WATCHOUT. It supports transparency information for
files that include such data.
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Alternate File Location

SERVING STILL IMAGES

218

By default, image files are served from a folder relative to the location of the
Image Server application. If you want to keep your dynamic images elsewhere,
pass the -f command line parameter to the Image Server application to specify
the location of the folder. Put this option into a shortcut used to start the image
server, possibly located in the Startup folder of the computer, so that the
shortcut’s Target field reads something like this:

"C:\WATCHOUT 5\ | mageServer.exe" -f D:\Dynl mages

Enclose the image folder path within double-quotes as well if it contains
spaces.

By providing a still image through the Image Server, you may change the
image at any moment. Whenever the image is replaced on the image server,
it will immediately appear on all displays currently showing it. To update the
image on the server, simply drop a new image file into the folder containing
the old one, with the same name and dimensions as the old image.

You can provide the updated image in any way you like. For instance, you
may run a web server on the same computer, configured to allow files to be
uploaded to the image folder being watched by the Image Server. This web
server can provide a web interface for manual uploading of images, or interact
with smart camera phones via the Infernet.

Alternatively, you may have a custom application that updates the image on a
regular basis, based on some external data or other events. This application
can run on the same computer as the WATCHOUT Image Server, or another
computer connected over the network. From the Image Server’s point of view it
doesn’t matter where the image comes from. As soon as it is changed, it will
be updated on screen accordingly.
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SERVING SWF FILES

Sourcing Flash Content

For even greater flexibility, you may choose to serve Flash (SWF) files. Such a
file can dynamically generate and update text, graphics and other image
elements, and can interact with various data sources. SWF files are produced
using Adobe Flash Professional. By combining high quality text and graphics
rendering with a powerful, network-aware programming language, Flash
allows you to create custom solutions with very little effort.

In order to serve SWF files, you must install the Adobe Flash Player 10.3 or
later on the Image Server computer. This is available as a free download:

http://get.adobe.com/flashplayer/

IMPORTANT: Since the SWF files served by the Image Server reside locally
on the Image Server computer, you may need to grant additional rights to
those files in order to access network resources. To do so, go to Control Pan-
el, Flash Player. Click the Advanced tab, then Trusted Location Settings.
Click the “Add...” button and add the folder(s) containing SWF files to be
served by the Image Server.

There are many sites on the internet dedicated to providing Flash examples
and tutorials. This is a great source for simple flash content, such as live clocks,
stock tickers, news readers, etc. In many cases, such content can simply be
dropped into your Image Server folder and used as-is.

IMPORTANT: Since you're going to run the SWF files on your local comput-
er, with a relaxed security sandbox based on the “trusted location settings”
set above, only use SWF files from sources you trust.

NOTE: Keep in mind that such content may be copyrighted. Always check
its license before including it in your presentations.
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Example SWF: A News Reader

220

To develop custom solutions, you need to be familiar with Flash Professional
and its ActionScript programming language, which is used to create live data.
The example below shows a complete news reader for displaying the latest
news from CNN:

var rssXML:XML; // RSS feed data is loaded here

var rssLoader:URLLoader = new URLLoader();

var rssURL:URLRequest = new URLRequest("http://rss.cnn.com/rss/edition_world.rss");
var timer : Timer = new Timer(10000); // For updating the display on a regular basis

rssLoader.addEventListener(Event. COMPLETE, rssLoaded);
rssLoader.load(rssURL);

function rssLoaded(evt:Event):void {
var firstCall : Boolean = !rssXML;
rssXML = XML(rssLoader.data);
if (firstCall) {
updateDisplay(null); / Draw first time rigt away
timer.addEventListener(TimerEvent. TIMER, updateDisplay);
timer.start(); / Display other news every 10 seconds
}
}

function updateDisplay(evt : TimerEvent) : void {
var itemCount : uint = rssXML.channel.item.length();
if (itemCount) { / Has something to display
var pick : uint = Math.random() * (itemCount-1);
displayField.htmlText = rssXML.channel.item[pick].description;
}
}
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Displaying Server Files

DYNAMIC IMAGE PARAMETERS

Missing Still Images

Put the image and SWF files to be served into a folder on the computer running
the WATCHOUT Image Server application. Typically, this folder is located in
the same folder as the Image Server application. Alternatively, add a
command line parameter when starting the Image Server application to put the
image folder elsewhere (see “Alternate File Location” on page 218).

You can fest a file manually using the Open command in the Image Server
application. This will display the image on screen if it is compatible with the
image Server application.

To display an image in your WATCHOUT presentation, add it as a media item
to the Media window of your WATCHOUT presentation (see “Add Dynamic
Image” on page 148), then drag it onto stage and update your display
computers. The image should now be requested from the Dynamic Image
Server, and displayed on screen.

NOTE: You can also preview dynamic images in the production software, if
specified in the dynamic media item. This feature is not available if you run

the Image Server on the same computer as the WATCHOUT production
software.

In addition to the basic settings, such as the dimensions and location of the
image being served, you can also provide additional parameters to the
dynamic image. The parameters available vary with the type of image served.
Still images support only the single, optional parameter:

ni ssi ngl magel sCK

to indicate that a missing image should be displayed as entirely transparent,
rather than giving an error message.
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Flash Parameters

Dynamic Image

Name: TN

Server Address:

Leave Server Address empty to uss
default address from Freferences

Stage Preview: () Live (@) Thumbnail
Dimensions

Width: 400 Height: 50

Server Path: flash/TickerTest. swf

Parameters: code=AAPL

[ Ok ] | Cancel |

===
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For SWF images, any parameters specified in the Dynamic Image Specifica-
tions dialog box are passed to the SWF similar to how parameters are passed
from a web page. This allows you to customize a single SWF file in various
ways, without having to modify the SWF file itself.

For example, when creating a stock quote display SWF, you may not know
what company to display. Instead of hard-coding the company identifier into
the SWF file, pass it as a parameter by putting it into the “Parameters” field of
the dynamic media item, as shown on the left.

You can then access this “code” parameter, as well as any other parameters
you may want to pass, from the loaderInfo object in the SWF file like this:

| oader | nf 0. par anet ers. code

This parameter can be sent to a web service providing live stock quotes, such
as the one available from Yahoo.
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A SYSTEM REQUIREMENTS

COMPUTER

IMPORTANT: These are mini-

mum system requirements.

Faster processor, faster mem-

ory, SSD or faster hard disk
with cache memory, faster

graphics card with more vid-

eo memory, etc, will enhance
performance. Some functions
(for example, live video inte-
gration) require additional
hardware.

This appendix lists what you need in order to install WATCHOUT on a PC.

A WATCHOUT computer has the following minimum system requirements:
* Intel or AMD dual core processor (quad core to drive multiple displays).
e USB port.

* Ethernet port.

e SATA hard disk (SSD recommended to drive multiple displays).

e 2 GB RAM (3 GB to drive multiple displays).

e PCl Express 16x video card slot.

* Modern ATl or nVidia graphics card with 256 MB of video memory (1GB
if driving multiple dusokays).

e High quality audio output or sound card/interface.
* Windows XP Home (Windows 7 Home to drive multiple displays).
¢ DirectX 9c¢ (included in Windows 7).

NOTE: It is generally not recommended to mix different kinds of computers
or graphics cards in one display cluster.
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LIVE VIDEO INPUT

NETWORK

224

To integrate live video into WATCHOUT, each display computer used to show
live video must be equipped with a suitable video input, and its driver software
must be installed. Some capture cards support multiple Composite and S-Video
inputs, while some support more advanced video signal standards.

Suitable video input solutions include:

® Black Magic Design DeckLink SDI, Duo, Studio or HD Extreme, accepting
SDI/HDSDI signals. Studio also accepts analog. Intensity Pro accepts HDMI
and analog.

http://blackmagic-design.com/
¢ Datapath VisionRGB cards accepts VGA/DVI/HDMI computer signal.
http:/ /www.datapath.co.uk/

The production and display computers must be connected using a TCP/IP
compatible network.

A typical system has 100 MBit Ethernet network ports on all computers and @
high-quality Ethernet switch with the required number of ports to connect the
computers.

A wireless network may work, but is generally not recommended for reliability
reasons.
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I} COMPUTER ISSUES

DEDICATED COMPUTER

Formatting the Disk and Installing
Windows

While the basic configuration of the display computer outlined in Chapter 2
“Installation” is sufficient in many cases, some computers require additional
work to achieve best possible performance. This section provides some general
hints and pointers on how to proceed.

If you intend to use a computer primarily as a WATCHOUT display computer,
it probably makes sense to re-format the hard disk and then install only
Windows, required device drivers and WATCHOUT. This avoids many prob-
lems caused by various pieces of software that are often pre-installed on
computers, or that may have accumulated over time.

NOTE: You don’t have to re-format your hard disk in order to use
WATCHOUT. This is an advanced procedure that helps in obtaining the
best possible performance. You can apply all other adjustments described

in this appendix even if you choose not to dedicate the computer to
WATCHOUT.

To prepare your computer in this way, first make sure that the hard disk doesn’t
contain any important information. You should perform a backup if you're
unsure about the content of the hard disk. Then start the computer from the
Windows installation disk, and follow the on-screen instructions. Early on in
the installation procedure, you will be asked where to install Windows. As part
of this, you will get the opportunity to remove the existing partitions and create
new ones, which you should do.
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Installing WATCHOUT

Right-click on the Unallocated
space and choose “New Parti-
tion”. Proceed with creating a
primary partition of the maximum
size.

226

For best performance, you should create a smaller (50 GB or so) partition for
Windows, and any other applications you may want to install. This partition
will become the C: drive. Leave the remainder of the disk unformatted for now.

Proceed with installing Windows on the newly created, small partition. Once
that's done, install required device drivers (graphics or sound card drivers,
etc), and perform any additional adjustments mentioned in this appendix.

Before installing WATCHOUT, you need to format the remaining space of the
hard disk. Choose Start > Programs > Administrative Tools > Computer
Management, then click Disk Management in the list.

(=5 |EOE =5

A Computer Managerment
File Action View Help
e 1 EE RXS & o
A Computer Management (Local) Volume
4 '[IJ.E Systemn Tools = (C)
3 @ Task Scheduler

- 2] Event Viewer n — .
- g2 Shared Folders }

- @ Reliability and Performance I

| Layout | Type | File System | Status
Simple Basic NTFS Healthy (System, Be

& Dei ==Disk 0
= Device Manager Basic )
4 =5 Storage 149.05 GB 50.27 GB NTFS

j =7 sk Management Online Healthy (System, | Unallocated

» Services and Applications

B Unzlocated [l Primary partition

IMPORTANT: On the last page of the “New Partition Wizard”, choose the
NTFS file system with an “Allocation Unit Size” of 32K. Generally, it is OK
to also select “Perform a Quick Format”.
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WINDOWS 7 UAC SETTINGS

Specifying a larger than usual allocation size greatly reduces the tendency of
disk fragmentation, at the cost of a small amount of wasted disk space. Given
the fact that most WATCHOUT media files tend to be rather large, this should
not have any practical disadvantages.

Once the formatting is complete, the new partition will appear as the D: disk
drive. Create a WATCHOUT folder on this disk, and install WATCHOUT to this
disk using the Installer, as described on page 15. When given the opportunity
to specify where to install WATCHOUT, chose the newly created WATCHOUT
folder on the D: drive.

The User Access Control (UAC) feature of Windows 7 may interfere with
certain functions in WATCHOUT, particularly when running on unattended
display computers. UAC, per definition, assumes that there is a user.
WATCHOUT display software is often run in an unattended way, with no user
standing by to click buttons or type passwords. Furthermore, you generally
shouldn’t run WATCHOUT on networks that have direct Internet access, or any
other kind of unrelated (and possibly harmful) traffic. Under those specific
circumstances, you're better off without UAC, since it tends to cause more
problems than it solves.

Things that UAC will interfere with, if enabled:

¢ Downloading of shows. WATCHOUT display software traditionally stores
its shows in the Shows folder, located in the same folder as the application.
This is a not permitted under UAC, and Windows will therefore relocate the
folder to another location. While this works OK as far as WATCHOUT is
concerned, it may interfere with other methods of accessing the Shows
folder, or just be confusing when you go looking for it.
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* Remote updating of WATCHOUT software and components. Since an
application under UAC doesn’t have permission to write to its own program
folder, or manage its components, those functions will generally fail under
UAC. Instead, you must manually install updates on each display computer,
with UAC prompting you for you administrator password.

For a regular PC, used to surf the web, the User Access Control is a good thing.
However, for an unattended computer running only WATCHOUT display soft-
ware on a private network, often without a keyboard connected, it doesn’t
make any sense.

To turn off the UAC:

e Click Start Menu, Control Panel, Action Center.
* Click Change User Account Control Settings.

* Drag the slider to Never Notify.

¢ Click OK and restart your computer.

You may need to take additional measures if you have already used a display
computer with UAC enabled, and then choose to disable it. As disabling UAC
also removes the automatic folder redirection, WATCHOUT will no longer see
its previous Shows folder, and will therefore create a new one, downloading
your shows anew. To avoid this problem after disabling the UAC, move the
Shows folder to its traditional location inside the WATCHOUT Programs folder
before restarting WATCHOUT
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GENERAL PERFORMANCE

Identifying Background Programs

The performance of a PC is often degraded by numerous small programs and
services running in the background. Such programs consume considerable
system resources, and may serve no purpose on a WATCHOUT display
computer. You can enhance performance by identifying and removing, or
disabling, such programs.

To identify any unwanted background applications or services, first close all
open windows then click the Start button and choose Programs > Accessories >
System Tools > System Information. Select “Software Environment, Running
Tasks” in the list to the left. The list to the right displays all currently running
programs (see illustration on page 230). Look specifically for tasks whose path
is anything but “c:\windows\system...”.

To see which programs that are automatically started, choose “Software
Environment, Startup Programs” in the list to the left.
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HINT: The names listed in the Running Tasks and Startup Programs lists are
often cryptic, and may be hard to associate with a particular program. In
this case, looking at the path leading to the program’s file can provide a

valuable hint. In particular, if the program is installed under “c:\Program
Files\...”, you should be able to learn more by looking inside its installation

folder.
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Removing Background Programs

Once you have identified any undesired background programs, you should
either remove or disable them. If you know you won't need a background
program, remove it from the computer.

To remove a program, open the “Programs and Features” control panel,
choose the program, and click “Uninstall”. Follow the subsequent instructions
on how to remove or uninstall the program.

If you're uncertain about removing the program, or if the program doesn’t
appear in the “Programs and Features” control panel, you may instead choose
to disable it. This can sometimes be done with configuration options in the
program itself. Other programs don’t offer this capability, forcing you to either
uninstall the program or disable it using other means.

Background programs often identify themselves by an icon on the taskbar, in
the lower right corner of the screen. Right-click such an icon to open its menu.
Sometimes the menu includes a “Disable”, “Close” or “Do Not Load” item. It
may include “Open”, “Configure” or “Properties” items that allow you to set
various options, including the automatic loading of the program at start-up.
After disabling a program in this way, restart the computer to verify that the
program is no longer active. Some programs only allow you to disable them
temporarily, and will then load again the next time you start the computer.
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Another way to locate and disable startup programs is by using the System
Configuration utility. To open this utility, click the Start button and choose Run.
Enter “msconfig” into the Run dialog box. Click the “Startup” tab. You can turn
off any undesired startup item by unchecking its checkbox.

(e System Configuration
| General | Boot I Services | Startup |Tm|s |
Startup Item Manufacturer | Cormmand | Location -
Windows Defender Microsoft Corp...  %%ProgramFiles... HKLM\SOFTWAREYM..
HD Audio Control Panel Realtek Semico... RHDVCpl.exe HKLMSOFTWAREYM. .
QuickTime Apple Inc, "C:\Program Fil... HELM\SOFTWAREM,.
Catalyst® Control Center Advanced Micr...  "C:‘Program Fil... HELM\SOFTWAREM,. |
MVIDIA Compatible VWindows Vista ... MVIDIA Corpor... RUNDLL32.EXE... HKLM\SOFTWAREWM..|™
MVIDIA Media Center Library MVIDIA Corpor...  RUNDLL32.EXE... HKLM\SOFTWAREYM..
|:| MVIDIA Compatible Windows Vista ... MVIDIA Corpor... RUNDLL3Z.EXE... HKLM\SOFTWAREM..
|:| MVIDIA Media Center Library MVIDIA Corpor... RUNDLL3Z.EXE... HKLM\SOFTWAREYM.. L |
[ mvIDIA Driver Helper Service, Versi... NVIDIA Corpor... RUNDLL3ZEXE... HKLM\SOFTWAREWM..
[ QuickTime Apple Inc., “C:\Program Fil... HKLM\SOFTWAREWM..
] L &) die Pl Fimemnl Fimmldm s O mmmimm, P HIE S ] e LI RATOAETLA AT ELRA ik
' 1 | 3
| Enableal | [ Disableal |
[ QK ] [ Cancel ] [ Apply ] [ Help ]
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System Services

NOTE: If the “Administrative
Tools” are unavailable, right-click
the task bar and choose Properties
to display the “Taskbar and Start
Menu Properties”. Click the “Start
Menu” tab. Click the “Customize”
button. In the list, make sure that
“System Administrative Tools” (or
“Display Administrative Tools” if
using the Classic Start menu) is

enabled.

Most background activities are not run as regular programs, but as System
Services. You can view the installed system services by clicking the Services tab
in the System Configuration utility (see previous page). This also indicates the
manufacturer of each service. In general, do not disable services by
unchecking them in the Services tab of the System Configuration utility. Instead,
choose Start > Programs > Administrative Tools > Services.

L Services [ ==
File Action View Help
" Services (Local)
Application Layer Gateway Service  Mame = Description Status Startup Type =
o Application Experi.. Processes a.. Manual
Start the service o Application Infor...  Facilitates t...  Started Manual
*3 Application Layer ... Provides su... Manual
Description: " Ati External Event ... Started Automatic
Provides support for 3rd party " Background Intelli... Transfers fil... Manual
E:’:s:ﬁigfgﬁ:::;rIntemﬁ ~: Base Filtering Engi... The BaseFil.. Started Automatic -
4 I [3
\ Extended /{Standard/

This list provides detailed information on each service. Select a service in the
list for a description. There are numerous services, many of which are not
needed on a computer dedicated to running WATCHOUT display software.
Not all services are running — only those listed as “Started”. To disable a
service, double-click it and set its “Startup Type” to Disabled.

For more information on what the various services do, and which ones you
may disable (or set to “Manual”), visit one of the many web sites dedicated to
tweaking Windows for better performance.
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Defragmenting the Disk

Using a Solid State Drive
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After using WATCHOUT for some time, adding and removing media or other
files, the hard disk may become fragmented. A fragmented hard disk signifi-

cantly increases the time and effort required to access and display images and
video. Defragmenting the disk restores it fo its optimal working condition. To

defragment your disk, choose Start > Programs > Accessories > System Tools
> Disk Defragmenter. Wait for the program to analyze your disks, then click

“Defragment Now”.

NOTE: Formatting the disk with a large allocation unit size, as described
under “Installing WATCHOUT” on page 226, greatly reduces the tendency
of fragmentation, but doesn’t eliminate it.

If your computer has additional disks or partitions, you should defragment
those as well. However, if you've partitioned the disk into a Windows and a
WATCHOUT partition, the Windows partition should not need to be defrag-
mented very often, since it really doesn’t change much.

If you also want to remove old shows from the disk, do so before you defrag-
ment the disk (see page 80).

IMPORTANT: The Disk Defragmenter can be set to run automatically on
schedule. In general, you shouldn’t use this feature on a dedicated
WATCHOUT display computer. If you do decide to enable this feature,
make sure it runs at a time where you're unlikely to be using your
WATCHOUT system.

If possible, choose an SSD drive for storing your WATCHOUT show data on

each display computer. This avoids the problem of disk fragmentation
mentioned above, and provides much faster access to the media files.
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DISPLAY PERFORMANCE

WATCHOUT is based on the latest technology in computers and graphics
cards. For this to work optimally, both the computer and the graphics card
must be properly installed and configured. One of the more useful utilities
available to verify and control the operation of the graphics card is PowerStrip:

%Aduanced timing options @
RAMDAC Harizontal geometry
Pisel clock  108.000 = MH=z Scanrate  £3.981 & kHz
Position and size Active 1280 2 pizels 11852 % s
—_ . —

- Frant porch 56 = pixels 05192 ps
Spnc width 112 = pisels 1.037 = ps

#‘ ¢ “‘ Backporch 24012 pivels 22222 s
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%
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“ertical geomety

Refreshrate  B0.020 2 Hz

[ Compozite sync
Sunc on green + = = Active 1024 2 lines 16005 = ms

[ interdaced IHermile] Wienlee! Front parch 12 lines 0016 2 ms

Options Sync width 3120 fines 0.047 21 ms

[ Utrafine ranuariy Customn resolutions... Back porch 38 2 lines 0534 = ms
[] Lock tokal geometry
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PowerStrip is shareware, and is available from:

http:/ /www.entechtaiwan.com/
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Display Drivers and DirectX

OTHER ISSUES

Video Playback

Sound Playback
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If you run into display problems or system errors, it’s often a good idea to look
for an updated display driver, either from the card’s manufacturer or the
chipset manufacturer (i.e., ATI/AMD or nVidia). WATCHOUT also requires
DirectX 9 or later — a standard part of Window Vista. You can download the
latest version of DirectX from:

http:/ /www.microsoft.com/directx

This section lists some other issues known to cause problems from time to time.

Some DVD player programs — often included with graphics cards or DVD
drives — may interfere with the ability of WATCHOUT to play back video
content (including some related audio formats). To solve this problem, uninstall
the DVD player application and all its components.

You need to install the proper software driver for the sound card installed in
your computer. The driver received with your computer, operating system or
sound card is usually sufficient, but you should check the sound card manufac-
turer’s web site to make sure you have the latest driver version installed -
particularly if you're experiencing sound playback-related problems.

When installing or updating sound card driver software, avoid installing other
associated software. Additional software is often provided that will run as
background applications. You may have to check for and remove such soft-
ware dfter installing/upgrading sound card drivers (see “Removing Back-
ground Programs” on page 231).
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Defect Drivers

CLONING A COMPUTER

Performance and reliability problems may be caused by defect software
drivers. Such problems can be hard to diagnose. More often than not, it's
easier to start from scratch by re-formatting the hard disk and re-installing
Windows and required device drivers only (see “Formatting the Disk and
Installing Windows” on page 225).

A WATCHOUT system typically uses multiple, identical playback computers.
Performing the above trouble-shooting and tuning operations on multiple
computers is tedious. An alternative is to get one display computer working
properly, and then clone its hard disk to the others. This, of course, assumes
that they all have the same hardware configuration.

A fast and convenient method for cloning the hard disk is to use True Image,
from Acronis:

http://www.acronis.com/

Using this program, you can clone a hard disk to another computer either
across a network or using a CD-ROM.

IMPORTANT: While the cloning procedure copies everything on the hard
drive, it does not perform any firmware (BIOS) or similar upgrade auto-
matically. You may need to perform any motherboard upgrades manually
after cloning the disk.
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C DISPLAY ISSUES

DISPLAY TECHNOLOGIES

DLP Projectors

(pLp

ATEXAS INSTRUMENTS TECHNOLOGY

WATCHOUT can be used with most display technologies, including DLP and
LCD projectors, LCD monitors, LED walls, video wall cubes and plasma
screens. Generally, you can use any display device that's compatible with the
display card in the display computer.

Avoid mixing brands and models of displays on adjacent or overlapping
areas, since they most likely will differ in their image reproduction. As the light
intensity and color temperature of many projectors may degrade over time, try
to use projectors that have been in use roughly the same number of hours.

The following sections provide an overview of display technologies, with
special emphasis on aspects related to WATCHOUT.

DLP (Digital Light Processor) uses a microscopic mirror chip to modulate the
light (see http://www.dlp.com/). This display technology has the advantage
of being 100% digital, resulting in excellent, long-term image stability and reli-
ability — particularly when using a digital computer connection, such as DVI
(see “DVI Connector” on page 242).

An issue with some DLP projectors is the lack of true black. The poor black level
produced by some projectors often results in gray banding in overlapping
image areas. This is particularly noticeable in a totally dark room, and,
conversely, is less of an issue in installations at, for example, a shopping malll,
a trade-show or similar environment. This problem is magnified when using
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very bright projectors on a small screen. Avoid using stronger projectors than
necessary for your screen size and ambient lighting conditions.

The contrast ratio has greatly improved over time. Modern DLP projectors,
utilizing second generation “black chip” Texas Instruments DLP technology,
often provide a contrast ratio of 3000:1 or better.

Keep in mind that when using WATCHOUT with projectors, you get the
combined brightness from multiple projectors. Hence, good contrast and color
saturation is often more important than high brightness. Hence, choosing a
“home cinema” projector may be better than an “office grade” projector due
to the better color fidelity and often lower noise level of the former.

To determine the suitability of a particular model of projector, always perform
proper tests under realistic screen size and lighting conditions. Details vary
widely among manufacturers and projector models, and are not always stated
on specification sheets.

A good starting point when looking for a projector may be one of the many
dedicated web sites, such as: http://www.projectorcentral.com/.
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LCD Projectors

LCD Display Panels

LCD (Liquid Crystal Display) projectors are in many ways similar to DLP projec-
tors, and share many of the same advantages and disadvantages. Instead of

bouncing the image off a mirror, an LCD projector uses a pass-through “filter”
to modulate the light. The more analog nature of this technology means some

LCD projectors may require more adjustment than DLP projectors, and exhibit
less long-term stability.

Some LCD projectors suffer from a poor black level. The problem is often even
more noticeable on LCD projectors than on DLP projectors, and there’s a wider
span of variation due fo the large number of LCD chip manufacturers. Always
make realistic tests under the expected screen size and ambient lighting condi-
tions. Use images of the kind you intend to use in the final presentation. Some
test images with white, black, saturated colors, checkerboards and gradients
are often useful too when evaluating projectors (see page 245).

Modern LCD display panels typically have very good color matching, bright-
ness and long-term stability — particularly when using a DVI cable. However,
when using multiple LCD displays to build larger display areas, bear in mind
the sometimes limited viewing angle.

Many LCD displays are designed for optimal image quality when viewed from
the front, with image quality degrading as you move off-center. Often, the
viewing angle is better when moving horizontally than when moving vertically
(as would be the case when placing multiple, landscape-oriented, LCD
displays in a column).
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When connecting the display to the display computer, keep the following in
mind:

* Keep analog (VGA) cables short. If possible, place the display computer
close to the display, powering both from the same outlet.

¢ If you must extend the cable, make sure you use high-grade extension
cables and distribution amplifiers.

Usually, the display is connected by using an analog 15-pin, VGA-style
connector or a digital DVI connector. Whenever possible, use DVI to connect
the display computer to the projector. This avoids many of the analog-to-digital
conversion problems associated with the VGA-style interface. If required, DVI
cables can be extended using products available from Gefen (http://
www.gefen.com/), Extron (http://www.extron.com/) and others.

The DVI (Digital Visual Interface; http://www.ddwg.org/) connector is
popular on LCD displays and modern video projectors. As the data to be
displayed is digital to begin with, it makes little sense to convert the signal to
analog, pass it through a VGA-style connector, and then convert it back to
digital form again in the display device. The DVI connector solves this by
keeping the signal in the digital domain all the way.

The advantages include a rock-solid image, no pixel jitter and best possible
image and color precision. This is usually provided with little, or no, need for
manual adjustment, resulting in improved image consistency and stability.

The high speed digital signal makes it more difficult to run long cables or to
distribute the signal to multiple display devices. Extension nd distribution solu-
tions based on CAT-5 cables and optical fibers are available from numerous
manufacturers (for example, http://www.gefen.com/).
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HDMI Connector

GENERAL TROUBLESHOOTING

Before You Begin

JERKY MOVEMENTS

The HDMI connector is similar to the DVI connector in many ways, but is gener-
ally limited to carrying video standard resolutions (for example, 1280 x 720
or 1920 x 1080 pixels). In some cases, you can connect a DVI output to a
HDMI input using a simple adaptor cable.

Just like the display computer, the kind of display or projector used has a major
influence on the end result. This section provides additional guidance on deter-
mining the cause and possible remedy of display related problems.

Connect a regular CRT monitor to the output of your display computer to deter-
mine if the problem is introduced by the display technology or by the display
computer. This is a good advice whenever you see unwanted phenomena in
the displayed image — always plug in a CRT monitor (assuming you can find
one). If the problem goes away, it's most likely caused by your display or
projector, in which case you should read this appendix. If the problem shows
up on the CRT monitor as well, you should instead focus on the display
computer (see “Computer Issues” on page 225).

An image moved using a Position track should move smoothly across the
displays. Jerky movement may be caused by either the display computer or the

isplay device itself. If the problem goes away when you view the output from
the display computer on a CRT display, you've determined that the jerkiness is
introduced by the display or projector you're using.

IMPORTANT: When making these fests, you should preferably use a CRT
monitor. If this is not possible, use a good quality LCD monitor. Some digital
display devices introduce artefacts of their own. Also, you may want to un-
plug the problematic display and connect the test display while the display
computer is running. If you restart the display computer, it may sense that
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Dropped Video Frames
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you've plugged in another display and change its behavior (for example,
its refresh rate), thereby causing the problem you're troubleshooting to
change or disappear.

The most common reason for such artefacts is lack of synchronization between
the video signal fed to the display and its internal operation. This is sometimes
a problem with digital display technologies, such as LCD and DLP. It is not a
problem with CRT-based computer displays, since they’re generally driven
directly by the incoming analog video signal.

Even if your display device supports multiple frequencies, it may work best at
one particular frequency. You may want fo try setting both the display card
and WATCHOUT to 60 Hz/fps even if you're using video optimized for other
frame rates, since this is the optimal display frequency of many projectors and
other display devices.

It is sometimes difficult o determine the optimal frequency of digital display
devices, or whether the display device is at all capable of synchronizing its
internal operation to the frame rate of the incoming video signal. Often,
changing the programming to use other rates for moves and other effects can
make artefacts less obvious. If possible, you may also try connecting the
display computer to the display device using other means, for example using a
digital DVI cable instead of the analog VGA.

Just as lack of synchronization in the display device can affect the smoothness
of positioning and other effects created in WATCHOUT, it may have a similar
impact on the video material used in your presentation. This is often particu-
larly noticeable in slow zooms and pans, or in objects moving across.
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BANDING

Gradients

Rear Projection

If using a CRT or known good LCD display makes the video playback look
considerably smoother, you're most likely experiencing synchronization prob-
lems introduced by the display or projector (see above).

This section deals with banding in smooth areas, either within a static image or
in the overlap area of projected images.

When displaying images with smooth areas and gradients, limited resolution
in the display may cause visible bands to appear. A good way of testing this is
to display a smooth grayscale ramp, as in the example shown to the left. Such
an image can easily be created in applications such as Adobe Illustrator or
Photoshop. You may also want to create test images with vertical or radial
gradients.

If such test images appear smooth on a good monitor, while exhibiting
banding using your display device, the signal resolution of the display device
is insufficient to reproduce all the steps in the gradient. Such problems are typi-
cally associated with low end, office grade projectors. Often, using a digital
interface may avoid or solve such problems since it circumvents the analog-to-
digital conversion step, which may be causing the loss of definition (see “DVI
Connector” on page 242).

When using rear projection, banding may be caused by the screen material.
This may also occur when using high-gain front projection screens. Such
banding can be identified by the fact that it moves with you as you walk along
the screen.

The only way to avoid or solve such problems is to use a different screen mate-
rial. Suitable low-gain screens for both front and rear projection are available
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Edge Blend Areas
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from most professional screen manufacturers (for example, “Aeroview 100”
from Stewart Filmscreen Corporation; http://www.stewartfilm.com/).

Banding and other artefacts may appear in the overlap areas of edge-blended
images. There are essentially three kinds of problems:

Too Dark, Bright or Uneven Overlap. It may be difficult to obtain a
perfectly invisible edge blend for all image types. You may have to locate a
typical or particularly problematic image in your presentation and tweak the
edge blend curve using that image for the best possible result (see “Edge
Blend” on page 121).

Non-linear Gamma Settings. Most LCD and DLP projectors have a
gamma curve setting, often with a number of standard curves to choose from.
In order fo achieve maximum perceived brightness, such projectors often come
preset to some high brightness gamma curve. While such a gamma curve may
provide some additional brightness, its non-linear nature tends to interfere with
the ability to achieve a smooth edge blend. Furthermore, it also results in
washed-out colors and a general lack of contrast. To avoid this problem, chose
a more linear gamma curve, often called “Photographic” or “Video”.

Projecting a grayscale gradient, or a set of gray bars (as seen in the testimage
on page 165) often reveals problems associated with a non-linear gamma.
Attempt to find a setting that shows a linear gradient, or a clear distinction
between each gray bar.

Gray Boxes in Dark Images. Due to the poor contrast ratio of some
LCD and DLP based projectors, lighter areas in the overlaps of black, or very
dark images are sometimes inevitable. You can minimize the effect by
reducing the light output of the projectors (for instance, by switching to a “low
brightness” or “economy” mode), or by increasing the ambient lighting in the
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Thin, Dark or Bright Slivers

room. Often, however, the best solution is to avoid large, dark areas in the
presentation altogether.

A slightly darker or brighter sliver along the edge-blend area is often the result
of under or over-shooting the chip in the projector.

NOTE: This problem is unusual when using DVI or HDMI interfaces, as those
interfaces allow direct pixel addressing, and often provide no control over
the image width or position.

Create a test image with a one or two pixel white edge. Put the image on an
auxiliary timeline set to perform above the edge blend. Adjust the projector so
that the image exactly fills the image area. Move the horizontal position of the
image to the left so the leffmost row of pixels just disappears, then move it back
so they reappear. Now adjust the image width to make the right edge of the
image fit the image area precisely. You may have to repeat the position and
width adjustments a couple of times, since changing one may affect the other.

Also ensure that the vertical position of the image shows the top and bottom
row of pixels. There's usually no adjustment for the image height, but if there
is, you may want to check that also.
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HOT-SPOTS

CREEPING SHADES
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Hot-spots appear as bright areas near the center of front or rear-projected
images. As you move your vantage point across the screen, these bright areas
tend to move with you in relation fo the projected image. The only way to solve
such problems is to use another screen material. Suitable low-gain screens for
both front and rear edge-blended projection are available from most profes-
sional screen manufacturers (see also “Rear Projection” on page 245).

When fading an image, you may sometimes see shades or ridges creeping
across or around smooth image areas. These artefacts are somewhat reminis-
cent of the Newton rings sometimes seen with slide projectors. They are gener-
ally caused by lack of resolution, similar to the description under “Banding” on
page 245.

The best way to diagnose these problems is to use a set of test images with hori-
zontal, vertical and radial gradients. Fade such an image slowly and look for
bands or rings moving across the image. Run the same test with a known good
display. The solution for this problem is the same as outlined above under
“Banding” on page 245.
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OPTICAL LINEARITY

Pin-cushion and barrel distortion.

Correcting Optical Errors

STEREOSCOPIC PROJECTION

When using multiple overlapping projectors, optical linearity is important.
Deficiencies in optics often show up as barrel or pin-cushion distortion. This
may be particularly troublesome when using short-throw, wide angle lenses
(often desirable for rear-projection).

The best way to avoid this problem is to choose projectors with high-grade
optics, and to ensure that your optics are properly matched for the desired
projection distance.

HINT: If you're using zoom lenses, you may be able to obtain better linearity
by changing the focal length and moving the projector accordingly.

If necessary, use the geometry correction feature built into WATCHOUT
(page 160) to compensate for the distortion. Some projectors have similar
capabilities built in.

Stereoscopic (“3D”) projection uses twice as many projectors as regular
presentations. Projectors are fitted with filters matching the filters used in the
glasses worn by the viewers. Special care must be taken when choosing the
screen material — particularly when using polarized filters. It may be hard to
find a screen material that works well for polarized stereoscopic projection,
while still avoiding hot-spots (see previous page).

An dlternative to polarized filters is the Infitec color filters, as this technology is
more accommodating in terms of screen material.

http:/ /www.infitec.de/
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") PRODUCTION COMPUTER PROTOCOL

Overview

Command Format

You can control a WATCHOUT production computer from an external device,
such as a touch panel or software capable of communicating using the TCP or
UDP IP protocols.

NOTE: While similar in its basic capabilities and commands, this protocol
is different from the one described under “Display Cluster Protocol” on
page 257. This protocol allows you to control the production computer,
while the Display Cluster Protocol controls one or many display clusters,
with no need for any production computer.

The production computer control protocol includes commands allowing you to
* Load a show from a specified file.

e Start, stop, position and run the timeline.

® Access the standby mode.

To control WATCHOUT production software in this way, you must choose
“TCP/IP” or “UDP” as appropriate in the Preferences dialog box (see “Produc-
tion Computer Control (TCP and UDP)” on page 122).

To control WATCHOUT, open a connection to TCP/IP port number 3040 of the
WATCHOUT production computer. UDP communications also uses port 3040.
Each command is then sent as a string, terminated by a carriage return, line
feed or CR/LF pair.
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Errors

252

A command consists of a command name, sometimes followed by parameters.
Commands are encoded using the UTF-8 UNICODE character format, which is
downward compatible with ASCII strings.

IMPORTANT: Commands containing non-ASCIl characters — such as &, &,
U, ¢ — must be encoded using the UTF-8 format.

String parameters are sent within double quotes. Backslash is used as an
escape character (that is, to encode a double quote in a string, precede it with
a backslash). To send a backslash character, use “\\” inside the string.

Commands are case sensitive. Successfully performed commands are not

acknowledged.

If an error occurs while processing a command, an error response is returned:
Error <uint> <string> <string>\n

where the first parameter is an internal error code number, the second para-
meter is a quoted string containing the error message, and the third parameter
is a copy of the offending command, also as a quoted string.
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LIST OF COMMANDS The table below shows the available commands, with some commands
explained in more detail on the following pages.
Command Parameters Description
run [<string>] Run timeline from current position, optional aux timeline name.
halt [<string>] Stop at the current position, with optional auxiliary timeline name
kill <string> Stop and deactivate the named auxiliary timeline.

gotoTime

gotoControlCue
standBy

load

online

Updcte
enableLayerCond

setlnput

<uint>/<string> [<string>]

<string> [<bool> [<string>]]
<bool>
<string> [<uint> [<bool>]]

<bool>

<uint>

<string> <float> [<uint>]

Go to a time position, specified in milliseconds or as a time. The
second, optional, parameter selects an auxiliary timeline.

Go to a named Control cue (name is case sensitive).

Set the standby mode to true or false.

Load a show from specified file, with optional parameters.
Control the online status of the production software.
Update the disp|qy computers.

Set enabled layer conditions (see table on page 255).

Set the value of a named Input, with optional fade-rate in mS.
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gotoTime

gotoControlCue

standBy
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Jumps to a time position along the timeline. The time can be specified in milli-
seconds:

got oTi me 60000

goes to one minute (60000 / 1000 = 60 seconds). Alternatively, specify the
time as a string in the format “HH:MM:SS.mmm”. A second parameter, if spec-
ified, selects an auxiliary timeline by name.

Jumps to the named Control cue. Returns an error if the cue can’t be found. The
name is specified within double quotes, and is case sensitive:
got oCont r ol Cue "anders"

A second parameter, if specified as true, instructs WATCHOUT to search back-
wards only, starting atthe current timeline position. Default is to search the
entire timeline.

A third parameter, if specified, selects an auxiliary timeline by name. Default
is the main timeline.

Enters or exits standby mode, where the parameter is true or false (without
quotes).

standBy true
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load

Condition

Number to Add

NG AN W N =

1
2
4
8
16
32

...and so on.

Loads a show by name. The name is specified as a quoted string containing the
full path to the file. The use of backslash characters in Windows path names
conflicts with the use of the backslash as an escape character in this protocol.
Either double the backslash characters, or use forward slashes instead (as
shown in this example):

| oad " C:/ Sanpl es/ Exanpl eShow. wat ch"

NOTE: When using this load command, the production software will auto-
matically go online after loading the show.

If desired, you can add a numeric parameter to override the conditional layer
settings of the show being loaded. For example, to enable condition 1 and 2
only:

| oad " C:/ Sanpl es/ Exanpl eShow. wat ch" 3

The number is a sum of the decimal numbers corresponding to each desired
condition, as shown in the table to the left.

The last optional parameter is a boolean controlling whether the production
software will go online or not, after loading the show (default value is true):

| oad "C:/ Sanpl es/ Exanpl eShow. wat ch" 3 fal se

loads the specified show and sets its layer conditions, but remains offline.
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setinput Sets the value of a named input (see “Inputs” on page 197):

uno" 0.5

set | nput

The value is generally in the range O through 1, but may be extended to cover
a wider range using the Limit setting of the Generic Input (see “Generic Input”
on page 197).

By prefixing the value with a plus or minus sign, you can adjust the value incre-
mentally relative to its current setting. This example increases the value of the
input by 0.1:

set |l nput "uno" +0.1

A third, optional parameter allows you to specify a transition rate, causing any
property controlled by the input to change gradually to the specified target
value. This parameter is specified in milliseconds.

NOTE: While you would typically use this command to set the value of a
Generic Input, you may use it fo set the value for any input. If data is also
provided by a MIDI or DMX-512 source, the latest data will take prece-
dence.
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= DISPLAY CLUSTER PROTOCOL

Overview

Preparation

CONTROL OPTIONS

File-based Control

You can control a cluster of WATCHOUT display computers using a local
command file or from a computer or other device capable of communicating
using a serial port or the TCP/IP network protocol.

NOTE: While similar to the production computer protocol described in the
previous appendix, this protocol allows you to control WATCHOUT display
clusters without a production computer being present in the system.

Before attempting to control a cluster, ensure that the show has been success-
fully run from WATCHOUT production software (meaning that all media files
have been transferred, etc). Then quit the WATCHOUT production software.

You can control the display cluster either using a file stored on the primary
display computer in the cluster, or using commands sent via the network or
through a serial port.

You can use a file stored on the primary display computer’s hard disk to auto-
matically perform most commands in this protocol when starting the display
software. This can, for example, be used to set up a system that automatically
loads and runs a show every time the computer is switched on.

The command file can be created using a text editor or word processor

capable of saving as plain text. To perform those commands when starting the
WATCHOUT display software, you provide the name of this command file as
a command line parameter to the display software. If started using a shortcut
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(possibly located in the Startup folder), add the name of the command file to
the Target field of the shortcut.

I =

£ WATCHPOINT EXE - Shortcut Properties (3]

Genersl | Shortout | Compatibiliy | Security | Details |

ﬁ WATCHPOINT.EXE - Shortcut

Enter the name of the command

file here. This example assumes Targettype:  Application
that the file is stored in the folder _
where WATCHOUT is installed. Target logation: WATCHOUT
Make sure this is set to the folder Target: DAWATCHOUTWATCHPOINT EXE Cmd et
where WATCHOUT is installed. \
Start in: DAMWATCHOUT

Shorcut key:  None

Run: ’ Mormal window ']
Comment:
[ Open File Location ] [ Change lcon... ] [ Advanced... ]

The excmp|e below shows the content of a command file that disp|c:ys a
message on the WATCHOUT screen, waits a few seconds, loads a show, waits
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Network Control

for any other computers in the WATCHOUT display cluster to become ready,
and then runs the show.

aut henticate 1
set LogoString "The show will begin shortly"

del ay 5000

| oad " MyShow'
wai t

run

See each individual command later in this appendix for details.

IMPORTANT: If using non-ASClI characters in the show name (for example;
&, 8, U, B), your text editor must be able to save the text using the UTF-8
encoding. If you're unsure about this, it’s usually easiest to rename the show
to avoid non-ASCIl characters.

NOTE: Any errors occurring while executing commands from such a
command file are displayed in a console window. However, to see this
window, you have to close the main WATCHOUT display window by
pressing Ctrl-W. Keep this in mind if your command file doesn’t work as
expected.

To control a WATCHOUT display cluster via the network, connect to TCP/IP
port number 3039 of one of the WATCHOUT display computers. The computer
you initiate communication with becomes the master of the cluster, and will
automatically control the other cluster members, as specified by the presenta-
tion loaded using the “load” command.
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Serial Control

COMMANDS AND RESPONSES

Authentication

Command Format

260

Use a Telnet program to check the communication. Open the port specified
above, then type “ping” and press Return. WATCHOUT will respond with a
Ready message, stating its version number and some other details.

To control a WATCHOUT display cluster through a serial port, connect the
controlling device to a serial port of one of the WATCHOUT display
computers. The computer you connect to becomes the master of the cluster, and
will automatically control the other cluster members, as specified by the presen-
tation loaded using the “load” command.

No serial port is open by default. Use the serialPort command to open a serial
port. Put this command into a text file, and use the file-based control feature to
perform the serialPort command (see “File-based Control” on page 257).

WATCHOUT uses a simple text format for its commands. Some commands
may return a reply, error message or other kind of response to the controller.
Such responses are also sent as fext.

Before you can give any command (with the exception of the “ping”
command), you must specify the authentication level. To control WATCHOUT,
you need authentication level 1:

authenticate 1
WATCHOUT responds with a Ready message. You can now send other

commands.

Each command is sent as a string, terminated by a carriage return, line feed or
CR/LF pair. A command consists of a command name, sometimes followed by
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Responses and Feedback

Parameters

<string>

<vint> and <int>

<float>

<bool>

parameters. Commands are case sensitive. Commands are encoded using the
UTF-8 UNICODE character format, which is downward compatible with ASCII.

IMPORTANT: When sending commands containing non-ASCll characters —
such as &, &, U, ¢ — these must be encoded using the UTF-8 format.

Most commands perform silently when successful. You can explicitly request
acknowledge from any command as described under “Command ID Tagging”
on page 274.

For commands that take parameters, parameters are separated by white-
space only. Optional parameters are shown in square brackets, like this:
[<uint>]. The parameter types are described below.

String parameters are sent within double quotes:
"This is a string"

Backslash is used as an escape character (that is, to encode a double quote in
a string, precede it with a backslash). To send a backslash character, use “\\”
inside the string.

An unsigned or possibly signed decimal integral number:
123

A possibly signed decimal number with an optional fractional part:
0.25

The keyword true or false, with no quotes:

true
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LIST OF COMMANDS The table below shows the available commands. Some are explained in
greater depth on the page indicated in brackets.
Command Description
ping Do-nothing command causing a Ready feedback message to be sent.

authenticate
load

run [<string>]
halt [<string>]
kill <string>
gotoTime
gotoControlCue
enableLayerCond
standBy
getStatus

reset

setlnput

delay

wait

serialPort

timecodeMode

Perform authentication. Required prior to other commands [260].
Load a show and get ready to run [263].

Start running, optionally specifying an auxiliary timeline name.
Stop running, optionally specifying an auxiliary timeline name.
Stop and deactivate the named auxiliary timeline.

Jump to a time position [264].

Jump to the time position of a named Control cue [264].

Turn conditional layers on or off [265].

Enter/exit standby mode [265].

Retrieves name and status of the currently running show [265].
Reset and stop all timelines.

Set the value of a named Input, with optional fade-rate in mS [267].
Introduces a delay between commands (command file use only) [266].

Wiaits for the entire display cluster to become established [266].

Activates LTC (SMPTE/EBU) timecode control [268].

262
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load Load a complete show specification from a local file associated with the show
name specified by the first parameter. Busy feedback may be sent to the host
while loading, informing the host about the progress (see “Busy” on page
270). If errors occur, Error feedback is sent (see “Error” on page 271). Finally,
a Ready feedback message is sent, regardless of whether any error occurred
(see “Ready” on page 269).
| oad " Phant onf

Parameter Description

<string> Name of the show to be loaded.

[<bool>] Manage cluster loading and feedback. Defaults to true.

[<bool>] Designate as the master disp|0y computer. Defaults to true.

[<uint>] Conditional layer enable flags, least significant bit is condition 1 (see table

on page 255).

NOTE: You can not specify a folder path to the show. The show must be
present in the “Shows” folder, located in the same folder as the
WATCHOUT display software.
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gotoTime Jump to the specified time position along the timeline.
got oTi me 5000
Parameter Description

<uint> or <string>

Time position to go to, in milliseconds, or as a string in this format:
“HH:MM:SS.FFF”, where FFF is milliseconds.

[<string>] Name of auxiliary timeline to control (omit for main timeline).
gotoControlCue Jump to the time of specified Control cue. If the optional “reverse only” boolean
is set to true, it searches for the Control cue only back in time from the current
time position. Otherwise it searches first forward then reverse.
The command does not change the run mode of the timeline. If specified cue is
not found, the timeline’s state will not change, and a runtime error message to
this effect will be returned.
gotoControl Cue "WIliant true
Parameter Description
<string> Name of Control cue fo look for.
[<bool>] Search in reverse only if true. If false or not specified, then search both ways.
[<string>] Name of auxiliary timeline to control (omit for main timeline).
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enableLayerCond

setLogoString

standBy

Change the set of enabled layer conditions. While the layer conditions can be
specified as part of the load command, this separate command allows the
layer conditions to be changed without loading another show. The command
takes a single, mandatory <uint> parameter with the same interpretation as the
conditional layers parameter of the load command (see table on page 255).

Display the string parameter next to the WATCHOUT logo, when shown on
screen. See example on page 259.

Enter/exit standby mode. In standby, the display and sound is muted, or
media on standby layers — if any — is performed (see “Perform Normal/In
Standby” on page 104). This mode can be entered/exited smoothly, by spec-
ifying a fade rate.

standBy true 1000

Fade out sound and image over one second and enter standby mode. If any
standby layer is available, its media is performed instead.

Parameter

Description

<bool>

[<uint>]

Enter standby if true, exit if false.

Fade rate, in milliseconds. Defaults to zero if not specified.

getStatus

Get the current status of the WATCHOUT cluster master.

get St at us
Reply "WQ2Launch" false 0 true true fal se 122 true
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Responds with a Reply with the following parameters:

Reply Parameter Description
<string> Name of the show. Empty string if no show loaded.
<bool> Busy. True if the master display computer or any of its slaves is busy
<vint> General health status of the cluster; 0: OK, 1: Suboptimal, 2: Problems, 3:
Dead.
<bool> Display is open (in its full screen mode).
<bool> Show is active (ready to run).
<bool> Programmer is on line.
[<uint>] Current time position, in milliseconds (only included if show is active).
[<bool>] Show is playing — false if paused (only included if show is active).
[<float>] Timeline rate (nominally 1, only included if show is active).
[<bool>] Standby mode (true if in standby, only included if show is active)
delay Wait the number of milliseconds specified by the parameter before performing
the next command in the file. See example on page 259.
NOTE: Performed only when used in a command file.
wait Wait for the display cluster to become fully established before proceeding with
the next command in the file. Waits at most the number of milliseconds speci-
fied by the parameter. See example on page 259.
NOTE: Performed only when used in a command file.
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setinput Sets the value of a named input (see “Inputs” on page 197).

Parameter Description

<string> The name of the input to set.

<float> The desired"value, optionally prefixed by + or - for incremental change.

[<uint>] Optional transition rate, in milliseconds.

See “setlnput” on page 256 for more details and an example.
serialPort Open serial port for cluster control protocol use, setting its parameters.
serial Port true "COWVL"

Parameter Description

<bool> Open (true) or close (false) the serial port.

<string> The name of the serial port.

[<uint>] Protocol selector. Must be 0. Default is O.

[<uint>] Data rate, in bits per second. Default is 9600.

[<uint>] Number of data bits, 7 or 8. Default is 8.

[<vint>] Number of stop bits, 1 or 2. Default is 1.

[<uint>] Parity: O = none, 1 = odd, 2 = even. Default is none.

HINT: For serial-only control, put the serialPort command into a text file,
and use the file based control feature to perform the commands in this file
(see “File-based Control” on page 257).
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timecodeMode

Controls the LTC timecode receiver of the display computer. The timecode
receiver is initially off. When turned on, incoming timecode will control the
presentation as if using the run, halt and gotoTime commands. Furthermore,
while playing, the presentation will be synchronized to the timecode.

ti nrecodeMode 2 "-1:00: 00"

Parameter

Description

<uint>

[<int> or <string>]

0 = receiver off, 1 = auto-detect format, 2 = EBU 25 fps, 3 = SMPTE 29.97
NDF, 4 = SMPTE 29.97 DF, 5 = SMPTE 30 ("B&W").

Time offset expressed in milliseconds, or as a string in this format:
“HH:MM:SS.FFF”, where FFF is milliseconds. Default is O.

268

Avoid using the auto-detect mode whenever possible. Instead, specify the
expected timecode format explicitly. Specifically, the SMPTE 30 ("B&W”)
format can not be detected automatically.

Use the separate Timecode Tester application fo verify proper timecode recep-
tion, and to choose the appropriate input connector to use for the timecode
signal (see “Timecode Control” on page 84).

HINT: For stand-alone use of the timecode control feature, put this
command into a text file, as described under “File-based Control” on
page 257.

NOTE: Timecode control of the display computer can’t be used while the
production software is online. In this case, use the corresponding feature of
the production software instead. See “Controlling the Production Computer”
on page 84.
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FEEDBACK

Ready

The WATCHOUT cluster master sends feedback messages to the controller.
Note that the controller must be prepared to receive such messages at any time
— not only as a direct response to particular commands.

Most commands execute silently, unless an error occurs. Use the command 1D
tagging feature to force commands to be positively acknowledged, if desired
(see “Command ID Tagging” on page 274). When using command ID
tagging, any feedback message sent as a direct response to a command will
be tagged by that command ID, and will be sent to the sender of that
command.

Any spontaneous feedback message (that is, not directly associated with a
particular command) will be sent to the most recently connected or authenti-
cated controller.

Sent once when becomes ready after being busy (as indicated by one or more
Busy messages). Also sent as response to the “ping” command.

Ready "2.0" "WATCHPO NT" "W ndows" true

Feedback Parameter

Description

<string>
<string>
<string>
<bool>

[<string>]

The version of the program.
The name of the program.

The name of the computer/OS.
License key is up to date.

Address of originator (empty or omitted if originating from the master).
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Busy Sent repeatedly while busy doing lengthy tasks, such as downloading or
caching files.
Busy "Transferring" "Media/WIlfred.jpg" 76
Note that either or both string parameters may be empty, in which case the
controller should retain the previous values for these parameters and just
Updote the progress value.
Feedback Parameter Description
<string> What is being done (for instance, “Transferring”). May be empty string.
<string> The subject of the above action (for instance, a file name). May be empty.
<uint> Percentage done so far, 0...100
[<string>] Address of originator (empty or omitted if originating from the master).
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Error

Sent when any error occurs, either as a direct result of a command, or for any
other reason.

Feedback Parameter

Description

<uint>

<int> or <string>

<string>

[ <string>]

Error kind:

Operating system error (for instance, a Win32 HRESULT).
QuickTime error (Mac OSErr style).

Rendering API error (that is, DirectX).

Network errors (that is, WinSock).

File server error (for example, file not found during download).
Syntax/parser error (for instance, when loading a specification file).
General runtime error — described by string.

Authentication error.

ONOOANWN=—

Error number or description string. May be zero.

Excuse or exp|cmation, may be empty string.

Address of originator (empty or omitted if originating from the master).

Operating System Error

QuickTime Error

Indicates a generic operating system error from the host's OS. Under
Windows, this is a HRESULT that indicates failure, with the error code included
as the second parameter (possib|y decoded into an error message string). The
third parameter may provide additional information.

Similar to the Operating System Error, but originating from QuickTime. This is
treated separately from the OS errors since the QT errors use MacOS style
error codes even under Windows. This kind of error typically originates from
still image files, or from video files as they are opened or played. The third
parameter generally contains the name of the offending media file.
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Rendering API Error

Network Error

File Server Error

Syntax/Parser Error

General Runtime Error

Error occurred specifically related to rendering. This is similar to other oper-
ating system errors, except that you also know that it occurred while rendering.
Sometimes, rendering errors occur due to display card driver issues, video
memory or other hardware resource limitations.

Error occurred specifically related to network communication. This is similar to
other operating system errors, except that you also know that it occurred
specifically while using the network. Sometimes, network errors are caused by
network interface hardware or driver issues, the computer’s network configu-
ration, or problems on the network itself (for instance, a bad cable/hub or
incorrectly configured router).

Error occurred when attempting to get a file from the media file server. The
error number the same as those listed for the first Reply parameter in the File
Transfer group. The Excuse string is typically the name of the required file.

Indicates an error that occurred when reading structured data (such as a show
specification file). Error code and excuse vary with the nature of the error.

Other errors, not covered by any of the above cases. Always described further
by a string as the second parameter, as well as further information in the third
parameter (optional).
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Authentication Error  The second parameter gives further details:

Value Description

You have no authority.

Your authority is insufficient for this command.

In use by another Programmer.

Authentication challenge/response sequence failed.
Invalid authentication level.

Authentication level not allowed for port.

N o oA WN R

Command not allowed in read-only mode.

The third parameter may provide additional context information. For instance,
in the case of being in use by another controller, it may provide information to
identify that controller — such as its address.

Warning Sent when a non-critical error occurs.

Warning "Low Menory: Primary Video 960 KB"

Feedback Parameter Description
<string> The warning message, as a quoted string.
[<string>] Address of originator (empty or omitted if originating from the master).
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Information Sent to convey some general information.
Feedback Parameter Description
<string> The information message, as a quoted string.
[<string>] Address of originator (empty or omitted if originating from the master).
Reply A Reply feedback message is sent as a direct response to a query command
(for instance, getStatus described on page 265). Use a command ID to posi-
tively associate the reply with the command.
The format of the reply parameter(s) depends on the command that caused the
reply to be sent.
Quit Sent when the application is about to quit (either due to a keyboard or other

COMMAND ID TAGGING

274

command). This message has no parameters.

Commands may optionally be preceded by a command ID. This is any
sequence of characters enclosed in square brackets. When used, at least one
explicit reply is always sent for each command. The reply is then also tagged
with the same ID:

[ 23] pi ng
[23] Ready "2.0" "WATCHPO NT" "W ndows" true

Use this feature if you want positive confirmation of commands, or to explicitly
associate a feedback message with a command.
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= MIDI SHOW CONTROL

MIDI Show Control (MSC) allows WATCHOUT o be controlled from a lighting
console, or similar device capable of outputting MSC commands.

NOTE: During production, connect your MIDI device to the production
computer. When not using the production software, connect it fo the
primary display computer in the cluster.

In addition to enabling MIDI Show Control, you also have to specify the MSC
Device ID (see page 122). This acts as a channel number for MSC commands,

and must be set to the device ID number output by the console. In addition,
WATCHOUT also recognizes the global “all call” device ID.

Some MSC commands allow a cue/list/path to be specified. WATCHOUT
doesn’t use the “path” number. The “list” number can be handled in either of
three ways, as specified in the WATCHOUT Preferences:

* Ignore Command. In this setting, the entire command will be discarded (not
acted upon) if a list number is specified.

* Map all to Main Timeline. This setting ignores the cue list number, sending
all such commands to the main timeline.

* Map to Auxiliary Timelines. If a cue list number is specified, the command
will be applied to an Auxiliary Timeline with the same name (where the
name must be numeric, to match the list number).

Appendix F - MIDI Show Control 275



GO

TIMED GO

STOP

LOAD

RESET

ALL OFF

RESTORE

276

The cue number, if specified, makes WATCHOUT locate a Control cue with
that name (that is, the name of the cue must be a number). The GO and TIMED
GO, LOAD and STOP commands interpret cue number O as specifying “no
cue”, allowing you fo specify the cue list part only. This allows you to use the
STOP command to stop an Auxiliary Timeline without necessarily specifying a
particular cue by sefting the cue number to zero.

The following is a description of each command, as it relates to WATCHOUT.

If given without a cue/list specification, runs the main timeline.

If given with a cue but no list, locates the specified cue on the main timeline and
runs from there. Does nothing if a cue with that name doesn’t exist.

If given with cue and list, locates the specified cue on the specified Auxiliary
timeline, and runs it from there (assuming cue lists are mapped to Auxiliary
timelines). Does nothing if specified cue or timeline can’t be found.

Performs like GO, ignoring the time value specified.

Pauses the timeline, optionally locating the specified cue.

Similar to GO, except that the timeline isn’t run.

Stops all Auxiliary timelines (returning them to their inactive state) and reset the
main timeline to its beginning.

Enters Stand-By mode.

Exits Stand-By mode.
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INDEX

Numerics
3D 86, 100, 124

A

acceleration 76

Add Composition command 143

adding a control cue 151

adding a display 131

adding a media proxy 139

Adobe After Effects 39

alpha channel 35, 36, 40, 142

anchor point 74

anchor point, in images 121

audio see sound

auxiliary timeline 203, 210
settings 152

AVI 37

B

Background Color command 138
balance, audio 180

batch file 257

Best Quality command 136

Index

black & white 187
blend mode 176

C

cache folder 80

CachedFiles 80

channel mixer 193

chromakey 185

Clear command 126

Click Selects Frontmost Image command 135

cluster control protocol 257

codec 40

color 189

color correction 165

color, keep 187

command file 257

composition 87, 143
sefttings 154

computer screen 143

conditional layers, preview of 137

Consolidate command 117

contrast & brightness 187

control cue 151

Copy command 126

corners 186

crop 188

277



cue 12, 64, 167
adding 102, 167
control 151
cutting 168
deleting 168
duration 67, 169
media position 168
pasting 168
pause 68
positioning 167
replacing media 66, 170
selecting 167
specifications 67, 170
string 208
tween track 69, 179
curved screen 160
Cut command 126

D
DA (distribution amplifier) 18
deinterlace
live video 146
delay 266
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display 157
adding 59, 97,131, 157
address 158

address prefix, in preferences 120

arranging 59
duplicating 158
DVI 242
geometry 160
installing 17
LCD 241
name 158
online 134
positioning 157
removing 158
selecting 157
specifications 158
stage position 159
display computer 9
connecting to 79
quitting WATCHOUT 79
DLP projector 239
DMX-512 57, 201, 205
Dv 37
DV video format 41
DVI connector 242

E
EBU timecode 84
edge blend 121, 153, 160, 246

Index



edit menu 125
enableLayerCond 265
Ethernet 16

Ethernet port 206
expression 203, 212
external control 83

F

file menu 115

find and replace 128
Find command 195

Find/Replace Again command 129

Find/Replace command 128
folder, in media window 149
frame rate 120

free running 174

function keys 195

G

gamma setting 246

geometry correction 160
adding points 164

getStatus 265

gotoControlCue 254, 264

gotoTime 254, 264
green screen 185

H

HDMI 243

high definition video 37
hub 16

hue & saturation 192

I

image specifications 36

input 197
controlling a tween track 202
starting a task 203

in-time 172

IP address 27

J
jump button 102
jumping, in presentation 81

K
keying 185
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L media 12, 61

Large Thumbnails command 149 adding 61, 107

layer 66 changing file association 62, 108
changing height 102 changing path to files 128
collapse 101 downloading files 80
condition 104 dragging to stage 97
current 102 editing file 62, 109
deleting 151 locating file 108
disabling preview of 103 opening original 109
inserting 151 positioning 98, 168
locking 103 proxy 63, 109, 139
renaming 151 purging unused 62
selecting 102 refreshing 62, 109, 149
settings 103, 151 removing 107

LCD display 241 selecting unused 150

LCD projector 241 thumbnail size 149

license key 16 window 107

link handles 183 menu

live video 145, 146 edit 125

live video input 18 file 115

load 255, 263 media 139

logical operators 214 preview 135

loop 81, 175, 193 stage 131

loop, timeline 194 timeline 151

tween 155

M window 155

mask 176 message 113

Masked by Displays command 136 removing 113

MIDI 198
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MIDI show control, MSC 122, 275

MOV file format 37

movie 37
assembling individual frames 39
audio embedded in 46
computer generated 38
pre-splitting 42, 140

moving along a path 183

MPEG 37

MPEG-2 41

N
network 9
connecting 16
control 251, 257, 259
requirements 224
NETWORK TRANSPONDER 82
network video 48
New Folder command 149

o
online 79, 134
opacity 35, 40, 72

tweening 180
Open command 116
operator 215
optical distortion 160, 249
ortographic 100, 136
Outline Dimmed Images command 136

Index

output 204
DMX-512 205
serial 207
string 206

output cue, creating 204

P
Paste command 126
pause cue 68
perspective 100, 124, 136
perspective correction 161
PICKUP 82
play 102
Play Audio Media command 136
position
animating 75
editing 75
moving along a path 76
tweening of 182
preferences 120
pre-roll 173
presentation
controlling 83
looping 81
making new 115
manual control of 81
opening 116
saving 116
pre-splitting large movies 42
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preview
background color 138
conditional layers 137
outline dimmed images 136
stage tiers 137
standby layers 137
wireframe 135

preview menu 135

Preview Scale command 131

Preview Standby Layers command 137

production computer 8

control protocol 251
progressive video 37
projection screen 17
projector

DLP 239

LCD 241
protocol 251, 257
proxy 63, 109, 139

Q

QuickFind 195

QuickTime
installing 15
obtaining 15

R
reference frame 154
Refresh Media command 109, 149
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relational operators 214
rotation tweening 184
rtp 48

rtsp 48

S
Save a Copy command 116
Save command 116
scale tweening 181
scaling 72
Select All command 126
Select to End command 126
Select Unused command 150
serial control 83, 260
serial port 207
serialPort 267
setinput 256, 267
setlogoString 265
skew, image 186
SMPTE 84
sound
file formats 45
installing 17
multi-channel 18, 45
producing 45
settings 31
Specifications command 127
speed of motion 76
spherical projection 163

Index



stacking 175

stacking order 153

stage
adding displays 97
adding media 97
background color 138
online 134
positioning displays 159

positioning media preview 65, 98

preview 131
preview quality 135, 175
scale 97
tier 98, 133
updating 81, 134
stage menu 131
stage window 12, 59, 97
standBy 254, 265
stereoscopy 86, 125
still image
formats 34
producing 34
style, text 55
sun icon, in layer header 103
suppress rendering 177

T
task 209
starting from input 203

TCP/IP network 206, 251, 257
text media 52
text style 55
Thumbnails command 135
tier 133
preview of 137
time scale, adjusting 102
timecode 84, 268
timecodeMode 248
timeline 12, 64
adding cues to 64, 102
jump button 102
layer 66
playing 102
settings 152
starting 102
window 101
timeline menu 151
Timeline Settings command 152
tint 192
transparency 36, 185
pre-multiplied, straight 142
transparency see opacity
triangle, in layer header 101
tween menu 155
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tween point 70
copying 70
corner 70
editing numerically 71
removing 70
smooth 70

tween track 12, 69, 179
adding points to 70
opacity 72
position 75
red curve 202
rotation 73
scale 72
stretching 70
volume 72

U

UDP 206

UDP, TCP/IP, control protocol 122
Undo command 125

Update command 134

USB port 16

\"4

vanishing point 124

velocity 76

Video as Thumbnails command 135
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video distribution amplifier 18

video see movie

VNC 143

volume 72
tweening 180

w
wait 266
warping 160
WATCHOUT
installing 15
obtaining 15
screenshot 13
system overview 8
window
media 107
message 113
overview 95
stage 97
timeline 101
window menu 155
Windows 22
Windows Media 9 37
wipe 186

Wireframes command 135

WMV file format 37
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